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Get Help

Get Help
There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications
Use help icons    to access help in the application. If you don't see any help icons on your page, click your user image
or name in the global header and select Show Help Icons.

Get Support
You can get support at My Oracle Support. For accessible support, visit Oracle Accessibility Learning and Support.

Get Training
Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community
Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You
can join forums to connect with other customers, post questions, suggest ideas for product enhancements, and watch
events.

Learn About Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program. Videos included in
this guide are provided as a media alternative for text-based topics also available in this guide.

Share Your Feedback
We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just
want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!

i

https://support.oracle.com/portal/
https://www.oracle.com/corporate/accessibility/learning-support.html#support-tab
https://www.oracle.com/education/
https://cloudcustomerconnect.oracle.com/pages/home
https://community.oracle.com/customerconnect/categories/idealab-guidelines
https://www.oracle.com/corporate/accessibility/
mailto:oracle_fusion_applications_help_ww_grp@oracle.com
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1  Overview of Channel Revenue Management
Cloud

Channel Flows: Buy Side vs Sell Side  
Channel Revenue Management supports multiple channel flows and categorizes them as either buy side or sell side
flows. Each has its own separate user interface for their transactional users.

A sell side channel flow centers around a customer account and typically involves rebates offered to customers.
Deductions is part of the sell side flow. A buy side channel flow centers around a supplier site and involves
administering rebates from suppliers.

On the sell side we support:

• Deductions and Settlement

For more information about Deductions and Settlement, see Oracle SCM Cloud: Using Deductions and
Settlement in Channel Revenue Management guide.

Analysts can access Deductions and Settlement from the Order Management work area.

• Rebates to channel customers

• Royalty payments

For more information about Customer Programs, see Oracle SCM Cloud: Using Channel Revenue Management
guide.

On the buy side we support:

• Rebates from your suppliers.

• Annual rebates from your suppliers.

• Ship and debit rebates from your suppliers.

• Direct collaboration with suppliers to administer programs.

Supplier Channel Management that encompasses buy side flows:

• Analysts and administrators can access Supplier Channel Management from either the Procurement or Order
Management work areas.

• Supplier contacts can access Supplier Channel Management from the Supplier Portal.

For more information, see Oracle SCM Cloud: Using Channel Revenue Management guide.

Related Topics
• Starting an Implementation

1
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Deductions and Settlement  

Deductions and Settlement  
Deductions originally started in consumer goods where powerful retailers would short pay invoices based on their
understanding of the trade terms or agreements.

This has spread across all industries, and deductions are a common practice not only for collecting promotions, but
also for any kind of dispute or misunderstanding, whether it's a pricing error, transportation related, damages, and so
on. This is also the hardest challenge for the receivables departments to resolve because of the need for approval from
outside receivables, like sales or shipping. The customer may short pay based on their own policies and procedures. It's
up to you to resolve these claims.

According to market surveys, deductions can represent 5 to 15 percentage of revenue, depending on the industry. Of
that number, 5.1 to 10 percent are invalid or unauthorized. In some industries it can be a lot higher.

Deductions and Settlement in Channel Revenue Management enables you to take back control, and provides:

• Centralized deductions directly from Receivables.

2
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• Accurate and fast resolution of customer short pays.

• Resolution with accountability and transparency, which enables root cause analyses.

• Settlement of deductions in Receivables.

How Deductions and Settlement Works  

Overview

When a customer short pays you, the flow is:

1. Receive a short pay from a customer, including from the Receivables lockbox.
2. Create a claim from Receivables for the short pay difference within the receipt.
3. Assign ownership of the claim.
4. Research and resolve deductions quickly and accurately.
5. Settle the claim.

With Deductions and Settlement you can:

• Centralize deductions and overpayments, with accountability and aging by:

◦ Supporting lockbox

3
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◦ Creating manual claims

◦ Assigning claim owners

◦ Setting up aging methods

• Resolve deductions by:

◦ Associate promotional accruals

◦ Creating credit memos

◦ Applying open credit memos and open overpayments

◦ Applying write-offs

◦ Applying chargebacks only for invoice deductions

• Resolve overpayments by:

◦ Creating invoices.

◦ Applying open deductions.

• Approve your claims.

• Schedule the Settle Customer Claims process periodically to settle the claims in Receivables in a ready-to-use
and tightly integrated manner. The settlement details are brought back to Channel Revenue Management to
complete the flow.

• Analyze the root causes behind deductions, with the help of claim types and claim reasons assigned while
resolving the claim.

• Proactively analyze write-off thresholds through occasional review of claim write-offs.

4
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Business Process Flow

How Deductions and Settlement Works with Receivables  
Here's how Deductions and Settlement works with Receivables to provide transparent, integrated settlement.

Receivables Analyst Claim Creation
At the end of the day, a short pay or deduction represents any kind of dispute or misunderstanding between you and
your customer. These disputes manifest themselves as short pays in customer remittances, and can take multiple
forms:

5
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Customer Action Action Taken by Customer Analyst or
Lockbox Integration

Claim Source in Channel Revenue
Management

Customer short pays a receipt while marking
invoices as paid in full
 

Create Claim Investigation
 

Deduction
 

Customer overpays a receipt on account
 

Create Claim Investigation
 

Overpayment
 

Customer short pays a specific invoice
 

Create Channel Revenue Claim
 

Invoice Deduction
 

Customer overpays a specific invoice
 

Create Channel Revenue Claim
 

Invoice Overpayment
 

Customer communicates a dispute
 

N/A
 

Manual Claim
 

Based on the action of the customer, the Receivables analyst in the Edit Receipt UI or through the lockbox integration,
will behind the scenes, initiate the creation of a customer claim accordingly in Deductions and Settlement. This typically
defaults to a deduction claim type and an unknown claim reason. It's part of the resolution process to determine the
true claim type and reason.

For a non-invoice based deduction or overpayment, a Receivables activity is applied to the receipt in the amount of the
short pay or overpayment. The receipt is updated with a reference to the created claim number.

For an invoice specific deduction or overpayment, claim details are applied to an invoice application line of the receipt in
the amount of the short pay or overpayment, and the invoice application line is updated with claim details. The created
invoice claim takes on the amount outstanding, the currency, and the business unit of the invoice.

Note:  Claim creation will fail if a default claim type and default claim reason isn't specified in the claim source setup.

Claim Creation Through Lockbox
Many enterprises leverage lockbox banking services for the receipt of payment from customers. Create claims
automatically for deductions and overpayments from the Process Receipts Through Lockbox process in Receivables.
This reduces deduction creation time and improves processing efficiency. The lockbox receives payments and
automatically creates an invoice-related claim in Channel Revenue Management for underpayments and overpayments
to the invoice's outstanding balance and non-invoice related overpayment claim for any remaining unapplied amount
on the receipt post applications.

Claim Settlement
After a channel manager resolves the deduction and it's approved, the Settle Customer Claims process can be run to
create the artifacts of settlement in Receivables. A deduction can encompass one or multiple settlement methods. The
process is typically scheduled by the Channel Operations user.

During the settlement of a claim, the schedule process:

1. Creates credit memos in Receivables with applicable taxes, if credit memo lines are present in the resolution of
the claim. Credit memos on account are then applied to the receipt. Credit memos on invoice are applied to the
invoice. Similarly, for an overpayment, an invoice is created and applied to the receipt.

2. The Fusion Tax application or supported partner tax applications are supported.
3. Reverses the original claim investigation activity in the receipt.

6



SCM Cloud
Implementing Channel Revenue Management

Chapter 1
Overview of Channel Revenue Management Cloud

4. Applies any open transactions that are part of resolution to the receipt if settling on account or to the invoice if
settling on invoice.

5. Auto write-offs are only applicable to short pays. If the entire short pay wasn't resolved, and the remaining
amount is below the write-off threshold, then this write-off amount is applied to the receipt or invoice.

6. If the entire short pay wasn't resolved, then the remaining amount results in a child claim in Deductions and
Settlement. This child claim is also applied to the receipt.

Note:  While settling a claim, the Claim Amount Includes Tax field indicates whether the amount settled is inclusive of
taxes. If the override is allowed at the controls at status and tax rate levels, then the application will check this field.

Accounting
The accounting for settlement is handled by Receivables. Settlement artifacts are created as Receivables transactions
and activities according to the Channel setups. For credit memos and invoices, Receivables performs the subledger
accounting based on the Receivables transactions and activities created by Channel Revenue Management settlement.

• Claim Type setup for a deduction includes a one to one mapping to a Receivables credit memo transaction
type. This is used when a credit memo is created in Receivables. A standard credit memo is always created for a
credit memo on invoice.

• Claim Type setup for an overpayment includes a one to one mapping to a Receivables invoice transaction type.
This is used when an invoice is created in Receivables.

• Claim Reason setup for a deduction includes a one to one mapping to a Receivables credit memo reason. This
is used when a credit memo is created in Receivables.

The accounting for a claim investigation is derived from the Receivables Activity associated with the claim investigation
application.

In the Manage Channel Settings page, there are two settings under the category Settlement by Credit Memo - On
Invoice that drive the settlement in Receivables. A receivables method to reverse accounting entries, and a receivables
method to credit installments.

Related Topics
• Create Claim Investigations

• Process Receipts Through Lockbox Execution Report

Customer Promotion  

Customer Promotion  
Deductions started in consumer goods where retailers would short pay invoices based on their understanding of
customer promotions.

7
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To combat invalid or unauthorized deductions, customer promotion in Channel Revenue Management provides:

• Centralized promotions for channel customers.

You can:

◦ Negotiate and activate customer promotions.

◦ Define customer and product eligibility.

◦ Define accruals by amount or percentage.

• Automated eligibility of channel incentives against sales transactions.

This leads to fast and accurate accruals.

• Automated accrual tracking.

This provides real time visibility of liabilities.

• Centralized claims processing.

This helps reduce margin leakage and reduce your DDO (Days Deductions Outstanding).

• Automated channel accounting.

This configurable integration reduces time to implement and cost of ownership.

How Customer Promotion Works  
Customer promotions works on top of Deductions and Settlement providing centralized deductions and settlement in
Receivables, and provides promotional settlement of claims.

You can use Customer Channel Management to activate channel promotions, and once sales orders or invoices are
imported, the application calculates accruals for eligible customers.

8
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1. Negotiate a promotion with channel customers and activate the program.
2. The customer makes purchases.
3. Upload your sales data, then process these transactions to create accruals.
4. Earned accruals are then tracked and posted to GL.
5. Short pays from Receivables are centralized as claims. Optionally, manual claims can be created on demand.
6. Claims are investigated. Promotional deductions can be matched with available accruals to resolve a claim.
7. Approved claims can be settled by creating various transactions in Receivables including credit memos.

Related Topics
• How Deductions and Settlement Works with Receivables

How Customer Promotion Works with Imported Sales Orders and
Invoices  
Here's how customer promotion works with imported sales orders and invoices:

The Import Management framework can be used to import sales orders and invoices using CSV. Customer rebates are
calculated according to the terms of the program with the customer, and accrued.

• A set of validations are in place to identify any errors during import.

• The successful upload of the CSV file creates a batch of transactions for processing.

• The Create Accruals for Channel Batch process checks the eligibility of the batch lines and creates accruals
for the eligible ones. A supply chain application administrator can create the channel accruals on demand or
schedule it as a periodic batch process.

Consideration: If you import sales orders and invoices via the CSV file (Batch Transaction Type =
ORA_SALES_ORDER_CSV), then you must first import the CSV file, and only then schedule the processes to create
accruals (Create Accruals for Channel Batch).

9
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Related Topics
• Import Customer Invoices

• How do I import data?

• How do I map import fields?

• Create Accruals from Imported Sales Orders and Invoices

How Channel Accounting Works for Sell Side  
Here's how channel accounting works for the sell side.

Accrue Customer Rebates

1. Customer Rebate: After sales orders and invoices are loaded into Channel Revenue Management, eligible
program discounts can be captured using the Create Accruals for Batch process.

2. A supply chain application administrator can create these accruals on demand or schedule it as a batch process
on a periodic basis.

10
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3. After a channel accrual is earned based on its program rules, it's eligible to be posted to the general ledger.
4. A general accounting manager can post earned accruals to the general ledger on demand, or schedule it as

a batch process on a periodic basis. The integration to General Ledger supports the Subledger Accounting
architecture to derive the accounting.

Relieve Accruals

1. After a claim is approved, it is in settlement pending status, and its then eligible to be relieved its accruals by
posting to the general ledger.

2. A general accounting manager can post relief of accruals to the general ledger on demand or schedule it as
a batch process on a periodic basis. The integration to General Ledger supports the Subledger Accounting
architecture to derive the accounting.

Related Topics
• Schedule the Creation of Accruals for Batches

• Schedule the Accounting of Channel Accruals and Relief of Accruals to General Ledger

Supplier Rebate  

Supplier Rebates  
Here you can learn about what wholesalers and retailers can do using Channel Revenue Management.

Channel Revenue Management provides wholesalers and retailers the ability to:

• Centralize rebate programs from suppliers

You can:

◦ Capture program details including the supplier, effective dates, and alternate suppliers if applicable.

◦ Define product eligibility.

◦ Support accruals based on amount, or percentage.

• Automate accrual tracking

This leads to better visibility and faster realization of supplier incentives.

• Automate claim processing

This helps reduce margin leakage through accurate claim computation, thereby reducing supplier rejection.
The streamlined process helps wholesalers realize value faster on supplier rebate claims.

• Automate channel accounting

The faster realization from supplier incentives through automation reduces time to implement and the cost of
ownership.

11
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Supplier Rebate Overview

Supplier rebates is the process by which the supplier offers incentives to the wholesaler or retailer to purchase more.
These are the five basic steps for a wholesaler/retailer:

1. Supplier offers rebates for specific purchases.
2. Wholesaler/retailer buys from the supplier and supplier ships the goods.
3. Wholesaler/retailer receives the shipment of goods and invoice from the supplier. Accruals are typically earned

upon receipt of supplier invoice for received goods.
4. Accruals are compiled into claims for review and approval.
5. The claims are settled by issuing debit memos (or payments against the supplier invoice for supplier rejections).

How Supplier Rebate Works  
You can use Channel Revenue Management to create supplier programs and activate them so that eligible supplier
accruals can be automatically applied to receiving transactions that have been invoiced by the supplier, or to supplier
invoices directly imported into Channel Revenue Management. Here's how

12
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Overview

1. The wholesaler or retailer activates their supplier rebate programs.
2. The wholesaler/retailer buys from the supplier.
3. Supplier ships goods to the wholesaler/retailer and supplier invoices are created for the shipment.
4. The wholesaler or retailer receives the goods, makes corrections or accepts them.
5. Channel Revenue Management then processes these transactions to create accruals. This can be done in 2

ways:

◦ Directly process the receiving transactions and their supplier invoices. Accruals can be accrued upon
receipt of shipment or upon receiving the supplier invoice. Typically, accrual happens upon supplier
invoicing.

◦ Processes supplier invoices imported using CSV files to create accruals.

6. Earned accruals are then tracked, posted, and accrued.
7. Supplier claims are generated on demand or scheduled on a periodic basis.
8. Approved supplier claims are sent to Payables to collect payment from the suppliers, and accruals are relieved.

If the supplier rejects a claim line, a manual adjustment can be created to reverse the accrual.
9. After payment, the claims are closed.

13
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Business Process Flow

Related Topics
• How Supplier Claims Work

• How Channel Accounting Works for Buy Side

14
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How Supplier Rebate Works with Receiving and Payables  
Here's how supplier rebate works with Oracle Fusion Receiving and Oracle Fusion Payables to support inbound receiving
transactions from Oracle Fusion. Accruals can be accrued upon receipt of shipment or upon receiving the supplier
invoice. Typically, accrual happens upon supplier invoicing.

Load Transactions
The Load Transactions process imports the receiving transactions from Receiving into Channel Revenue Management.
A new batch is created with each load. It:

• Extracts receiving transactions and related PO details.

• Stores them as lines of a batch (1 batch per Load Transactions scheduled process).

Create Accruals from Channel Batch
The Create Accruals for Channel Batch process converts the batch lines into accruals. A supply chain application
administrator can create the channel accruals on demand or schedule it as a batch process on a periodic basis.

If the channel setting Event for Triggering Supplier Rebate Accrual = Receiving Transaction, then

• if the batch line is eligible, then

creates earned accruals

If the channel setting Event for Triggering Supplier Rebate Accrual = Supplier Invoice, then Channel receives the supplier
invoices directly from Payables, or are imported using CSV files.

• if the batch line is eligible but not invoiced, then

creates open accruals

• if eligible and invoiced, then

creates earned accruals

15
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For example, a receiving transaction for a quantity of 10 units can be invoiced for a quantity of 8 units. Here, open
accruals will be recorded for a quantity of 2 units, and earned accruals will be recorded for 8 units.

Related Topics
• How Supplier Claims Work

• How Channel Accounting Works for Buy Side

How Supplier Rebate Works with Imported Supplier Invoices  
The Import Management framework can be used to import supplier invoices using CSV files into Channel Revenue
Management. Supplier rebate accruals are then accrued according to the terms of the agreement with the supplier.

• A set of validations are in place to identify any errors during import.

• The successful upload of the CSV file creates a batch of transactions for processing in Channel Revenue
Management.

• The Create Accruals for Channel Batch process checks the eligibility of the batch lines and creates accruals
for the eligible ones. A supply chain application administrator can create the channel accruals on demand or
schedule it as a batch process on a periodic basis.

Consideration: If you import supplier invoices via the CSV file (Batch Transaction Type =
ORA_SUPPLIER_INVOICE_CSV), you must first import the CSV file, and then schedule the processes to create accruals
(Create Accruals for Channel Batch).

Related Topics
• Import Supplier Invoices

• How do I import data?

• How do I map import fields?

• Create Accruals from Imported Supplier Invoices

Supplier Annual Rebate  

Supplier Annual Program  
Supplier annual rebate is the process by which a wholesaler or retailer purchases goods from a supplier over a period of
time, typically a year.

The supplier may offer annual rebates that encourages buying based on accumulated volume attainments for the year.
Target attainments are tiered. For instance, if you purchase under a million dollars, you get 3% discount. If you purchase
between 1 and 2 million dollars, you get 5%. Above 2 million, you get 8%.

Channel Revenue Management provides wholesalers and retailers the ability to:

• Centralize annual rebates from suppliers
You can define annual programs based on accumulated attainments across orders, including:
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◦ Percentage rebate based on purchase value tiers

◦ Amount rebate per UOM based on quantity tiers

• Automate accrual tracking

This leads to better visibility and faster realization of supplier incentives.

• Automate claim processing

This helps reduce margin leakage through accurate claim computation, thereby reducing supplier rejection.
The streamlined process helps wholesalers realize value faster on supplier rebate claims.

• Automate channel accounting

The faster realization from supplier incentives through automation reduces time to implement and the cost of
ownership.

Supplier Annual Program Overview

Supplier annual rebate is the process by which a wholesaler or retailer purchases goods from a supplier across a
duration of time, typically a year. What makes supplier annual rebates different from supplier rebates is that volume
attainments are accumulated across orders. In supplier rebates, rebates are in the context of a given transaction. In
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supplier annual rebates, rebates are in the context of accumulated volume attainments across orders over a period of a
year.

1. Supplier offers or negotiates an annual rebate.
2. Wholesaler/retailer buys from the supplier and supplier ships the goods.
3. Wholesaler/retailer receives the invoice from the supplier and accumulate volumes across orders.
4. Accruals are calculated as percentage rebates based on purchase value tiers, or as an amount rebate per unit of

measure based on quantity tiers. Retrospective or stepped calculations are supported.
5. Accruals are compiled into claims for review and approval.
6. The claims are settled by issuing debit memos (or payments against the supplier invoice for supplier rejections).

How Supplier Annual Program Works  
You can use Channel Revenue Management to create supplier annual programs and activate them so that eligible
supplier accruals are automatically calculated from supplier invoices imported into Channel Revenue Management.
Here's how the supplier annual program business process works in Channel Revenue Management.

1. The wholesaler or retailer activates their supplier annual programs.
2. The wholesaler/retailer buys from the supplier.
3. Supplier ships goods to the wholesaler or retailer and supplier invoices are created for the shipment. Volumes

are accumulated across orders.
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4. Channel Revenue Management then processes the supplier invoices imported using CSV files to create
accruals.

5. Earned accruals are then tracked, posted, and accrued.
6. Supplier claims are generated on demand or scheduled on a periodic basis.
7. Approved supplier claims are sent to Payables to collect payment from the suppliers, and accruals are relieved.

If the supplier rejects a claim line, a manual adjustment can be created to reverse the accrual.
8. After payment, the claims are closed.

Business Process Flow

How Supplier Annual Rebates Work with Imported Supplier Invoices
The Import Management framework can be used to import supplier invoices using CSV files into Channel Revenue
Management. This is the same Import Management framework supported for supplier rebates. Supplier annual rebate
accruals are then accrued according to the terms of the agreement with the supplier.
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Consideration: If you import supplier invoices via the CSV file (Batch Transaction Type =
ORA_SUPPLIER_INVOICE_CSV), you must import the CSV file, and then schedule the processes to create accruals
(Create Accruals for Volume Programs).

• A set of validations are in place to identify any errors during import.

• The successful upload of the CSV file creates a batch of transactions for processing in Channel Revenue
Management.

• The Create Accruals for Volume Programs process checks the eligibility of invoice lines, aggregates and
creates accruals for the eligible ones. A supply chain administrator can schedule the program on a periodic
basis, for example, monthly.

Unlike supplier rebates, supplier annual rebates don't create an accrual for each invoice line. Instead, qualified
invoice lines are aggregated and a single accrual is created. Invoice lines are aggregated by business unit,
program, volume rule, period, item, ship-to location, bill-to location, and alternate supplier site if applicable.
This is an important distinction from supplier rebates.

Related Topics
• How do I import data?

• How do I map import fields?

Supplier Ship and Debit  

Supplier Ship and Debit  
Here you can understand what distributors can do using Channel Revenue Management.

Channel Revenue Management on the buy side is a supply chain management application that can help prevent margin
leakage in your channel business processes with greater efficiency. With supplier ship and debit, distributors can:

• Centralize ship and debit programs from suppliers.

• Automatically apply eligible supplier programs at order capture.

• Automate accruals tracking and claims processing.

Supplier Ship and Debit Overview:
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Centralize Supplier Programs

Use Channel Revenue Management as your hub to manage ship and debit agreements from suppliers. You can:

• Capture program details including the supplier, effective dates, and supplier authorization number.

• Define customer eligibility and product eligibility.

• Support accruals based on amount, new cost, or percentage basis.

Automatically Apply Eligible Programs at Order Capture

Sales can see eligible supplier programs and calculate channel discounts providing margin visibility before they book an
order. Accruals can be included in margin calculations.

Automate Accruals Tracking and Claims Processing

For many distributors, profitability is determined by the ability to track and collect supplier incentives. Channel Revenue
Management automates accrual tracking, providing you with real-time visibility to the earned, collected, and balance
accruals, for each program. Earned accruals are tracked in channel's subledgers and posted to the general ledger. Real-
time supply chain integrations provide accurate supplier balance tracking and compliant accounting practices. You can:

• Improve your productivity by generating and processing supplier claims online. Accruals are relieved in General
Ledger after claims are approved, and pending settlement.

• Settle supplier claims through Payables and automatically close the claim.
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Supplier ship and debit is the process by which a distributor ships goods at a lower than usual price to the customer and
debits the supplier for the additional discount from the acquisition price. The additional discount is claimed from the
supplier.

These are the four basic steps for a distributor:

1. Request a Ship and Debit Agreement from Supplier

The salesperson for the distributor can request this new price or can decide on this price to win a deal in hopes
that it will be approved. To debit the supplier for the difference, the distributor requests a special price from the
supplier. If the supplier approves, a supplier ship and debit program can be created and sales are made against
the program.

2. Ship to Customer

The distributor ships to the customer and earns the accrual. Accruals are calculated.
3. Claim Debit from Supplier

The distributor creates a claim with a matching debit memo or a supplier invoice to pay back the transactions (if
it is a supplier rejection), in Payables. Payables issues a debit memo or invoice to the supplier.

4. Settle Claim

The issuance of a debit memo (or payment against the supplier invoice if it is a supplier rejection) closes the
claim.

How Supplier Ship and Debit Works  
You can use Channel Revenue Management to create a supplier program and activate it so eligible supplier accruals can
be automatically applied at order capture. Here's how the distributor's supplier ship and debit business process works in
Channel Revenue Management.

22



SCM Cloud
Implementing Channel Revenue Management

Chapter 1
Overview of Channel Revenue Management Cloud

1. The distributor requests a special price or the supplier issues a special price.
2. An agreement between the distributor and the supplier is reached with the supplier providing an authorization

number to the distributor.
3. The distributor defines a supplier ship and debit program capturing the supplier, date effectivity, customer

eligibility, and product eligibility.
◦ Channel Revenue Management gets supplier sites already defined in Procurement and associates them

to a supplier ship and debit program.
◦ Date eligibility can be based on requested ship date or ordered date.

◦ Customers from Trading Community Hub are used to define customer eligibility.

◦ Item and unit of measure attributes from the Product Information Management work area can be used to
define product eligibility rules.

◦ The supplier incentive can be defined as a flat amount, a new cost, or a percentage.

◦ A supplier ship and debit program must belong to the same business unit as the supplier site.
4. The distributor activates the supplier ship and debit program. Approvals are optional.
5. The distributor creates a sales order and eligible program accruals are applied automatically or by request.
6. Earned accruals are tracked and accrued. Manual adjustments can be created for accruals that were missed or

needed correction.
7. Supplier claims are generated on demand or scheduled on a periodic basis.
8. Supplier claims are sent to Payables to collect payment from the suppliers, and accruals are relieved.
9. After payment, the claims are closed.
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Business Process Flow:

How Supplier Ship and Debit Works with Order Capture Systems  
Here's how supplier ship and debit works with order capture systems.
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1. Sales creates a sales order in an order capture application specifying the customer, bill-to, and ship-to
information, then adds several items with their quantity, unit of measure, and other fulfillment line details.

2. The order capture application gets the list of all eligible programs.

◦ Most programs are automatically applied to the line items.

◦ A type of program can be defined to be applied by request only. A sales user can apply these manual
programs to line items.

◦ Most programs can be declined by a sales user, but a type of program can be prevented from being
declined by sales users.

3. With the list of eligible programs, the order capture application calls on Oracle Fusion Pricing to calculate the
incentives.

4. A supply chain application administrator can create channel accruals on demand or schedule it as a batch
process on a periodic basis using the Create Accruals scheduled process. Channel related charge lines from the
order capture application are created as channel transactions.

Related Topics
• Manage Program Types

How Supplier Claims Work  
Here's how supplier claims work for the buy side.
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1. After an accrual is captured in Channel Revenue Management and earned, it's eligible to be picked up in a
supplier claim. Manual adjustments are also reflected in supplier claims.

2. A supply chain application administrator can generate a supplier claim on demand or schedule it as a batch
process on a periodic basis, using the Generate Supplier Claims scheduled process.

◦ The process can generate a single claim for a single supplier site, or multiple claims, at least one claim for
each supplier.

◦ Various parameters can be used to identify the earned accruals and manual adjustments to be included
for claim generation.

◦ The generated claim can be immediately sent to Payables for supplier payment or sent to the claim
analyst for review and approval.

3. The Financials Cloud integration can be configured to collect payment from the supplier.
4. Claims are settled by the Payables process Import Payables Invoices, with the Source parameter set to Claims.

This checks when payment has been successfully debited and retrieves settlement details such as debit memo
number or check number to confirm the claim settlement.

5. A general accounting manager can relieve accruals in Channel Revenue Management on demand or schedule it
as a batch process on a periodic basis using the Create Accounting scheduled process.

6. After payment, a supply chain application administrator can close the settled claims on demand or schedule it
as a batch process on a periodic basis using the Close Settled Claims scheduled process.

7. If the supplier declines a claim line, the distributor investigates and creates a manual adjustment to reverse the
accrual.
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Related Topics
• Manage Supplier Claim Sources and Settlement Methods

• How Payables Standard Invoice Import Data Is Processed

How Channel Accounting Works for Buy Side  
Here's how channel accounting works for the buy side.
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Accrue Earned Supplier Discounts
1. Supplier Rebate: After receiving transactions are loaded into Channel Revenue Management and supplier

invoices are received, eligible program discounts can be captured using the Create Accruals for Channel Batch
process.

Supplier Ship and Debit: When an order is created in an order capture application, eligible program discounts
are calculated and applied as channel incentives on an order line. After the order is invoiced, it's eligible to be
brought into Channel Revenue Management as a channel accrual.

2. A supply chain application administrator can create these accruals on demand or schedule it as a batch process
on a periodic basis.

3. Accruals that were missed or needs correction can be added as manual adjustments.
4. After a channel accrual is earned based on its program rules, it's eligible to be posted to the general ledger.
5. A general accounting manager can post earned accruals to the general ledger on demand, or schedule it as

a batch process on a periodic basis. The integration to General Ledger supports the Subledger Accounting
architecture to derive the accounting.

Relieve Supplier Accruals
1. After a claim is created and approved, it's eligible to relieve its accruals by posting to the general ledger.
2. A general accounting manager can post relief of accruals to the general ledger on demand or schedule it as

a batch process on a periodic basis. The integration to General Ledger supports the Subledger Accounting
architecture to derive the accounting.

3. The claim can be closed thorough the Close Settled Claims scheduled process.

Related Topics
• Schedule the Mass Creation of Accruals

• Schedule the Accounting of Channel Accruals and Relief of Accruals to General Ledger

Overview of Managing Supplier Programs  
Here you understand how to manage supplier programs in Channel Revenue Management.

Here's what you can do:

• Create a program or have suppliers create their own program via the Supplier Portal.

• Edit a draft program.

• Submit a program for approval.

• Activate a program so channel incentives can be applied to sales orders, receiving transactions, or supplier
invoices.

• Edit active programs in a limited fashion.

• Terminate active programs, locking them down from update and further application to sales orders, receiving
transactions, or supplier invoices.
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Overview of Managing Adjustments  
Here's what you can do.

• Create a positive or negative accrual adjustment.

• Approve the adjustment for supplier rebate adjustments.

• Reverse an accrual.
Once created or approved in the case of supplier rebate adjustments, you can't edit or delete an adjustment.
You must create a reversal adjustment to negate an original adjustment.

How Supplier Claims Are Processed  
On a periodic basis, a distributor creates supplier claims to collect on channel incentives. Typically, earned incentives are
gathered and associated with a supplier claim.

1. After an accrual is captured in Channel Revenue Management and earned, it's eligible to be picked up in a
supplier claim. Manual adjustments are also reflected in supplier claims.
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2. A supply chain application administrator can generate a supplier claim on demand or schedule it as a batch
process on a periodic basis, using the Generate Supplier Claims scheduled process.

◦ The process can generate a single claim for a single supplier site, or multiple claims, at least one claim for
each supplier.

◦ Various parameters can be used to identify the earned accruals and manual adjustments to be included
for claim generation.

◦ The generated claim can be immediately sent to Payables for supplier payment or sent to the claim
analyst for review and approval.

3. The Financials Cloud integration can be configured to collect payment from the supplier.
4. Claims are settled by the Payables process Import Payables Invoices, with the Source parameter set to Claims.

This checks when payment has been successfully debited and retrieves settlement details such as debit memo
number or check number to confirm the claim settlement.

5. A general accounting manager can relieve accruals in Channel Revenue Management on demand or schedule it
as a batch process on a periodic basis using the Create Accounting scheduled process.

6. After payment, a supply chain application administrator can close the settled claims on demand or schedule it
as a batch process on a periodic basis using the Close Settled Claims scheduled process.

7. If the supplier declines a claim line, the distributor investigates and creates a manual adjustment to reverse the
accrual.

How to Claim Supplier Accruals
1. Schedule the Generate Supplier Claims process. This creates claims for the channel accruals and manual

adjustments.

◦ Claim status: Settlement Pending

◦ Each claim settlement line contains the program and the line items on which it was applied.

2. Import these claims to Payables using the Import Payables Invoices process. The claims are now available in
Payables for payment.

3. Process the Payables invoice.
4. Close the claims after payment is confirmed by running the Close Settled Claims process. This updates the

claim with:

◦ Claim status: Settled

◦ Invoice or payment instrument details issued by Payables

How Supplier Accruals are Accounted  
Here you understand how supplier activity is accounted in Channel Revenue Management.
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Accrue Earned Supplier Discounts
1. Supplier Rebate: After receiving transactions are loaded into Channel Revenue Management and supplier

invoices are received, eligible program discounts can be captured using the Create Accruals for Channel Batch
process.

Supplier Ship and Debit: When an order is created in an order capture application, eligible program discounts
are calculated and applied as channel incentives on an order line. After the order is invoiced, it's eligible to be
brought into Channel Revenue Management as a channel accrual.

2. A supply chain application administrator can create these accruals on demand or schedule it as a batch process
on a periodic basis.

3. Accruals that were missed or needs correction can be added as manual adjustments.
4. After a channel accrual is earned based on its program rules, it's eligible to be posted to the general ledger.
5. A general accounting manager can post earned accruals to the general ledger on demand, or schedule it as

a batch process on a periodic basis. The integration to General Ledger supports the Subledger Accounting
architecture to derive the accounting.
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Relieve Supplier Accruals
1. You can create claims against the accruals using the Generate Supplier Claims process.
2. After a claim is created (or approved) and is pending settlement, it's eligible to relieve its accruals by posting to

the general ledger.
3. A general accounting manager can post relief of accruals to the general ledger on demand or schedule it as

a batch process on a periodic basis. The integration to General Ledger supports the Subledger Accounting
architecture to derive the accounting.

4. Sweep the unprocessed channel journal entries from closed accounting periods to open or future enterable
periods using the Sweep Channel Transaction Accounting Events process. Run the Create Accounting
process to post these to GL.

5. After payment, close the settled claims using the Close Settled Claims process.

Sign in to Channel Revenue Management  
You must sign in to Channel Revenue Management to access its various features.

1. From your administrator, get the following details:

◦ URL to access Channel Revenue Management.

◦ User account with the required privileges to manage the different features of Channel Revenue
Management along with the password.

2. After signing in, select the navigator.

◦ To access the supplier features of Channel Revenue Management, select Supplier Channel Management
under Order Management or Procurement.

◦ To access claim settlement and deduction features, select Deductions and Settlement under Order
Management.

◦ To access centralized rebate features for channel customers, select Customer Channel Management.

Note:  If you have the Manage Customer Programs or the View Customer Programs privilege, then you
can see the Customer Channel Management icon on the Fusion home page.

◦ To access promotional and nonpromotional claims settlement features in Redwood, opt into the
following:

- Deductions and Settlement
- Manage Deduction Claims Using Redwood Pages
- Customer Channel Management

Note:  The opt into Redwood pages feature will expire in 23D, after which all implementations of
Deductions and Settlement will be in Redwood.

On the buy-side, your supplier contacts can access Channel Revenue Management through the supplier portal:

1. From your administrator, get the following details:

◦ URL to access the Supplier Portal.

◦ User account with the required privileges to manage the Supplier Portal along with the password.
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2. After signing in, select the navigator. To access the channel programs, select Supplier Portal under Supplier
Portal. From the Supplier Portal dashboard, select Tasks, select Channel Programs, and then select Manage
Programs.
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2  Implement

Starting Decision Points  
Decision Points guide you in identifying the flows and deciding on the features for which you want to opt in as part of
your implementation.

The following decision points help you to evaluate what you must implement:

Sell Side
1. Identify the flows you want and their respective user communities.
2. If you require the Deductions and Settlement flow, then under the Order Management offering, you must opt in

to the function area Channel Revenue Management. Now, opt in to the feature Deductions and Settlement.
3. Use the following table to decide on the additional flows you require.

Supported Coexistence
Scenarios

Opt into Deduction and
Settlement

Opt into Deductions Claims
Using Redwood (Planned
Expiry 24A)

Opt into Customer Channel
Management

Settlement of nonpromotional
claims

Yes No No

Settlement of nonpromotional
claims in Redwood

Yes Yes No

Settlement of nonpromotional
and promotional claims in
Redwood

Yes Yes Yes

Promotional rebates and
payment, without bringing in
short pays from AR

No No Yes

Buy Side
1. Identify the flows you want and their respective user communities.
2. If you require the Deductions and Settlement flow, then under the Order Management offering, you must opt in

to the function area Channel Revenue Management. Now, opt in to the feature Deductions and Settlement.
3. If you require any buy side flow, then consider whether your user communities already use other Procurement

Cloud applications.
4. If a user community requires access from Procurement, then under the Procurement offering you must opt in

to the functional area: Supplier Incentives under the Purchasing functional area, and then opt in to the feature:
Supplier Channel Management.

5. If a user community requires access from Order Management, then under the Order Management offering you
must opt in to the functional area: Channel Revenue Management, and opt in to the feature: Supplier Channel
Management.
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Roadmap for Setting Up Deductions and Settlement  
Use this as a roadmap to implement Deductions and Settlement in Channel Revenue Management.

Sell side channel flow offers and administers discounts to the customers. Although deductions aren't always the results
of discounts to customers, promotional rebates can be the reason behind a customer short pay, and is considered as
a sell side channel flow. End users of Channel Revenue Management get separate UIs for buy side vs sell side channel
flows.

This roadmap can be used as a check list to implement Deductions and Settlement. Each of these setup steps is
explained in detail in the later sections of this guide.

Use the Functional Setup Manager to:

1. Opt in to Channel Revenue Management, and Deductions and Settlement.
2. Manage these channel settings:

◦ Claim Owner

◦ Automatically Show Available Programs to Associate

◦ Settlement Type

◦ Aging Method for Filtering

◦ Credit Method for Accounting Rules

◦ Credit Method for Installments

◦ Deduction Threshold

◦ Receivables Activity for Receipt Write-Offs

◦ Receivables Activity for Write-Off Adjustment

3. Manage user statuses.
4. Manage claim types including the standardization of accounting for write offs.
5. Set the Default Business Unit profile option at the user level when creating a manual claim and viewing the

customer checkbook. This step is optional and applies only for Redwood UIs.
6. Manage claim reasons.
7. Manage these claim sources and their settlement methods:

◦ Deduction

◦ Overpayment

◦ Invoice Deduction

◦ Invoice Overpayment

◦ Manual Claim

8. Manage these setups related to the Oracle Fusion Receivables integration, including the accounting for
Deductions and Settlement:

◦ Manage transaction sources.

◦ Manage Receivables activities.

◦ Manage SLA setup tasks.
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Scheduled Processes You Must Run
You must schedule these processes for Deductions and Settlement:

• Settle Customer Claims

Related Topics
• Schedule the Settlement of Customer Claims

Solution Components of Sell Side Flows  
Here you'll learn about the solution components of Deductions and sell side flows.

The following table summarizes the solution components of Deductions and sell side flows.

Flows Program Administration Inbound Integrations Claims Administration Outbound Integrations

Deductions and Settlement
(Nonpromotional
settlement)

N/A Claims from Oracle
Receivables

Claims UI
 
Create Manual Claims UI
 

Synchronously to Oracle
Receivables upon claim
approval
 
Settle Customer Claims
(scheduled process)
 
Create Accounting
(scheduled process)
 
Sweep Channel Transaction
Accounting Events
(scheduled process)
 

Customer Promotions
(Promotional settlement)

Programs UI
 
Customer Checkbook UI
 
Update Customer Accruals
Summary(scheduled
process)
 

Claims from Oracle
Receivables
 
Import Management for
CSV Sales Orders
 
Create Accruals for Channel
Batch (scheduled process)
 

Claims UI
 
Create Manual Claims UI
 

Synchronously to Oracle
Receivables upon claim
approval
 
Settle Customer Claims
(scheduled process)
 
Create Accounting
(scheduled process)
 
Sweep Channel Transaction
Accounting Events
(scheduled process)
 

Lump Sum Programs UI
 
Customer Checkbook UI
 

Claims from Oracle
Receivables
 

Claims UI
 
Create Manual Claims UI
 

Synchronously to Oracle
Receivables upon claim
approval
 
Settle Customer Claims
(scheduled process)
 
Create Accounting
(scheduled process)
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Flows Program Administration Inbound Integrations Claims Administration Outbound Integrations

 
Sweep Channel Transaction
Accounting Events
(scheduled process)
 

Roadmap for Setting Up Customer Promotions  
The sell side channel flow receives and administers discounts to customers.

Note:  Implement Deductions and Settlement before implementing customer promotions. Start with the Roadmap for
Setting Up Deductions and Settlement.

Use this roadmap as a check list to implement the sell side promotion flow. Each of these setup steps is explained in
detail in the later sections of this guide.

Use the Functional Setup Manager to:

1. Opt in to Channel Revenue Management, and Customer Channel Management.
2. If you need deductions from Receivables, then opt in to the Deductions and Settlement feature. Then opt in to

the Manage Deduction Claims Using Redwood Pages feature .
3. Under the offering: Financials and functional area: Receivables, navigate to the task Manage Receivables

System Options. Search for and select your business unit. Click the Cash Processing tab. Select the Enable
channel revenue management integration check box and click Save.

4. Under the offering: Financials, navigate to the task Manage Legal Entity Configurator Profile Options. Set the
profile Enable Legal Entity Time Zone at the Site level.

5. Run the ESS job to create index definition and perform initial ingest to OSCS scheduled process to create
index definitions and perform the initial ingest to OSCS for the program index.

6. Optionally, you can set the Default Business Unit profile option at the user level when creating a program and
viewing the customer checkbook.

7. Configure program types.
8. Configure user statuses for programs (optional).
9. Manage the channel settings:

◦ Automatically Show Available Programs to Associate. By default, Available Programs to Asscociate are
displayed. Change this setting if you don't want to display the programs available for association.

◦ Settlement Type (optional)

10. Manage user statuses.
11. Manage customer claim types.
12. Manage customer claim reasons.
13. Manage the claim source for Deductions, Invoice Deductions and Manual Claims. Configure Credit Memo - On

Account as the default settlement method.
14. Manage SLA setup tasks.

Schedule Processes You Must Run
You must schedule the following processes for customer rebates:

• Import sales orders and invoices using the CSV file from Tools > Import Management
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• Schedule the Mass Creation of Accruals for Batches

• Schedule the Accounting of Channel Accruals and Relief of Accruals to General Ledger

• Schedule the Clean Up of Unprocessed Accounting Events for Channel Transactions

• Settle Customer Claims

Related Topics
• Roadmap for Setting Up Deductions and Settlement

Solution Components of Buy Side Flows  
The following table summarizes the solution components of Supplier Rebate and Supplier Ship and Debit flows.

Flow Programs
Administration

Inbound
Integrations

Create Accruals Adjustments Claims
Administration

Outbound
Integrations

Supplier Ship and
Debit

Supplier Portal
 
Manage Supplier
Programs UI
 
Supplier
Checkbook UI
 

Oracle Order
Management

Create Accruals
(scheduled
process)

Manage Supplier
Ship and Debit
Adjustments UI

Generate Supplier
Claims (scheduled
process)
 
Manage Supplier
Claims UI
 

Synchronously
upon claim
approval
 
Oracle Financials
Cloud
 
Close Settled
Claims (scheduled
process)
 

Supplier Rebate Supplier Portal
 
Manage Supplier
Programs UI
 
Supplier
Checkbook UI
 

Oracle Inventory
Management
Cloud, Oracle
Procurement
Cloud, Oracle
Financials Cloud
 
Load Transactions
(scheduled
process)
 
Import
Management
for CSV Supplier
Invoices
 

Create Accruals
for Channel
Batch (scheduled
process)

Manage
Supplier Rebate
Adjustments UI

Generate Supplier
Claims (scheduled
process)
 
Manage Supplier
Claims UI
 

Synchronously
upon claim
approval
 
Oracle Financials
Cloud
 
Close Settled
Claims (scheduled
process)
 

Supplier Annual
Rebate

Supplier Portal
 
Manage Supplier
Programs UI
 
Supplier
Checkbook UI
 

Import
Management
for CSV Supplier
Invoices

Create Accruals for
Volume Programs
(scheduled
process)

Manage
Supplier Rebates
Adjustments UI

Generate Supplier
Claims (scheduled
process)
 
Manage Supplier
Claims UI
 

Synchronously
upon claim
approval
 
Oracle Financials
Cloud
 
Close Settled
Claims (scheduled
process)
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Flow Programs
Administration

Inbound
Integrations

Create Accruals Adjustments Claims
Administration

Outbound
Integrations

 

Roadmap for Setting Up Buy Side: Supplier Rebates  
The buy side channel flow receives and administers discounts from suppliers and manufacturers. End users of Channel
Revenue Management get separate UIs for buy side vs sell side channel flows.

Use this roadmap as a check list to implement the buy side supplier rebate channel flow. Each of these setup steps is
explained in detail in the later sections of this guide.

Use the Functional Setup Manager to:

1. Opt in to Channel Revenue Management, and Supplier Channel Management
2. Manage the channel setting: Event for Triggering Supplier Rebate Accrual
3. Manage user statuses
4. Manage programs types
5. Manage adjustment types and reasons
6. Manage claim types
7. Manage claim reasons
8. Manage these claim sources and their settlement methods:

◦ Supplier Rebate - Claim

◦ Supplier Rebate - Debit Claim

9. Manage SLA setup tasks

Scheduled Processes You Must Run
You must schedule these processes for supplier rebates:

• Load Transactions

Run this scheduled process if you use direct integration with receiving transactions. If you don't use the direct
integration with receiving transactions, then import supplier invoices using the CSV file from Tools > Import
Management.

• Create Accruals for Channel Batch

• Create Accounting (from Oracle Fusion Subledger Accounting)

• Sweep Channel Transaction Accounting Events

• Import Payables Invoices (Oracle Fusion Payables scheduled process). The Source parameter must be set to
Claims.

• Generate Supplier Claims

• Close Settled Claims

Related Topics
• Overview of Scheduled Processes
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Roadmap for Setting Up Buy Side: Supplier Annual
Rebates  
The buy side channel flow receives and administers discounts from suppliers and manufacturers. End users of Channel
Revenue Management get separate UIs for buy side vs sell side channel flows.

Use this roadmap as a check list to implement the buy side supplier annual rebate channel flow. Each of these setup
steps is explained in detail in the later sections of this guide.

Use the Functional Setup Manager to:

1. Opt in to Channel Revenue Management, and Supplier Channel Management
2. Manage the channel setting: Calendar for Accrual Calculation
3. Manage user statuses
4. Manage programs types
5. Manage adjustment types and reasons
6. Manage claim types
7. Manage claim reasons
8. Manage these claim sources and their settlement methods:

◦ Supplier Annual Program - Claim

◦ Supplier Annual Program - Debit Claim

9. Manage SLA setup tasks
10. To leverage supplier categories in program definition and reporting:

◦ Create a supplier catalog in PIM with no functional area.

◦ Create a supplier trade profile at supplier level and specify the supplier catalog.

Scheduled Processes You Must Run
You must schedule these processes for supplier annual rebates:

• Create Accruals for Volume Programs

• Create Accounting (from Oracle Fusion Subledger Accounting)

• Sweep Channel Transaction Accounting Events

• Import Payables Invoices (Oracle Fusion Payables scheduled process). The Source parameter must be set to
Claims.

• Generate Supplier Claims

• Close Settled Claims

Related Topics
• Overview of Scheduled Processes
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Roadmap for Setting Up Buy Side: Supplier Ship and
Debit  
The buy side channel flow receives and administers discounts from suppliers and manufacturers. End users of Channel
Revenue Management get separate UIs for buy side vs sell side channel flows.

Use this roadmap as a check list to implement the buy side supplier ship and debit channel flow. Each of these setup
steps is explained in detail in the later sections of this guide.

Use the Functional Setup Manager to:

1. Opt in to Channel Revenue Management, and Supplier Channel Management
2. Manage user statuses
3. Manage programs types
4. Manage adjustment types and reasons
5. Manage claim types
6. Manage claim reasons
7. Manage these claim sources and their settlement methods

◦ Supplier Ship and Debit - Claim

◦ Supplier Ship and Debit - Debit Claim

8. Manage SLA setup tasks
You must also perform the setups required for the integration with Oracle Fusion Pricing.

Scheduled Processes You Must Run
You must schedule these processes for supplier ship and debit:

• Create Accruals

• Create Accounting (from Oracle Fusion Subledger Accounting)

• Sweep Channel Transaction Accounting Events

• Import Payables Invoices (Oracle Fusion Payables scheduled process). The Source parameter must be set to
Claims.

• Generate Supplier Claims

• Close Settled Claims

Related Topics
• Overview of Scheduled Processes
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Starting an Implementation  
Identify the channel revenue flows and the offering(s) your user communities will access flows from. This decision
determines how you should opt in. Unlike other Fusion apps, some channel flows can be accessed from the Order
Management or Procurement offering.

Opt In To Channel Revenue Management
Modify the Predefined Offering

Channel Revenue Management requires opt in. You must first enable it as a functional area under Order Management
or Procurement to access its setup tasks.

Access from Order Management
1. From the Navigator, select Setup and Maintenance.
2. On the Setup: page, select Order Management from the drop-down list.
3. Click Change Feature Opt In.
4. On the Opt In: Order Management page, select the check box in the Enable column for the functional area:

Channel Revenue Management.
5. Click the Features icon.
6. In the Edit Features page, enable the following based on your business flow:

◦ Deductions and Settlement

◦ Supplier Channel Management

◦ Customer Channel Management

◦ Manage Deduction Claims Using Redwood Pages.

◦ Approve Customer Claims with BPM Workflow

Note:  Opt into this feature only if you choose to use BPM workflow-based approvals to process and
route the approval to the designated approvers.

Note:  After 24B, you can approve claims only with the Approve Customer Claims Using BPM Workflow
feature.

7. Click Done.
8. From the roadmap check list, finish each setup task as necessary, depending on your business requirements.

Access from Procurement
1. From the Navigator, select Setup and Maintenance.
2. On the Setup: page, select Procurement from the drop-down list.
3. Click Change Feature Opt In.
4. On the Opt In: Procurement page, select the check box in the Enable column for the functional area: Supplier

Incentives, which is under Purchasing.
5. Click the Features icon for Supplier Incentives.
6. In the Edit Features page, enable Supplier Channel Management.
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7. Click Done.
8. From the roadmap check list, finish each setup task as necessary, depending on your business requirements.

If you find that modifying the predefined offering doesn't meet your business requirements, then create a new
implementation.

Create a New Implementation Project
If the predefined offering doesn't meet your business requirements for some reason, then create a new implementation
project.

1. From the Navigator, select Setup and Maintenance.
2. On the Setup page, open the Tasks panel and select Manage Implementation Projects.
3. On the Implementation Projects page, click the Create icon, or select Create from the Actions drop-down list to

create a new project.
4. On the Create Implementation Project: Enter Basic Information page, modify the values as necessary, and then

click Next.
5. On the Create Implementation Project: Select Offerings to Implement page, in the Name list:

◦ Order Management

Expand Order Management. Enable the Include option for Order Management and Channel Revenue
Management.

◦ Procurement

Expand Procurement > Purchasing. Enable the Include option for Procurement, Purchasing, and Supplier
Incentives.

6. Click Save and Open Project.

You can create one or more implementation projects for the offerings and options. Each Oracle application
creates the task list you must finish for each project you create. An Application Implementation Manager can
set up these task lists, and assign and track each task that these lists contain.

7. On the Implementation Project page, in the Task list, expand and perform the tasks that your business flow
requires.

Export Setup Data
This procedure shows you how to export setup data using offering or functional area. You need appropriate roles
assigned to export setup data.

1. Click Navigator > My Enterprise > Setup and Maintenance.
2. In the Setup and Maintenance work area, select the offering you want to export from the Offering menu.
3. To export setup data:

◦ For an entire offering, select and open the Actions menu in the page header, and then select Export.

◦ For a specific functional area, select and open the Actions menu corresponding to the functional area,
and then select Export.

4. Select Create New to create a new export process.
5. Optionally, specify appropriate scope values to filter exported setup data. By default, all existing setup data

is exported for each business object processed during export. However, if scope is supported by any of those
business objects, you can select scope values to filter the exported setup data. To specify scope values for one
or more of the business objects:
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a. Select the applicable business object from the Business Objects table and then click Add. If no related
business object supports scope, then the table remains empty.

b. Search and select the value you want to use as scope for the business object and click Apply.
c. Repeat the previous step to add more scope values if needed. Click Done when finished.

6. Click Submit to start the export process.
7. Monitor the status of the export process until it completes by selecting Export from the Actions menu. Up to

three most recent processes are listed, and are ordered from newest to oldest. Each process indicates its status
at the time, and if it was completed already, then the time stamp when it was processed.

8. While the process is still in progress, you may select the status to view how much progress the process has
made at the time. A message shows you how many business objects were already processed out of the total
number of objects to be processed. Click View Progress to review the details on the business objects that were
already processed. Click the Refresh button to get the most recent information. Refer to the topic Review of
Export and Import Process Results for detailed description of the process results.

9. When the export process completes, select the status link to go to the Export Offering Data Results page.

◦ If the process completes successfully, the status is set to Ready to download.

i. Click Download File to download the configuration package .zip file and save it at an appropriate
location. Use this file to import setup data in the target environment.

ii. In addition, review the list of post export tasks. If any tasks are listed, then those tasks aren't
migrated by export and import process. You must migrate that data manually in the target
environment.

◦ On the other hand, if the process completes with errors, the status displays Ready for error review.

i. The Business Objects table shows all business objects that had errors during processing. Refer
to the topic Review of Export and Import Process Results for detailed description of the process
results.

ii. Click Download Log File from the page header, which includes the error log of all business
objects that experienced error. Alternatively, you can also click Actions > Download Log File
corresponding to a specific business object to download error log specific to that business object.

iii. After correcting the cause of the errors, create a new export process.

Note:  You can export the Order Management or Procurement Offering or the Channel Revenue Management
Functional Area.

Import Setup Data
This procedure shows you how to import setup data using an offering or functional area. You need appropriate roles
assigned to import setup data.

1. Click Navigator > My Enterprise > Setup and Maintenance.
2. In the Setup and Maintenance work area, select the offering you want to import from the Offering menu.
3. If the configuration package you want to import was created by exporting:

◦ An offering, select Import from the Actions menu in the page header.

◦ A functional area, select Import from the Actions menu corresponding to that functional area.

4. Select Create New to create a new import process.
5. Browse and select the configuration package file that contains the setup data you want to import. View the

Configuration Package Details to verify that you selected the correct file.
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◦ If the offering or functional area selected during export doesn't match the offering or functional area you
chose for the import process, an error message appears. Click the Update button to browse and select
the correct file.

6. Expand the Import Options section.

◦ Best practice is to select the Compare setup data prior to import option. If you select this option, the
import process automatically runs a comparison of the setup data in the configuration package file with
that in the target environment before importing the setup data.

Note:  Comparing setup data prior to import requires additional time. You may skip this step by not
selecting the Compare setup data prior to import option. However, if you skip this step, you can't
review how the setup data is similar or different in the source and target, and how the import process
changes setup data in the target environment.

◦ Optionally, select the Import feature selection option to import the opt-in configuration of the offering
or functional area you're importing. This imports the enabled dependent functional areas and features of
the offering or functional area.

◦ The Pause process each time an error occurs option is selected by default. If an error occurs, the import
process pauses so that you can take corrective action and resume the import. If you don't want the
import process to be interrupted even if there are errors, deselect the option. However, note that if any
prerequisite data fails, additional dependent data might not be imported correctly.

◦ The Pause process each time manual import setup data is required option is selected by default. The
import process pauses each time there's some data that you must manually import. You can deselect this
option if the data to be imported manually already exists in your target environment.

7. Click Submit to start the import process.
8. If any setup data requires manual entry before the import can start, a warning message appears. This message

shows you the tasks you must perform before submitting the process.

◦ If you verified that the setup data for those tasks are already entered in the target environment, click
Submit.

◦ Otherwise, click Cancel. Create a new import process after you ensure that the setup data is entered in
the target environment.

9. Monitor the import process by clicking Actions > Import. Up to three most recent processes are listed and
ordered from newest to oldest. Each process indicates its status at the time and, if the process is completed, the
time stamp when it was processed.

10. While the process is in progress, you can select the status to view how much progress the process made at
the time. A message shows you how many business objects were already processed out of the total number
of the objects to be processed. Click View Progress to review the details of the business objects that finished
processing. Click the Refresh button to view the most recent information. Refer to the topic Review of Export
and Import Process Results for detailed information about the process results.

11. If you selected the Compare setup data prior to import option, once the comparison completes, the status
reads Waiting for comparison review. Select the status to go to the Import Offering Data Results page to
review the comparison results. Refer to the topic Compare Setup Data Using Offering or Functional Area for a
detailed description of the comparison results.

12. Click Continue to Import from the Import Offering Data Results page to start the import process if you're
satisfied with the comparison results.

13. Alternatively, if you didn't select the Compare setup data prior to import option, the import process starts
automatically.

14. Monitor the process as before, until it completes.
15. If any setup data requires manual data entry during import, the process pauses, and the status reads Waiting

for manual import.
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a. Select the status to go to the Import Offering Data Results page and review the details.
b. A list displays the business objects that require manual data entry before import.
c. For each of the listed business objects, click Go to task. This displays a list of related tasks. Select each

task to enter the required data.
d. After you enter the setup data for all the listed business objects, click Resume from the Import Offering

Data Results page to restart the import process.
e. Click Confirm in the confirmation message that appears to resume the import process.

16. Continue to monitor the process until it completes.
17. If the import process completes successfully:

a. Review the results to verify successful completion.
b. If any post import tasks are listed, ensure that their setup data is entered. Otherwise, the setup data

remains incomplete, and you experience errors when processing transactions.
18. If the import process completes with errors:

a. The Business Objects table displays all business objects which encountered errors while processing. Refer
to the topic Review of Export and Import Process Results for a detailed description of the process results.

b. Click the Download Log File from the page header level. This includes the error log of all business
objects that encountered errors. Alternatively, click Actions > Download Log File corresponding to a
specific business object to download the error log specific to that business object.

c. Create a new import process after correcting the errors.

Export Setup Data to a CSV File
To export setup data to a CSV file, follow these steps:

1. Click Navigator > My Enterprise > Setup and Maintenance.
2. In the Setup and Maintenance work area, select the offering whose task requires setup data entry using CSV

file.
3. Identify the setup data as appropriate:

◦ For all tasks associated with the offering, click Actions > Export to CSV File.

◦ For all tasks associated with a functional area, select the functional area and click Actions > Export to
CSV File.

◦ For specific tasks:
i. Select the appropriate functional area and go to the Tasks table.

ii. Select Columns > View > Actions to make the applicable task actions visible.
iii. Select the task, and from the corresponding Actions menu, select Export to CSV File.

Note:  The Export to CSV file option is disabled if the task doesn't support export.

4. Select Create New. You can export all existing setup data represented by the task.

◦ If Scope is supported for any of the selected setup tasks, you can select appropriate scope values to filter
the setup data you want to export.

◦ You can also download the template for managing setup data without exporting the existing setup data
in the environment. To do so, select the Export only template files check box.

5. Click Submit to start the export process.
6. Select Export to CSV file for the offering, or functional area, or task as appropriate, to see the latest process.

Monitor the process at any level until it completes.
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7. Select the process after it's complete and review the results. Verify that the process completed without any error
before you download the CSV file package.

If there are more than one business objects associated with the task, you may find more than one CSV files.

Modify Setup Data in a CSV File
To enter or modify setup data before importing it into the target environment, you must edit the CSV file. While editing,
ensure that you maintain the exact format for dates, numbers, and any other value that's present in the original
exported CSV file.

CAUTION:  Never delete any CSV file from the downloaded CSV package. Deleting a CSV file will cause errors during
import. If you don't want to include setup data from a particular CSV file, remove all records (rows) from the CSV file
except the heading row. Even if that CSV file is empty, you must include it in the CSV package to be imported.

If your file contains setup data with Date attributes, you must specify the correct date format that appears in the
exported setup data file.

1. Open the original exported file using a CSV editor such as WordPad and review the date format attribute (for
example, 2015/10/25).

2. Open the CSV file using Microsoft Excel.
3. Select the Date attribute and click Format Cells. Change the Category to Custom and provide the same format

that appeared in the original file. In the same way, provide the format for all date columns.

Note:  Depending on the setup data, you must use the custom format to match the correct data format in
columns as suggested in the following table.

Columns Data in CSV Custom Format Cells

Date
 

2018/03/02
 

yyyy/mm/dd

 

Date and Time
 

2018/02/28 12:07:48:48
 

yyyy/mm/dd hh:mm:ss.SSS

 

Long Number
 

123456789123
 

Custom > 0

 

4. Modify the remaining setup data as per your requirement.

Tip:  If you require further information to understand how to fill up the CSV file, refer to the Help associated
with the task.

5. Save the file in CSV format and immediately close it to prevent any other change. Ensure that the CSV file size
doesn't exceed 10MB. The CSV file is ready for import.

If your file contains setup data with special characters for other languages such as Chinese, you might need to specify
Text as the column format to represent such information.

1. Open Microsoft Excel and click the Data tab.
2. In the Get External Data group, click From Text.
3. Navigate to and select the CSV file you downloaded. .
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4. Select Delimited as Data Type and click Next.
5. Select Comma as delimiter and click Next.
6. Select Text as column data format for all columns and click Finish. You can now edit the file.
7. Save the file as file type Unicode Text (.txt) and close it.
8. Open the file again using Notepad++:

a. Find and replace all tab characters with commas.
b. Change the encoding to Encode in UTF-8.

9. Save and close the file.
10. Change the file extension from .txt to .csv.
11. Save the CSV into a .zip file. Ensure that the CSV file size doesn't exceed 10MB. You can now import the file.

Import Setup Data from a CSV File
To upload the new or modified setup data, follow these steps:

1. Select Import from CSV file from the Actions menu of an offering, a functional area, or a task as appropriate.
2. Select Create New.
3. Select the appropriate .zip file. The application validates that the file corresponds to the selected offering,

functional area, or task before you can submit the process.
4. Click Submit.
5. Select Import from CSV file to see the latest processes. Monitor the process until it completes.
6. Select the process once it completes to review the results. If any error occurs, review the details listed in Status

Details in the Business Objects section. Fix the issues and import again, if necessary.
7. After you import the setup data successfully, you can verify the loaded data by selecting the task from the

Setup page.

Related Topics
• Starting Decision Points

Time Zones in Channel Revenue Management  
Here you will understand how to configure time zones in Channel Revenue Management.

The channel application takes into consideration these time zones:

• Server time zone: The time zone configured on the application server. In the case of cloud servers, this time
zone is set as Coordinated Universal Time (UTC).

• Legal entity time zone: The time zone in which the business unit's legal entity exists. This is defined as part of
the legal address linked to the legal entity. If you want the transactions to be accounted for in this time zone,
you must select the legal entity time zone check box in the legal entity definition.

All dates in Channel Revenue Management use the legal entity time zone for the business unit. If the legal entity time
zone is not set, then the application uses the UTC (Coordinated Universal Time).

Important Considerations
Before commencing enablement for the legal entity time zone feature, there are implementation considerations that
need to be taken into account. Consider if your server time zone is different than your legal entity time zone.
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Note:  Existing dates in channel programs, claims, adjustments and transactions will remain unchanged after the
upgrade. The dates in existing programs, claims, adjustments and transactions will be treated as being in the legal
entity time zone. Hence, a supplier claim may have older accruals with accrual date in the server time zone and newer
accruals in the legal entity time zone.

For Deductions and Settlement:

• Existing dates stamped in server time zone by Channel in existing claims and set ups will be treated as in the
legal entity time zone.

• New claims and their processing are treated in the legal entity time zone.

For Supplier Channel Management:

• Existing dates stamped in server time zone by Channel in existing programs, accruals, adjustments and claims
will be treated as in the legal entity time zone.

• New inbound transactions and new processing are treated in the legal entity time zone, including CSV uploads.
So consider the business processes around the preparation of inbound transactions, as imported dates will be
treated in the legal entity time zone.

• There are 2 exceptions for purchase order related dates:

• ◦ Requested Delivery Date and Requested Ship Date are displayed in Channel, as they were entered in the
PO. Purchase Order does not capture a time zone for these dates. Channel will process these dates as is
without any conversions.

◦ The processing of the dates within the eligibility service REST will be in the legal entity time zone.
However, all dates returned by the eligibility service REST are in Coordinated Universal Time (UTC).

Set Up Legal Entity Time Zones
To enable legal entity time zone, perform the following steps.

1. With roles having the required access, Opt-in to the Use the Legal Entity Time Zone in Channel Revenue
Management feature.

Note:  Currently, this opt-in feature is a temporary opt-in. The opt-in will become mandatory from Release
22D.

2. With roles having the required access, navigate to the Setup and Maintenance work area. Click Tasks and
search for the Manage Administrator Profile Values task. In the Profile Option Code field, query for the
option XLE_ENABLE_LEGAL_ENTITY_TIMEZONE with Enable Legal Entity Time Zone as the Profile Option
Display Name.

3. In the Profile Values record, add a new row, and enter the following information:

◦ Profile Level - Set the profile level to Site. Don't use any other level because it would result in
inconsistent data in Channel Revenue Management.

◦ Profile Value - Set the profile value to Yes to enable the legal entity time zone in Channel Revenue
Management.

Note:  It is recommended that you don't update the profile option once you have set it to Yes.

4. With roles having the required access, navigate to the Setup and Maintenance work area:

◦ Offering: Order Management

◦ Functional Area: Legal Structures
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◦ Task: Manage Legal Entity

5. On the Scope dialog box, select Search Legal Entities, and click Apply and Go to Task.
6. On the Manage Legal Entities page, search for and select the legal entity you require, and select Edit from the

Actions menu.
7. In the Legal Entity Addresses section on the Edit Legal Entity page, select the Primary address. Select Edit

address from the Actions menu, and in the Edit Address dialog, select the Time Zone for the primary legal
entity.

Channel Revenue Time Zones
This table describes how Channel handles and processes various dates in the application.

How Channel Uses Dates From Displayed and Processed as LETZ Additional Information

Programs, Accruals, Claims, and Adjustments
User Interface

Yes All user enterable dates are in the legal entity
time zone. By default, the current date with
time is converted to the legal entity time zone.

REST (except eligibility) Yes All dates passed to the REST are assumed to be
in the LE time zone. By default, the current date
with time is converted to the legal entity time
zone. All functional dates returned by REST
should be in LE time zone. WHO column dates
should be in the server time zone.

ESS Scheduled Processes
• Create Accruals Scheduled Process

• Create Accruals for Channel Batch
Scheduled Process

• Create Accruals for Volume Programs
Scheduled Process

• Generate Supplier Claims Scheduled
Process

• Settle Supplier Claims Scheduled Process

• Mass Settle Scheduled Process

Yes By default, the current date with time is
converted to the legal entity time zone.

WHO Columns No WHO column dates always use the server time
zone.

Descriptive Flexfield Attributes No No conversion is applicable to date and
datetime attributes.

FSM UI No For FSM UI using the Reference Set, the start
and end dates must be in reference to the
respective transaction using it. WHO columns
continue to use the server time zone. There is
no impact on the following items:

1. User Statuses
2. Program Types
3. Adjustment Types
4. Claim Types
5. Claim Reasons
6. Claim Sources

All dates in CSVs Yes
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How Channel Uses Dates From Displayed and Processed as LETZ Additional Information

Order Management:
• Ordered Date

• Requested Ship Date

Yes The Ordered Date and the Requested Ship Date
are datetime attributes and they are in UTC.
Channel converts these dates to the legal entity
time zone and passes this information to the
eligibility service.

Procurement
• Purchase Order Date

• Requested Delivery Date

• Requested Ship Date

Yes The Purchase Order Date, the Requested
Delivery Date, and the Requested Ship Date
are datetime attributes and they are in UTC.
Channel converts these dates to the legal entity
time zone and passes this information to the
eligibility service.

Inventory Management
• Receipt Transaction Date

• Shipped Date

Yes The Receipt Transaction Date and the Shipped
Date are datetime attributes and they are in
UTC. Channel converts these dates to the legal
entity time zone and passes this information to
the eligibility service.

How to Enable Smart Search  
This feature uses Oracle Search Extension Framework to provide a powerful index-based search engine combined with
Oracle's next user experience so you can quickly and easily perform full-text searches for programs or claims across
dozens of attributes.

1. Run the scheduled process ESS job to create index definition and perform initial ingest to OSCS to create
index definition and perform initial ingest to Oracle Search with the following parameter values:

Parameter Name Parameter Value Description

Index Name to Create
and Ingest

fa-cjm-customer-programs This parameter enables
you to register the
customer program
index and load initial
index data, if any, to the
Oracle Search server.
To do this, you must
also have the Manage
Customer Programs
privilege.

Index Name to Create
and Ingest

fa-fscm-customerclaim This parameter enables
you to register customer
claim index and load
intial data for customer
claims, if any, to the
Oracle Search server.
To do this, you must
also have the Manage
Customer Claims
privilege.

This creates index definitions and adds data to the Oracle search server. The time taken to run the batch process
depends on the amount of data.
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Note:  If you resubmit the ESS job to create index definition and perform initial ingest to OSCS process after the
index is already created, then the process clears the index and reingests the entire data again.

For additional details on implementing Oracle Search Extension Framework, see the section entitled Search Extension
Framework in the Search chapter of the guide Implementing Applications.

1. Ensure you have the following Supply Chain Application Administrator predefined job role to run the ESS job to
create index definition and perform initial ingest to OSCS to create and update the index:

2. Ensure that you have the appropriate privileges to view or manage programs:
◦ Manage Customer Programs

◦ View Customer Programs

3. Ensure that you have the appropriate privileges to view or manage claims:
◦ Manage Customer Claims

◦ View Customer Claims

4. If you have one of the following predefined duty roles, you have the required privileges to search and view
programs in the Programs page:

◦ Customer Channel Program Management

◦ Customer Channel Program Viewing

5. If you have one of the following predefined duty roles, you have the required privileges to search and view
programs in the Claims page:

◦ Channel Claims Management

◦ Channel Claims Viewing

Related Topics
• Elements of a Customer Promotion Program

• Elements of a Customer Claim

Security Tasks  
Here are some of the security tasks that are required for Channel Revenue Management.

• Create Implementation Users

• Manage HCM User Accounts

• Manage Data Security Policies

• Manage Duties

• Manage User Principal

• Provision Roles to Implementation Users

Owners in Channel Programs, Claims and Adjustments must be set up as HCM workers. A warning message is displayed
when you open a program, claim, or adjustment where the owner is not set up as an HCM worker.

Run the Validate Channel Owner Data scheduled process to report on owners who are not HCM workers. This report
display owners of programs, claims or adjustments who aren't set up as HCM workers. Select a value from the Owner
User Name list to run this process for a specific username. Alternatively, leave this field blank to run the process for all
usernames.
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For more information, see Getting Started with Oracle Fusion Applications: Common Implementation (1387777.1) on My
Oracle Support at https://support.oracle.com.

You can do these tasks using the Security Console as a super user:

• Manage Job Roles

• Manage Role Templates

Related Topics
• Manage HCM User Accounts

• Create User Accounts for Implementation Users

• Create Application Users
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3  Integrate

Integrating Channel Revenue Management with Other
Oracle Cloud Applications  
Channel Revenue Management is integrated with the following Oracle applications depending on the channel flow.

• For Deductions and Settlement

◦ Oracle Fusion Receivables

• For Sell Side - Customer Promotions

◦ Tools > Import Management for CSV file import

◦ Oracle Fusion Pricing for program eligibility

◦ Oracle Fusion Subledger Account

◦ Oracle Fusion Receivables

• For Buy Side - Supplier Rebate

◦ Oracle Fusion Receiving, Purchasing, and Payables for direct integration to inbound receiving
transactions

◦ Tools > Import Management for CSV file import

◦ Oracle Fusion Subledger Accounting

◦ Oracle Fusion Payables

• For Buy Side - Supplier Annual Program

◦ Tools > Import Management for CSV file import

◦ Oracle Fusion Subledger Accounting

◦ Oracle Fusion Payables

• For Buy Side - Supplier Ship and Debit

◦ Oracle Fusion Pricing

◦ Oracle Fusion Order Management for direct integration to inbound sales orders

◦ Oracle Fusion Subledger Accounting

◦ Oracle Fusion Payables

Oracle Fusion Receivables Integration  
Integration with Receivables lets you create and settle claims against receipts for deductions or overpayments. You must
enable Channel Revenue Management in your Receivables application for this.
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How to Enable the Integration
1. With roles having the required access, navigate to the Setup and Maintenance work area.

◦ Offering: Financials

◦ Functional Area: Receivables

◦ Task: Manage Receivables System Options

2. Search for and select your business unit.
3. Click the Cash Processing tab.
4. Select the Enable channel revenue management integration check box.
5. Click Save.

Standardize Claim Reasons
Some customers may have their own set of reason codes for raising a dispute or short paying you. You can standardize
your customer claim reasons by translating the reason for the dispute provided by your customers to a standard
set of reason codes. You can create a mapping between your claim reasons and those provided by your customers,
which can be used to automatically categorize the reason for the claim. This mapping can be created in the Manage
Customer Trade Profiles page. This streamlines the initial classification of claims for immediate visibility into queues
of work. This translation is supported in Lockbox, in the Receivables integration, in the Manual Claim UI, and in the
channelCustomerClaims REST service.

Manage Transaction Types
The accounting for settlement is handled by Receivables, driven through the Channel mappings to Receivables
transactions and activities. For credit memos and invoices, Receivables performs the subledger accounting based on the
Receivables transactions and activities created by Channel Revenue Management settlement.

• Claim Type setup for a deduction includes a one to one mapping to a Receivables credit memo transaction type.

• Claim Type setup for an overpayment includes a one to one mapping to a Receivables invoice transaction type.

• Claim Reason setup for a deduction includes a one to one mapping to a Receivables credit memo reason.

You can manage transaction types here:

• Offering: Financials

• Functional Area: Customer Billing

• Task: Manage Transaction Types

Note:  You must set up the subledger accounting for any new Receivables transaction types.

Manage Transaction Sources
Configure the predefined transaction source, Channel Revenue Management, which is available as the transaction
source for the receivables credit memo or invoices created during settlement of a claim.

• Offering: Financials

• Functional Area: Customer Billing

• Task: Manage Transaction Sources
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Manage Receivables Activities
The accounting for claim investigation is derived from the receivables activity associated with the claim investigation
application. Configure the predefined receivables activity for the activity type Channel Claim Investigation available
under Manage Receivables Activities. Add the Activity GL Account for your business unit.

• Offering: Financials

• Functional Area: Receivables

• Task: Manage Receivables Activities

Date Population in Receivables upon Settlement
• Receipt Application Date

◦ Will be the same as Override Transaction Date if it's a future date and after the Receipt Date.

◦ Else, if Override Transaction Date isn't set, and Claim Accounting Date is a future date and after the
Receipt Date, then Receipt Application Date will be the Claim Accounting Date.

◦ Else, if the Receipt Date is in the future, then Receipt Application Date will be the Receipt Date.

◦ Else it will be the System Date (settlement system date).

For example, System Date = May 28

◦ Override Transaction Date = 5th June, Receipt Date = 4th June

Then Receipt Application Date = 5th June

◦ Override Transaction Date = 3rd June, Receipt Date = 6th June

Then Receipt Application Date = 6th June

◦ Override Transaction Date =1st May, Receipt Date = 2nd May

Then Receipt Application Date = 28th May

• Receipt Application Accounting Date

◦ Will be the same as Claim Accounting Date, if it's a future date and after the Receipt Accounting Date.

◦ Else, if the Receipt Accounting Date is in the future, then Receipt Application Accounting Date will be the
Receipt Accounting Date.

◦ Else it will be the System Date (settlement system date).

For example, System Date = May 28

◦ Claim Accounting Date = 5th June, Receipt Accounting Date = 4th June

Then Receipt Application Accounting Date = 5th June

◦ Claim Accounting Date = 3rd June, Receipt Accounting Date = 6th June

Then Receipt Application Accounting Date = 6th June

◦ Claim Accounting Date =1st May, Receipt Accounting Date = 2nd May

Then Receipt Application Accounting Date = 28th May
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Note:  In the Settle Customer Claims scheduled process, the Receivables integration for settlement synchronously
calls the Receivables API and not the asynchronous Auto Invoice interface. The log file for the scheduled process
documents the claims processed in Receivables.

Privileges for Quick Links to Receivables Transactions
You must assign these privileges to users to enable them to view the Receivables transactions directly from Channel
Revenue Management.

This table contains the privileges required for a user to view the Receivables transactions directly from Channel Revenue
Management.

Privilege Usage Code Description Assigned to Duty Role

View Receivables Activities
Data
 

DATA
 

AR_VIEW_RECEIVABLES_
ACTIVITIES_DATA
 

View Receivables activities
data.
 

Channel Claims Manager
 

View Receivables Credit
Memo
 

Function
 

AR_VIEW_RECEIVABLES_
CREDIT_MEMO
 

View a Receivables receipt.
 

Channel Claims
Management Duty
 

View Receivables Invoice
 

Function
 

AR_VIEW_RECEIVABLES_
INVOICE
 

View a Receivables invoice.
 

Channel Claims
Management Duty
 

View Receivables Receipt
 

Function
 

AR_VIEW_RECEIVABLES_
RECEIPT
 

View a Receivables credit
memo.
 

Channel Claims
Management Duty
 

Related Topics
• Requirements for Completing a Receivables Transaction

• How can I arrange the creation of transaction types?

• Receivables Activity Types

• Predefined Receivables Data in Subledger Accounting

• Receivables Accrual Accounting Entries

Oracle Fusion Receiving, Purchasing, and Payables for
Direct Integration to Inbound Receiving Transactions  
To claim rebates from suppliers, Channel Revenue Management directly integrates with Oracle Receiving to get the
receipt of goods. When Receiving receives goods, the Load Transactions process can be used to extract these receiving
transactions and related PO details into channel batches.

For supplier rebates, supplier invoices from Payables can be used to trigger the accruals for received shipments. The
Load Transactions process extracts receiving transactions into channel batches. The Create Accruals for Channel
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Batch process creates potential accruals in the open status for receipts in the batch without supplier invoices. Earned
accruals are recognized for receipts in the batch with invoices.

Note:  Drop Ship purchase orders and Consignment orders aren't in scope for the Procurement integration.

Supplier Portal Integration  
The Fusion Supplier Portal enables a buying company (wholesaler/distributor) to negotiate and communicate channel
agreements with their suppliers.

As a supplier contact on the Supplier Portal, you can create, submit, and view your channel programs and interact with
your sales channel partner. It leverages the Portal’s existing security model, allowing supplier contact access to supplier
programs based on their data access at supplier and supplier site levels. This integration helps you to:

• Invite suppliers to securely create and offer programs directly from the Supplier Portal.

• Centralize the definition of supplier incentives.

• Reduce and share administrative load of managing programs.

Suppliers create their program in a draft status, which is then reviewed and approved by the supplier channel manager
prior to program activation. For wholesalers and distributors this self service capability reduces and shares the
administrative load of manage programs with their suppliers.

Actions Required for Manage Supplier Programs
The Managing supplier programs through the supplier portal is delivered disabled. The following actions must be taken
to use this feature.

• The enablement for the supplier portal integration requires the enablement of Supplier Channel Management,
which involves the following opt ins:

a. Opt in to the Supplier Incentives functional area under the Procurement offering.
b. Then opt in to the Supplier Channel Management feature.

After you opt in, perform the following tasks:

1. Provision access to Supplier Portal for the supplier and their contacts.
2. Configure applicable Program Types.
3. Specify the Default Program Owner in the Supplier Trade Profile.
4. Configure supplier items using the Trading Partner Item page in the Product Information Management work

area.

Access for Manage Supplier Programs
• Access to this feature is through the shipped job role Supplier Sales Representative.

• Access to this feature is through shipped privileges:
◦ Manage Supplier Programs in Supplier Portal

◦ View Supplier Programs in Supplier Portal

• The Manage Channel Programs (from Supplier Portal) business processes is affected by this feature.
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You can additionally capture notes in a claim and capture attachments in a claim. This capability helps to justify the
resolution taken during approval and audit.

Notes and attachments for supplier claims are delivered disabled. Actions must be taken to use this feature.

• Access to this feature is through the Supplier Channel Manager job role.

• Access to this feature is through any role with the Manage Supplier Claims privilege.

• The Manage Channel Programs business processes is affected by this feature.

Oracle Fusion Payables Integration for Settlement  
Supplier claims are paid through the Payables cloud. The two settlements methods for Channel Revenue Management
for payment of these supplier claims are AP Debit and AP Default Payment.

This table shows details of the Payables integration for supplier claim settlement.

Settlement Method AP Debit AP Default Payment

Claim Class
 

DEBIT CLAIM
 

CLAIM
 

Usage
 

When a supplier claim is positive, this amount
is collected from the supplier through a debit
memo with a negative amount. This is typical of
a promotional supplier claim. The debit memo
is applied to a payment instrument like a check.
The check may be for a payment to a supplier (a
positive amount).
 

When a supplier claim is negative, this amount
is paid to the supplier through a check or EFT
and is common when a supplier rejects a claim
accrual and you want to issue a refund check
immediately to the supplier. A payables invoice
is created and a payment instrument is issued.
There may be multiple checks if the original
check is canceled and reissued.
 

Payment Method
 

Supplier Claim - positive amounts
 
Debit Memo - negative amounts
 
Instrument - positive amounts
 
Instrument (refund) - negative amounts
 

Supplier Claim - negative amounts
 
Invoice - positive amounts
 
Instrument - positive amounts
 

Settlement Document Type
 

Transaction (applied to check, EFT)
 

Instrument (settled by check, EFT)
 

Claim Closure
 

Immediately available to be closed after
Settlement Pending status, as a debit memo
may be applied to any outstanding balance.
 

After Invoice is fully paid.
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Oracle Fusion Subledger Accounting Integration  

Oracle Fusion Subledger Accounting for Sell Side Integration  
Subledger Accounting integration enables you to define and configure accounting rules and generate detailed
accounting for business transactions in Channel Revenue Management.

Predefined Subledger Accounting Setup
Channel Revenue Management has been registered as a subledger application. The setup tasks are available in the
Channel Revenue Management functional area to help you set up your subledger. It enables corporations to comply
with corporate, local and managerial accounting and audit requirements via increased control, visibility and efficiency.

Journal Source and Categories
Journal entries created for transactions from Channel Revenue Management are assigned the following journal source
and categories. Channel Revenue Management assigns default journal categories to each event class. You can configure
the assignment in the Subledger Accounting Options task.

This table gives the journal sources and journal categories for Channel Revenue Management.

Field Values

Journal Sources
 

Channel Revenue
 

Journal Category
 

Channel Accrual
 
Channel Claim
 

Channel Revenue Management Sell Side Event Classes
An accounting event is a business event in Channel Revenue Management that has an accounting impact. Subledger
Accounting categorizes accounting events as event types. Event types are grouped into event classes. The Channel
Revenue Management accounting event model is predefined for you, and includes each event class and its life cycle.
This accounting event model forms the basis for creating subledger accounting. An event class enables Subledger
Accounting to handle the accounting for similar business events in a consistent manner.

For the sell side flows, the Subledger Accounting integration is centered on deriving accounting rules for two
accounting event classes:

Event Class Event Types

Customer Accrual
 

Customer Accrual Creation
 

Customer Claim Settlement
 

• Customer Claim settlement by Credit Memo
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Event Class Event Types

• Customer Claim Settlement Reversal

Note:  If a claim/deduction is nonpromotional it isn’t interfaced to Subledger Accounting or General Ledger.

Customer Accrual Event
For all accruals that are created, an accrual event triggers its accounting to General Ledger. Accounting events are raised
with the respective event types for all accruals created in Channel Revenue Management. Customer accrual events:

• Debit Sales or Expense Account

• Credit Accrual Liability Account

For example:

Dr/Cr Account Amount

Dr.
 

Sales or Expense
 

USD 100
 

Cr.
 

Accrual Liability
 

USD 100
 

Predefined Accounting Rules for Customer Accruals
The following subledger accounting rules are used to generate accounting for customer accruals if predefined journal
entry rule set is in use. The accounts to debit and credit are defined in the Subledger Accounting mapping sets.

Event Class Name Journal Entry Rule
Set

Journal Line Rule Side Account Rule Mapping Set

Customer Accrual
 

Customer Accrual Rule
 

Sales or Expense
 

Debit
 

Sales or Expense
Account
 

Sales or Expense
Account
 

Customer Accrual
 

Customer Accrual Rule
 

Accrual Liability
 

Credit
 

Accrual Liability
Account
 

Accrual Liability
Account
 

Customer Claim Settlement Event
When a claim or deduction is associated with promotional accruals or earnings, and the claim is being settled by credit
memo, another accounting event is triggered. Channel Revenue Management passes the Receivables Clearing Account
to Receivables and creates the following customer claim settlement entries:

• Debit Claim Accrual Liability Account

• Credit Receivables Clearing Account

For example:
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Dr/Cr Account Amount

Dr.
 

Claim Accrual Liability Account
 

USD 100
 

Cr.
 

Receivables Clearing Account
 

USD 100
 

Predefined Accounting Rules for Customer Claim Settlements
The following subledger accounting rules are used to generate accounting for customer claim settlements if predefined
journal entry rule set is in use. The accounts to debit and credit are defined in the Subledger Accounting mapping sets.

Event Class Name Journal Entry Rule
Set

Journal Line Rule Side Account Rule Mapping Set

Customer Claim
Settlement
 

Customer Claim
Settlement by Credit
Memo Rule
 

Claim Accrual Liability
 

Debit
 

Claim Accrual Liability
Account
 

Claim Accrual Liability
Account
 

Customer Claim
Settlement
 

Customer Claim
Settlement by Credit
Memo Rule
 

Receivables Clearing
 

Credit
 

Receivables Clearing
Account
 

Receivables Clearing
Account
 

Reversal Event for Customer Claim Settlements
If Claim is reopened from Settlement Pending status because of any issues, Settle Customer Claims scheduled process
verifies that the event was processed successfully or not.

• If the first event was processed successfully, then the application creates a reversal event.

If the first event isn't processed, then the application deletes the existing event.

Manage Mapping Sets for Channel Revenue Management Sell Side
The following predefined mapping sets are available for Channel Revenue Management Sell Side. These map the
predefined input sources with the Chart of Accounts for your ledger.

Mapping Set Usage Output Type Input Sources

Accrual Liability Account
 

Mapping set for the accrual liability
account.
 

Account combination
 

• Customer Accrual Business
Unit

• Customer Adjustment Type

Claim Accrual Liability Account
 

Mapping set for the claim accrual
liability account.
 

Account combination
 

• Customer Claim Business Unit

• Customer Claim Type

Exchange Gain Account for
customer claim
 

Mapping set for the exchange gain
account for customer claim.
 

Account combination
 

Customer Claim Business Unit
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Mapping Set Usage Output Type Input Sources

Exchange Loss Account for
customer claim
 

Mapping set for the exchange loss
account for customer claim.
 

Account combination
 

Customer Claim Business Unit
 

Receivables Clearing Account
 

Mapping set for the receivables
clearing account.
 

Account combination
 

• Customer Claim Business Unit

• Customer Claim Type

Sales or Expense Account Mapping set for the sales or
expense account.

Account combination • Customer Accrual Business
Unit

• Customer Adjustment Type

Assign Accounts to Predefined Mapping Sets
You must associate at least one output value for your ledger's chart of accounts for each of the above mapping sets if
you're using the predefined journal entry rule sets.

1. With roles having the required access, navigate to the Setup and Maintenance work area.

◦ Offering: Order Management/Procurement

◦ Functional Area: Channel Revenue Management/Supplier Incentives

◦ Task: Manage Mapping Sets

2. The Manage Mapping Sets: Channel Revenue Management page opens, where you can see the mapping sets
for your subledger. Select a mapping set to edit it.

3. In the Chart of Accounts section of the Edit Mapping Set, click the Add Row icon. Select the chart of accounts
from the drop-down list.

4. In the Mappings section, add the Input source to Output type mappings for your account. If applicable, select
the Default button to identify a default account to be used in case there is no mapping available for the input
source value.

5. Click Save.

Note:  Create a custom mapping set only if you must map the account to different input sources.

Sweeping the Transactions
The Sweep Channel Transaction Accounting Events scheduled process is used to sweep unaccounted channel
transactions to open or future enterable period.

Oracle Fusion Subledger Accounting for Buy Side Integration  
Subledger Accounting integration enables you to define and configure accounting rules and generate detailed
accounting for business transactions in Channel Revenue Management. General Ledger integration enables the posting
of accounting journals to the general ledger for financial reporting.

Predefined Subledger Accounting Setup
Channel Revenue Management has been registered as a subledger application. The setup tasks are available in the
Channel Revenue Management functional area to help you set up your subledger.
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Journal Source and Categories
Journal entries created for transactions from Channel Revenue Management are assigned the following journal source
and categories. Channel Revenue Management assigns default journal categories to each event class. You can configure
the assignment in the Subledger Accounting Options task.

This table gives the journal sources and journal categories for Channel Revenue Management.

Field Values

Journal Sources
 

Channel Revenue
 

Journal Category
 

Channel Accrual
 
Channel Claim
 

Channel Revenue Management Event Classes
An accounting event is a business event in Channel Revenue Management that has an accounting impact. Subledger
Accounting categorizes accounting events as event types. Event types are grouped into event classes. The Channel
Revenue Management accounting event model is predefined for you, and includes each event class and its life cycle.
This accounting event model forms the basis for creating subledger accounting. An event class enables Subledger
Accounting to handle the accounting for similar business events in a consistent manner.

For Channel Revenue Management, the Subledger Accounting integration is centered around deriving accounting rules
for two accounting event classes:

Event Class Event Types

Supplier Accrual
 

Supplier Accrual Creation
 
Supplier Accrual Adjustment
 

Supplier Claim Settlement
 

Supplier Claim Settlement by Check/Wire/EFT/AP Default
 
Supplier Claim Settlement by AP Debit
 

Supplier Accrual Event
For all accruals that are created, an accrual event triggers it's accounting to General Ledger. Accounting events are
raised with the respective event types for all accruals created in Channel Revenue Management. Supplier accrual events:

• Debit the Accrual Asset account

• Credit the Income or Discount on COGS account

For example:
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Dr/Cr Account Amount

Dr.
 

Accrual Asset
 

USD 100
 

Cr.
 

Income or Discount on COGS
 

USD 100
 

Predefined Accounting Rules for Supplier Accruals
The following subledger accounting rules are used to generate accounting for supplier accruals if predefined journal
entry rule set is in use. The accounts to debit and credit are defined in the Subledger Accounting mapping sets.

Event Class Name Journal Entry Rule
Set

Journal Line Rule Side Account Rule Mapping Set

Supplier Accrual
 

Supplier Accrual Rule
 

Accrual Asset
 

Debit
 

Accrual Asset Account
 

Accrual Asset Account
 

Supplier Accrual
 

Supplier Accrual Rule
 

Income or Discount on
COGS
 

Credit
 

Income or Discount on
COGS Account
 

Income or Discount on
COGS Account
 

Supplier Claim Settlement Event
For all promotional claims that are settled after association to earnings, another accounting event is triggered.
Accounting events are raised after the claim is initiated for settlement. Supplier claim settlement events:

• Credit the Claim Accrual account

• Debit the Payables Clearing account

• Credit the Primary Ledger Exchange Gain and Loss account (from conversion rate differences between when
it's accrued vs paid)

For example:

Dr/Cr Account Amount

Cr.
 

Claim Accrual Asset account
 

USD 100
 

Dr.
 

Payables Clearing account
 

USD 100
 

Predefined Accounting Rules for Supplier Claim Settlements
The following subledger accounting rules are used to generate accounting for supplier claim settlements if predefined
journal entry rule set is in use. The accounts to debit and credit are defined in the Subledger Accounting mapping sets.
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Event Class Name Journal Entry Rule
Set

Journal Line Rule Side Account Rule Mapping Set

Supplier Claim
Settlement
 

Supplier Claim
Settlement by
Payables Rule
 

Payables Clearing
 

Debit
 

Payables Clearing
Account
 

Payables Clearing
Account
 

Supplier Claim
Settlement
 

Supplier Claim
Settlement by
Payables Rule
 

Claim Accrual Asset
 

Credit
 

Claim Accrual Asset
Account
 

Claim Accrual Asset
Account
 

Supplier Claim
Settlement
 

Supplier Claim
Settlement by
Payables Rule
 

Primary Ledger
Exchange Gain or Loss
 

Credit
 

Claim Gain or Loss
Account
 

Exchange Gain
Account
 
Exchange Loss
Account
 

Manage Mapping Sets
The following predefined mapping sets are available for Channel Revenue Management. These map the predefined
input sources with the Chart of Accounts for your ledger.

Mapping Set Usage Output Type Input Sources

Accrual Asset Account
 

Map the accrual asset account
to the accrual business unit and
adjustment type.
 

Account combination
 

• Accrual Business Unit

• Adjustment Type

Claim Accrual Asset Account
 

Map the claim accrual asset
account to the claim business unit
and claim type.
 

Account combination
 

• Claim Business Unit

• Claim Type

Exchange Gain Account
 

Map the exchange gain account to
the claim business unit.
 

Account combination
 

Claim Business Unit
 

Exchange Loss Account
 

Map the exchange loss account to
the claim business unit.
 

Account combination
 

Claim Business Unit
 

Income or Discount on COGS
Account
 

Map the income or discount on
the cost of goods sold account
to the accrual business unit and
adjustment type.
 

Account combination
 

• Accrual Business Unit

• Adjustment Type

Payables Clearing Account
 

Map the Payables clearing account
to the claim business unit and
claim type. The Payables clearing
account is used for claims settled
through Payables settlement
methods.
 

Account combination
 

• Claim Business Unit

• Claim Type
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Assign Accounts to Predefined Mapping Sets
You must associate at least one output value for your ledger's chart of accounts for each of the above mapping sets if
you're using the predefined journal entry rule sets.

1. With roles having the required access, navigate to the Setup and Maintenance work area.

◦ Offering: Order Management/Procurement

◦ Functional Area: Channel Revenue Management/Supplier Incentives

◦ Task: Manage Mapping Sets

2. The Manage Mapping Sets: Channel Revenue Management page opens, where you can see the mapping sets
for your subledger. Select a mapping set to edit it.

3. In the Edit Mapping Set > Chart of Accounts section, click the Add Row icon. Select the chart of accounts from
the drop-down list.

4. In the Mappings section, add the Input source to Output type mappings for your account. If applicable, select
the Default button to identify a default account to be used in case there is no mapping available for the input
source value.

5. Click Save.

Note:  Create a custom mapping set only if you must map the account to different input sources.

Posting to General Ledger  
General Ledger integration enables the posting of accounting journals to the general ledger for financial reporting for
program accruals and claims processing.

The Create Accounting process creates the subledger entries. To transfer the entries to general ledger, select the
following while scheduling the process:

• Transfer to General Ledger field as Yes.

• Post in General Ledger field as Yes.

Related Topics

• Schedule the Accounting of Channel Accruals and Relief of Accruals to General Ledger in the Using Supplier
Channel Management guide.

• Schedule the Closure of Settled Claims in the Using Supplier Channel Management guide.

• Schedule the Clean Up of Unprocessed Accounting Events for Channel Transactions in the Using Supplier
Channel Management guide.
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Oracle Fusion Pricing Integration  

Manage Your Integration  
These are the Pricing tasks required for your implementation.

• Manage Service Mappings for Channel Revenue Management

• Manage Matrix Classes for Channel Revenue Management

• Manage Algorithms for Channel Revenue Management

• Manage Price Elements for Channel Revenue Management

• Manage Pricing Bases for Channel Revenue Management

Program Eligibility  

Determine Supplier Ship and Debit Program Eligibility  
Program eligibility determines the supplier programs that can be applied to a sales order line.

Program eligibility works by evaluating the date effectivity, program, market, and product rules against the
corresponding attributes on the sales order line to determine if there is a match. If there is a match, the supplier
program is applied to the sales order line. Pricing calculates these accruals and returns them as charge components for
each supplier program applied.

Manage Service Mappings for Channel Revenue Management
Service mappings store the eligibility attributes used for eligibility algorithms. To view the service mapping for Channel
Revenue Management:

1. From the Navigator, select Pricing Administration.
2. On the Overview page, open the Tasks panel and select Manage Service Mappings.
3. On the Manage Serve Mappings page, select Sales to manage service mappings for Channel Revenue

Management.

◦ Service Mapping: Sales

◦ Service Name: ProgramEligibility

Manage Matrix Classes for Channel Revenue Management
Matrix classes capture the conditions and results (dimensions) for a matrix. The predefined matrix class for Channel
Revenue Management is Channel Program Eligibility. Each of the program and market qualifiers in the program must
be setup as condition columns in the Channel Program Eligibility matrix class. The predefined qualifiers have already
been setup in the Channel Program Eligibility matrix class.
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Custom Dimensions for Using Custom Qualifiers
To implement a custom qualifier in the program, you must add it as a dimension with domain in Pricing. After adding
the dimension, you can use it as a custom qualifier in your program types. For example, you want to set up a program or
market rule as Ship To Country Equals Canada. For this you must first create a custom qualifier for Ship To Country:

1. Add an entry in the lookup code for qualifiers ORA_CJM_QUALIFIER_TYPE. Make note of the lookup code and
meaning.

For example, Lookup Code = SHIP_TO_COUNTRY_ID; Meaning = Ship To Country
2. Sign in to Order Management with administrative privileges.
3. From the Navigator, select Pricing Administration.
4. From the Tasks panel click Manage Matrix Classes.
5. On the Manage Matrix Classes page, select Channel Program Eligibility.
6. On the Edit Matrix Class: Channel Program Eligibility page you can see the predefined dimensions.
7. Click the Add Row icon.
8. In Name field, enter the meaning for the lookup code you entered in ORA_CJM_QUALIFIER _TYPE along with

the operator that should be used in the program and market rules.

For example, Ship To Country Equals
9. In the Source Code Name field, enter the lookup code you entered in ORA_CJM_QUALIFIER _TYPE

concatenated with the operator abbreviation. The supported operator abbreviations are E for equal to, NE for
not equal to, EGT for greater than or equal to, and ELT for less than or equal to.

For example, SHIP_TO_COUNTRY_ID_E
10. In the Comparison field, choose the comparison operator.

For example, =
11. From the Compare to Attribute drop-down list, select the order header, line, order header EFF, or order line

EFF attributes that you want to compare.

For example, Line.ShipToLocationCountry
12. Leave the Required check box deselected.
13. Select the Allow Null and Null Is Wildcard check boxes.
14. From the Domain list, select the Domain type. Choose Lookup, Custom, or None.

◦ If you select Lookup, choose the lookup from the Lookup drop-down list.

◦ If you select Custom, choose Text or Number from the Data Type drop-down list. Specify the domain
values.

◦ If you select None, choose Text or Number from the Data Type drop-down list. The user specified values
for the dimension (qualifier) isn't validated with this option.

15. Click Save.

Manage Algorithms for Channel Revenue Management
The Price Sales Transaction process consists of a series of algorithm steps used to determine a base list price and
arrive at a final price for items.

1. Sign in to Order Management with administrative privileges.
2. From the Navigator, select Pricing Administration.
3. From the Tasks panel click Manage Algorithms. The predefined algorithm for program eligibility is Get Eligible

Programs.
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Note:   If you have previously extended your algorithms, you will need to create a new version from version 0,
reconcile your algorithm extension changes to this new version, and then promote the algorithms.

Related Topics
• Promote Pricing Algorithms into the Current Release

• Pricing Algorithm

• How Service Mappings, Pricing Algorithms, and Matrixes Work Together

Pricing Execution  
Eligibility service determines which programs are applied to the order line, based on the eligible channel programs, and
Pricing calculates the value of the accruals.

Accruals are deferred discounts which impact revenue and margin. Including accruals in the calculation of the margin
provides visibility into the true profitability of the sale. When an order line is eligible for a supplier accrual, this accrual
is displayed as a charge component and is included in the price breakdown on the order line. Pricing supports the
calculations for amount based accruals, percentage based accruals that are a percentage of price or a cost, and New
Cost based accruals.

Manage Price Elements for Channel Revenue Management
To manage the channel accrual price element:

1. In the Setup and Maintenance work area, go to:

◦ Offering: Order Management

◦ Functional Area: Pricing

◦ Task: Manage Price Elements

2. Use the Manage Price Elements page to create and manage your channel price elements. These must be of
element type Cost or Price.

Manage Pricing Bases for Channel Revenue Management
Select the task Manage Pricing Bases to manage your pricing basis, or create a new one. The basis usage Accrual basis
is predefined for Channel Revenue Management.

You can create pricing basis for Channel Revenue Management with price element types Price and Cost. Once this is set
to active, it can be referenced in the channel program types. The pricing basis can be deleted as long as it's inactive and
not referenced in a pricing setup.

Note:  Cost elements aren't supported for other types of bases.

Pricing Bases for New Cost and Percent Discount Types

To create a pricing basis for new cost or percent discount type:

1. Click the Create icon in the Manage Pricing Bases page.
2. Enter the name of the pricing basis in the Name field.
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3. From the Price Element drop-down list, select a price element based on the element type Cost or Price.
4. From the Usage drop-down list select Accrual basis.
5. Select the Active check box.
6. Click Save. This creates the pricing basis which is now available for selection in channel program types.

Note:  Basis isn't used for the Amount discount type.

Calculate Supplier Ship and Debit Accruals
Amount

You can directly specify the accrual amount in the program product rule. Pricing calculates accruals after net price, and
returns charge components of element type Accrual. Accruals with the adjustment type Accrual Amount are calculated
and returned.

New Cost

You can specify the new cost value in the program product rule. The accrual amount is calculated based on the basis for
new cost, specified in the program type. New Cost accruals are calculated based on a cost or price.

The accrual amount is calculated as the difference between the charge component referenced in the basis and the new
cost specified in the product rule. Accruals are calculated after net price, and returns charge components of element
type Accrual. Accruals with the adjustment type Accrual Difference are calculated and returned.

Calculation

Assuming the new program cost is captured on the program line (pricing term),

New Program Cost = Pricing Term.AdjustmentAmount (Value captured on the program)

Accrual Basis Calculation: This value is calculated by taking the charge component referenced in the Accrual Basis on
the Pricing Term.

Accrual Difference Calculation = Value of Accrual Basis - New Program Cost

For example: Average Cost = 100 USD, New Program Cost = 80 USD, Quantity = 1

Unit Price (USD) Charge Component

500
 

Net Price
 

-100
 

Average Cost
 

20
 

Accrual
 

420
 

Margin
 

Note:  Algorithm extensions may be needed to derive these costs if they're not defined in Pricing.

Percent
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You can specify the discount in percentage in the product rule. The accrual amount is calculated based on the basis for
percent, specified in the program type. Pricing calculates accruals after net price, and returns charge components of
element type Accrual. Accruals with the adjustment type Accrual Percent are calculated and returned.

Returns
Referenced Returns: The polarity of the accrual charge components is reversed for the unit prices, and the extended
amounts are calculated based on unit price multiplied by returned quantity. Charges can be marked as refundable in
the Manage Pricing Charge Definitions page. As part of the standard returns processing, Pricing checks whether the
charge is refundable, and if non-refundable, the base list price, list price, and net price are set to zero. Accruals are also
calculated.

Un-referenced Returns: Pricing will price the un-referenced order line as an outbound line, apply automatic eligible
programs, and then reverse the polarity of the charges. Authorized users can decline programs and add manual
incentives.

Related Topics
• Manage Pricing Elements

• Manage Pricing Bases

Extensible Flexfields  

How to Set Up Custom Qualifiers Based on Order Header
Extensible Flexfields  
Here's how you can set up and use custom qualifiers based on order header extensible flexfields in your Supplier Ship
and Debit programs.

Identify the Order Header Flexfields
1. With roles having the required access, navigate to the Setup and Maintenance work area.

◦ Offering: Order Management

◦ Functional Area: Orders

◦ Task: Manage Order Extensible Flexfields

2. On the Manage Order Extensible Flexfields page, in the Search area, enter Header Information as the name,
then click Search.

3. Select the flexfield from the search results and click Edit.
4. On the Edit Extensible Flexfield: Header Information page, click to expand Additional Header Information in

the Category section.
5. On the Associated Contexts tab, click Manage Contexts, create a new context with required details, and then

save your work. For example:

Field Value

Display Name Channel Program2
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Field Value

Code Channel Program2

API Name ChannelProgram2

Enabled Ensure that the check box is selected

Behavior Single Row

Description Channel Program Qualifier

Context Usages Additional Header Information

Add these additional details to your sales order through Order Management > Create Order > Actions > Edit
Additional Information.

6. In the Context Sensitive Segments section of the Edit Context page, click Actions > Create to add a new
segment for example:

Field Value

Name Service Level

Code Service Level

API Name serviceLevel

Enabled Ensure that the check box is selected

7. Click Create Value Set.
8. On the Create Value Set page, enter the details, and save your work. For example:

Field Value

Value Set Code Service Level

Description Service Level

Module Order Management

Validation Type Independent

Value Data Type Character

9. In the Definition section, enter the following details, and save your work. For example:

Field Value

Value Subtype Text
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Field Value

Maximum Length 10

10. Click Manage Values and ensure that the values are enabled, and save your work. For example:

Attribute Value Description

Value Gold Gold Level

Value Silver Silver Level

Value Bronze Bronze Level

11. Return to the Create Segment page, enter the required details, and save your work. For example:

Region Attribute Value

Column Assignment Data Type Character

Column Assignment Table Column ATTRIBUTE_CHAR1

Validation Value Set Service Level

Validation Value Set Description Service Level

Display Properties Prompt Service Level

Display Properties Display Type List of Values

Display Properties Display Size 10

Display Properties Display Height 1

12. On the Edit Context page, ensure that the details in the Context Sensitive Segments section show accurately.
For example:

Field Value

Sequence 10

Name Service Level

Code Service Level

Value Data Type Character

Display Type List of Values

Value Set Service Level

Enabled Ensure that this check box is selected
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Field Value

Prompt Service Level

13. Navigate to the Manage Context page and search for the Header Information EFF and click Edit.
14. On the Edit Extensible Flexfield: Header Information page, select Additional Header Information from the

Category list and add an Associated Context in the Additional Header Information Details section.
15. Search for and add the context you created. For example, Channel Program2. Save your work.
16. Click on the Pages tab. Click Actions > Create to create a new page and add the required details. For example:

Field Value

Display Name Channel Program Qualifiers2

Code Channel Program Qualifiers2

Description Channel Program Qualifiers

Usage Additional Header Information

17. Select the page you just created, search for, and associate the context you created with this page. For example,
Channel Program2. Save your work.

18. On the Manage Order Extensible Flexfields page, search for the Header Information extensible flexfield, and
click Deploy Flexfield. Wait for the deployment dialog to indicate that deployment successfully finished, then
click OK.

19. Verify your setup.

Download the Flexfield Archive and Obtain the View Object Details for the Extensible
Flexfields Context

1. From the Manage Order Extensible Flexfields page, select your flexfield.
2. From the Actions menu, select Download Flexfield Archive. Wait for the dialog to indicate that the archive

successfully finished, then click Download. Save the 10008_DOO_HEADERS_ADD_INFO.zip file to your local
hard drive.

3. Open the file, extract, and get the information for the context from the location:
10008_DOO_HEADERS_ADD_INFO\oracle\apps\scm\doo\processOrder\flex\headerContextsB\view

4. Open the XML file HeaderEffBChannelProgram2privateVO.xml. See the VO name for your flexfield. For
example, name = HeaderEffBChannelProgram2privateVO.

5. You can also get the attribute name from the XML file. For example, ViewAttribute Name=serviceLevel.

Manage Service Mapping Setup Using Sandbox after Identifying the Order Extensible
Flexfields

1. With the appropriate pricing administrator role, navigate to the Sandboxes page.
2. In the Navigator, click Sandboxes.
3. On the Sandbox page, click Create Sandbox.
4. On the Create Sandbox page, enter a name for the sandbox.
5. Select the check box for the Manage Service Mappings  tool, then click Create and Enter.
6. Navigate to the Pricing Administration work area. Select Manage Service Mappings from the panel.
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Note:  A yellow banner displays at the top of the page to indicate that you're in the sandbox.

7. On the Manage Service Mappings page, click Sales. Pricing comes predefined with the Sales service mapping
that prices sales orders and order lines.

8. On the Edit Service Mappings: Sales page, click the Entities tab. You use the Entities tab to define the entity and
its attribute details that receive the output of the service mapping. On the Entities tab, click Action > Add Row,
and enter the following details:

Field Value

Entity Name of your entity, for example, ServiceLevel_Custom

Description A description containing information about the entity for the flexfield on the order header.

9. In the Details section, add the following attributes, for example, and then save your work.

Attribute Type Primary Key Allow Null

HeaderId_Custom Long Selected Selected

ServiceLevelCode_Custom String Leave this blank Selected

10. To specify the services, click the Services tab, and select ProgramEligibility.
11. In the Program Eligibility: Details section, select the Entities tab, click Actions > Add Row, enter the following

values, for example, and then save your work.

Field Value

Entity ServiceLevelCode_Custom

Read Selected

Write Selected

12. In the Details section, add the following attributes, for example, and then save your work.

Attribute Alias Read Write Parent Attribute

HeaderId_Custom Leave this blank. Selected Leave this blank. Leave this blank.

ServiceLevelCode_
Custom

Leave this blank. Selected Leave this blank. Leave this blank.

13. On the Edit Service Mappings: Sales page, select the Sources tab. Pricing comes predefined with the Sales
service mapping that prices sales orders and order lines.
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14. For each of the following sources, add the entity you created, and add the following details in the Entity
Mappings tab of the Details section:

Source - ChannelProgramsforOrder

Field Value

Source ChannelProgramsForOrder

Entity The name of the entity you created. For example, ServiceLevel_Custom

Type View object

View Object The name of the view object. You retrieve this information from the downloaded flexfield
definition XML file. For example, HeaderEffBChannel__Program2privateVO

Query Type Unique identifier

Query Attribute HeaderId

In the details section of your entity, click the Attributes Mappings tab. Enter the attributes of the entity that you
created and the view object attributes from the XML file, for example:

Field Value

HeaderId_Custom HeaderId

ServiceLevelCode_Custom serviceLevel

Source - ChannelProgramsforOrderLine

Field Value

Source ChannelProgramsForOrderLine

Entity The name of the entity you created. For example, ServiceLevel_Custom

Type View object

View Object The name of the view object. You retrieve this information from the downloaded flexfield
definition XML file. For example, HeaderEffBChannelProgram2privateVO

Query Type Unique identifier
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Field Value

Query Attribute HeaderId

In the details section of your entity, click the Attributes Mappings tab. Enter the attributes of the entity that you
created and the view object attributes from the XML file, for example:

Attribute View Object Attribute

HeaderId_Custom HeaderId

ServiceLevelCode_Custom serviceLevel

Source - ManualChannelProgramsforOrder

Field Value

Source ManualChannelProgramsForOrder

Entity The name of the entity you created. For example, ServiceLevel_Custom

Type View object

View Object The name of the view object. You retrieve this information from the downloaded flexfield
definition XML file. For example, HeaderEffBChannel__Program2privateVO

Query Type Unique identifier

Query Attribute HeaderId

In the details section of your entity, click the Attributes Mappings tab. Enter the attributes of the entity that you
created and the view object attributes from the XML file, for example:

Attribute View Object Attribute

HeaderId_Custom HeaderId

ServiceLevelCode_Custom serviceLevel

15. Click Save.

Pricing Algorithm Setup

Note:  If you have implemented algorithm extensions for the Get Eligible Programs algorithm, then you must
perform the Merge Algorithm Extensions steps described in the Post-Update Steps section of the Oracle SCM Cloud:
Performing Your 22C Quarterly Update guide available from Oracle Fusion Cloud SCM: Performing Your Quarterly
Update (Doc ID 2337485.1).
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After making any customizations, you must update the changes in the Pricing algorithm and publish it.

1. From the Navigator, select Pricing Administration.
2. From the Tasks panel, click Manage Algorithms. Select the algorithm for program eligibility, Get Eligible

Programs.

Note:  You can either create a new version of Get Eligible Programs or you can modify the existing version. To
modify the existing version, first set it to inactive, make the changes, make it active again, and then publish it.

3. If you're setting up for supplier rebate programs, then on the Edit Algorithm: Get Eligible Programs page, from
the Algorithm tab, select the step Process Supplier Rebate Programs. Select the Process Each Program
Header row, then select Process Header Eligibility, , and then select Invoke Header Eligibility Matrix. Add
the entity you created using Service Mappings. Add the following details under the Header data set row:

Field Value

Name Enter your custom entity name here. For example, ServiceLevel_Custom.

Variable Path Add the variable path to your custom entity here. For example, EligibityRequest.ServiceLevel_
Custom.

Primary Leave this blank.

Cardinality Zero or one

Data Set Join [HeaderId_Custom:{Header.HeaderId}]

Order By Leave this blank.

4. If you're setting up for supplier ship and debit or customer rebate programs, then on the Edit Algorithm: Get
Eligible Programs page, from the Algorithm tab, select the step Process Supplier Ship and Debit or Customer
Rebate Programs. Select the row Process Eligible Program Headers and add the entity you created using
Service Mappings. Add the following details under the Header data set row:

Field Value

Name Enter your custom entity name here. For example, ServiceLevel_Custom.

Variable Path Add the variable path to your custom entity here. For example, EligibityRequest.ServiceLevel_
Custom.

Primary Leave this blank.

Cardinality Zero or one

Data Set Join [HeaderId_Custom:{Header.HeaderId}]

Order By Leave this blank.

5. On the Edit Algorithm: Get Eligible Programs page, in the Data Sets section of the Algorithm tab, select
Process Each Program Candidate, select Process Program Eligibility and select the Invoke Program
Eligibility Matrix Row add the entity you created using Service Mappings. Add the following details under the
Header data set row:

80



SCM Cloud
Implementing Channel Revenue Management

Chapter 3
Integrate

Field Value

Name Enter your custom entity name here. For example, ServiceLevel_Custom.

Variable Path Add the variable path to your custom entity here. For example, EligibityRequest.ServiceLevel_
Custom.

Primary Leave this blank.

Cardinality Zero or one

Data Set Join [HeaderId_Custom:{Line.HeaderId}]

Order By Leave this blank.

6. Verify your setup, save, and then click Actions and Publish to publish the algorithm.

Adding the Qualifier
1. In the Setup and Maintenance work area, go to:

◦ Offering: Order Management

◦ Functional Area: Channel Revenue Management

◦ Task: Manage Channel Lookups

2. On the Manage Channel Lookups page, search for ORA_CJM_QUALIFIER_TYPE as the Lookup Type.
3. Click Action > New to add the following lookup code:

Field Value

Lookup Code Enter a name here. For example, SERVICE_LEVEL.

Enabled Selected

Meaning Service Level

4. Click Save and Close.
5. From the Navigator, select Pricing Administration.
6. In the Overview page, from the Tasks panel select Manage Matrix Classes.
7. In the Manage Matrix Classes pages, select Channel Program Eligibility.
8.

Field Value

Name Add the name of the qualifier that you entered in the lookup to the Condition Columns of the
Edit Matrix Class: Channel Program Eligibility page. For example, Service Level Equals.

Source Code Name Enter the lookup code that you entered in ORA_CJM_QUALIFIER _TYPE concatenated with the
operator abbreviation. The source code name of the matrix condition must match the newly
created lookup code. The supported operator abbreviations are E for equal to, NE for not equal
to, EGT for greater than or equal to, and ELT for less than or equal to. For example, SERVICE_
LEVEL_E.
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Field Value

Comparison Choose the comparison operator. For example, =.

Compare to Attribute Select the required attribute. If you're unable to view the attribute, make any update to the
description of the Channel context and save it before publishing the sandbox.
 

Note:  The format of the Compare To Attribute must be Entity Name.Attribute Name (from
Service Mappings). For example, ServiceLevel_Custom.ServiceLevelCode_Custom

Required Leave this blank.

Allow Null Selected

Null is Wildcard Selected

9. Click the icon next to Domain to edit the column domain values.

Field Value

Name Enter a name here. For example, Service Level Equals.

Default Value Leave this blank

Default is fixed value Don't select this.

Domain Type Custom

Data Type Text

Add the required Domain Values, for example:

Field Value

Domain Value Gold

Display Value Gold

Domain Value Silver

Display Value Silver

Domain Value Bronze

Display Value Bronze

10. Click Save and Close.

You can now add the qualifier value used in the program in the EFF context field to the sales order line additional
information.
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Related Topics
• Use Extensible Flexfields with Pricing

• How Service Mappings, Pricing Algorithms, and Matrixes Work Together

How to Set Up Custom Qualifiers Based on Order Line Extensible
Flexfields  
Here's how you can setup and use custom qualifiers based on order line extensible flexfields in your Supplier Ship and
Debit programs.

Create a New EFF Attribute in OM Order Line
1. With roles having the required access, navigate to the Setup and Maintenance work area.

◦ Offering: Order Management

◦ Functional Area: Orders

◦ Task: Manage Order Extensible Flexfields

2. On the Manage Order Extensible Flexfields page, in the Search area, enter Fulfillment Line Information as the
name, then click Search.

3. Select the flexfield from the search results and click Edit.
4. Click Manage Contexts and then create a new context, and then save your work. For example:

Field Value

Display Name Channel Program

Code ChannelProgram

API Name ChannelProgram

Enabled Ensure the check box is selected

Behavior Single Row

Description Channel Program Qualifier

Context Usages Additional Fulfillment Line Information

5. Add a new Segment, add the segment details, and save your work. For example:

Field Value

Name SSD Authorization Code

Code SSD Authorization Code

API Name ssdAuthorizationCode
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Field Value

Description Channel Program SSD Authorization Code

Data Type Character

Table Column ATTRIBUTE_CHAR1

6. Click Create Value Set.

Field Value

Value Set Code SSD Authorization Code

Description SSD Authorization Code

Module Order Management

Validation Type Format Only

Value Data Type Character

7. In the Definition section, enter the following details, and save your work.

Field Value

Value Subtype Text

Maximum Length 10

8. Return to the Create Segment page, enter details, and save your work. For example:

Region Attribute Value

Column Assignment Data Type Character

Column Assignment Table Column ATTRIBUTE_CHAR1

Validation Value Set SSD Authorization Code

Validation Value Set Description SSD Authorization Code

Display Properties Prompt SSD Authorization Code

Display Properties Display Type Text Box

Display Properties Display Size 10

Display Properties Display Height 1

9. Navigate to the Manage Context page and search for the Fulfillment Line Information EFF and click Edit.
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10. On the Edit Extensible Flexfield: Fulfillment Line Information page, select Additional Fulfillment Line
Information from the Category list and add an Associated Context in the Additional Fulfillment Line
Information section.

11. Search for and add the context you created, for example Channel Program. Save your work.
12. Click the Pages tab, and then click Actions > Create to create a new page. Add required details, for example:

Field Value

Display Name Channel Program Qualifiers

Code Channel Program Qualifiers

Description Channel Program Qualifiers

Usage Additional Fulfillment Line Information

13. Search and associate the context you created with this page, fo example Channel Programs.
14. Click Save and Close.
15. On the Manage Order Extensible Flexfields page, search for the Fulfillment Line Information extensible flexfield,

and click Deploy Flexfield. Wait for the deployment dialog to indicate that deployment successfully finished,
then click OK.

16. Navigate to the Create Orders page and verify your setup.

Note:  These additional details are added to your sales order through Order Management > Create Order >
Select the order line > Actions > Edit Additional Information.

Obtain the View Object Details for the Extensible Flexfields Context

1. From the Manage Order Extensible Flexfields page, select your flexfield.
2. From the Actions menu, select Download Flexfield Archive. Wait for the dialog to indicate that the archive

successfully finished, then click Download. Save the 10008_DOO_FULFILL_LINES_ADD_INFO.zip file to your
local hard drive.

3. Open the file, extract and get the information for the context from the location:

10008_DOO_FULFILL_LINES_ADD_INFO\oracle\apps\scm\doo\processOrder\flex\fulfillLineContextsB\view

4. Open the XML file FulfillLineEffBChannelProgramprivateVO.xml. for your flexfield to see the VO name. For
example, name = FulfillLineEffBChannelProgramprivateVO.

5. You can also get the attribute name from the XML file. For example, ViewAttribute
Name=ssdAuthorizationCode.

Manage Service Mapping Setup Using Sandbox after Identifying the Order Line
Extensible Flexfields

1. With the appropriate pricing administrator role, navigate to the Sandboxes page.
2. In the Navigator, click Sandboxes.
3. On the Sandbox page, click Create Sandbox.
4. On the Create Sandbox page, enter a name for the sandbox.
5. Select the check box for Manage Service Mappings  tool, then click Create and Enter.
6. Navigate to the Pricing Administration work area, select Manage Service Mappings from the panel.
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Note:  A yellow banner displays at the top of the page to indicate that you're in the sandbox.

7. On the Manage Service Mappings page, click Sales to edit the service mapping. Pricing comes predefined with
the Sales service mapping that prices sales orders and order lines.

8. On the Edit Service Mappings: Sales page, click Entities. You use the Entities tab to define the line entity and
its attribute details that receives the output of the service mapping. Click Action > Add Row and enter the
following details, for example:

Field Value

Entity SSDAuthCode_Custom

Description Enter a description.

9. In the Details section, add the following attributes, and then save your work.

Attribute Type Primary Key Allow Null

LineId_Custom Long Selected Selected

SSDCode_Custom String Leave this blank Selected

10. Click the Services tab, select ProgramEligibility.
11. In the ProgramEligibility: Details section, add the entity and its details that you just created.

Field Value

Entity SSDAuthCode_Custom

Read Selected

Write Selected

12. In the Details section, add the following attributes, and then save your work.

Attribute Alias Read Write Parent Attribute

LineId_Custom Leave this blank. Selected Leave this blank. Leave this blank.

SSDCode_Custom Leave this blank. Selected Leave this blank. Leave this blank.

13. Click Save and Close.
14. On the Edit Service Mappings: Sales page, select the Sources tab. Pricing comes predefined with the Sales

service mapping that prices sales orders and order lines.
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15. For each of the following sources, add the entity you created, and add the following details in the Entity
Mappings tab of the Details section:

Source - ChannelProgramsforOrder

Field Value

Source ChannelProgramsForOrder

Entity The name of the entity you created. For example, SSDAuthCode_Custom.

Type View Object

View Object Add the view object from the XML file. For example, FulfillLineEffBChannelProgram2privateVO.

Query Type Join

Query Attribute FulfillLineId

Joined Entity Line

Joined Entity Attribute LineId

Note:  Ensure you add the custom entity below the Line entity.

In the details section of your entity, on the Attributes Mappings tab, enter the attributes of the entity you
created and the view object attributes from the XML file, for example:

Attribute View Object Attribute

LineId_Custom FulfillLineId

SSDCode_Custom ssdAuthorizationCode

Source - ChannelProgramsforOrderLine

Field Value

Source ChannelProgramsForOrderLine

Entity The name of the entity you created. For example, SSDAuthCode_Custom.

Type View Object

View Object Add the view object from the XML file. For example, FulfillLineEffBChannelProgram2privateVO.

Query Type Join

Query Attribute FulfillLineId
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Field Value

Joined Entity Line

Joined Entity Attribute LineId

Note:  Ensure you add the custom entity below the Line entity.

In the details section of your entity, on the Attributes Mappings tab, enter the attributes of the entity you
created and the view object attributes from the XML file, for example:

Attribute View Object Attribute

LineId_Custom FulfillLineId

SSDCode_Custom ssdAuthorizationCode

Source - ManualChannelProgramsforOrder

Field Value

Source ChannelProgramsForOrder

Entity The name of the entity you created. For example, SSDAuthCode_Custom.

Type View Object

View Object Add the view object from the XML file. For example, FulfillLineEffBChannelProgram2privateVO.

Query Type Join

Query Attribute FulfillLineId

Joined Entity Line

Joined Entity Attribute LineId

Note:  Ensure you add the custom entity below the Line entity.

In the details section of your entity, on the Attributes Mappings tab, enter the attributes of the entity you
created and the view object attributes from the XML file, for example:

Attribute View Object Attribute

LineId_Custom FulfillLineId

SSDCode_Custom ssdAuthorizationCode
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16. Click Save.

Pricing Algorithm Setup
After any customizations you must update the changes in the Pricing algorithm and publish it.

1. Sign in to Order Management with administrative privileges.
2. From the Navigator, select Pricing Administration.
3. From the Tasks panel click Manage Algorithms. Select the algorithm for program eligibility, Get Eligible

Programs.

Note:  If you have previously extended your algorithms, you will need to create a new version from version 0,
reconcile your algorithm extension changes to this new version, and then promote the algorithms.

4. On the Edit Algorithm: Get Eligible Programs page, in the Data Sets section of the Algorithm tab, select Process
Each Program Candidate, select the Process Program Eligibility, and then select the Invoke Program
Eligibility Matrix Row add the entity you created using Service Mappings. Add the following details under the
Line data set row:

Field Value

Name Enter your custom entity name here. For example, SSDAuthCode_Custom.

Variable Path EligibityRequest.SSDAuthCode_Custom

Primary Leave this blank.

Cardinality Zero or one

Data Set Join [LineId_Custom:{Line.LineId}]

Order By Leave this blank

5. Verify your setup and then click Actions and Publish to publish the algorithm.

Adding the Qualifier
1. In the Setup and Maintenance work area, go to:

◦ Offering: Order Management

◦ Functional Area: Channel Revenue Management

◦ Task: Manage Channel Lookups

2. Search for the configurable lookup: ORA_CJM_QUALIFIER_TYPE. Add the qualifier to the lookup code. For
example, Lookup Code = SSDAuthCode; Meaning = SSD Auth Code.

3. Click Save and Close.
4. From the Navigator, select Pricing Administration. In the Overview page, from the Tasks panel select Manage

Matrix Classes.
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5. In the Manage Matrix Classes pages, select Channel Program Eligibility. Enter the following details:

Field Value

Name Enter the meaning for the lookup code you entered in ORA_CJM_QUALIFIER _TYPE along with
the operator. For example, SSDAuthCode.

Source Code Name Enter the lookup code you entered in ORA_CJM_QUALIFIER _TYPE concatenated with the
operator abbreviation. The supported operator abbreviations are E for equal to, NE for not
equal to, EGT for greater than or equal to, and ELT for less than or equal to. For example,
SSDAuthCode_E.

Comparison Choose the comparison operator. For example, =.

Compare to Attribute Select the attribute you created using service mappings.
 

Note:  The format of the Compare To Attribute must be Entity Name.Attribute Name (from
Service Mappings). For example, SSDAuthCode_Custom.SSDCode_Custom.

Required Leave this blank.

Allow Null Selected

Null is Wildcard Selected

Domain Text

6. Click Save and Close.

Now you should be able to enter the qualifier value used in the program in the EFF context field to the sales order line
additional information.

How to Set Up Custom Qualifiers Based on Supplier Invoice
Header Descriptive Flexfields  
Here's how you can set up and use custom qualifiers based on Supplier Invoice Header descriptive flexfields in your
Supplier Rebate programs.

Note:  This setup doesn't apply to Supplier Rebate programs with direct integration to PO, Receiving, and AP.

Configure Document Header Descriptive Flexfield
1. With roles having the required access, navigate to the Setup and Maintenance work area.

◦ Offering: Order Management

◦ Functional Area: Channel Revenue Management

◦ Task: Manage Channel Descriptive Flexfields
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2. On the Manage Channel Descriptive Flexfield page, search for the Channel Document Header DFF as the name,
and click to edit it.

3. On the Edit Descriptive Flexfields: Channel Document Header DFF page, in the Global Segments section, click
Actions > Create to create a new Global Segment.

Field Value

Name Supplier_Product_Color_headerdff

Code Supplier_Product_Color_headerdff

API Name supplierProductColorHeaderdff

Enabled Ensure the check box is selected

4. Click Create Value Set.
5. On the Create Value Set page, enter the details, and save your work. For example:

Field Value

Value Set Code Supplier_Product_Color

Description Supplier_Product_Color

Module Channel Revenue Management

Validation Type Independent

Value Data Type Character

6. In the Definition section, enter the following details, and save your work. For example:

Field Value

Value Subtype Text

Maximum Length 15

7. Click Manage Values and ensure the values are enabled, and save your work. For example:

Attribute Value Description Enabled

Value Black Black Selected

Note:  This attribute value should have been specified in the supplier invoice and available in the imported
CSV file to qualify the program.
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8. Return to the Create Segment page, enter the required details, and save your work. For example:

Region Attribute Value

Column Assignment Data Type Character

Column Assignment Table Column ATTRIBUTE_CHAR2

Validation Value Set Supplier_Product_Color

Validation Value Set Description Supplier_Product_Color

Display Properties Prompt Supplier_Product_Color_headerdff

Display Properties Display Type List of Values

9. On the Manage Channel Descriptive Flexfields page, search for the Channel Document Header DFF, and click
Actions > Deploy Flexfield. Wait for the deployment dialog to indicate that deployment successfully finished,
then click OK.

10. Verify your setup.

Download the Flexfield Archive and Obtain the View Object Details for the Channel
Document Header Descriptive Flexfields Context

1. From the Manage Channel Document Header Descriptive Flexfields page, select your flexfield.
2. From the Actions menu, select Download Flexfield Archive. Wait for the dialog to indicate that the archive

successfully finished, then click Download. Save the 10566_CJM_DOCUMENT_HEADER_DFF.zip file to your
local hard drive.

3. Open the file, extract and get the information for the context from the location:
10566_CJM_DOCUMENT_HEADER_DFF\oracle\apps\flex\scm\cjm\indirectSales\documentHeaderFlex\view

4. Open the XML file CjmDocumentHeaderDFFVO.xml for your flexfield to see the VO name. For example, name =
CjmDocumentHeaderDFFVO

5. You can also get the attribute name from the XML file. For example, ViewAttribute Name =
supplierProductColorHeaderdff.

Manage Service Mapping Setup Using Sandbox after Identifying the Channel
Document Header Descriptive Flexfields

1. With the appropriate pricing administrator role, navigate to the Sandboxes page.
2. In the Navigator, click Sandboxes.
3. On the Sandbox page, click Create Sandbox.
4. On the Create Sandbox page, enter a name for the sandbox.
5. Select the check box for the Manage Service Mappings  tool, then click Create and Enter.
6. Navigate to the Pricing Administration work area, select Manage Service Mappings from the panel.

Note:  A yellow banner displays at the top of the page to indicate that you're in the sandbox.

7. On the Manage Service Mappings page, click Channel.
8. On the Edit Service Mapping: Channel page, click the Entities tab. You use the Entities tab to define the entity

and its attribute details that receives the output of the service mapping. On the Entities tab, click Action > Add
Row, and enter the following details:
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Field Value

Entity Name of your entity, for example, SupplierProductColorHeaderdff_Custom

Description A description containing information about the entity for the flexfield on the order header. For
example, SupplierProductColorHeaderdff_Custom.

9. In the Details section, add the following attributes, for example, and then save your work.

Attribute Type Primary Key Allow Null

DocumentHeaderId_Custom Long Selected Selected

SupplierProductColorHeaderdff_
Custom

String Leave this blank Selected

10. To specify the services, click the Services tab, select ProgramEligibility.
11. In the ProgramEligibility: Details section, select the Entities tab, click Actions > Add Row, enter the following

values, for example, and then save your work.

Field Value

Entity SupplierProductColorHeaderdff_Custom

Read Selected

Write Leave this blank

12. In the Details section, add the following attributes, for example, and then save your work.

Attribute Alias Read Write Parent Attribute

DocumentHeaderId_
Custom

Leave this blank. Selected Leave this blank. Leave this blank.

SupplierProductColorHeaderdff_
Custom

Leave this blank. Selected Leave this blank. Leave this blank.

13. On the Edit Service Mappings: Channel page, select the Sources tab.
14. For each of the following sources, add the entity you created, and add the following details in the Entity

Mappings tab of the Details section:

Field Value

Source ChannelProgramsForSupplierDocument

Entity The name of the entity you created. For example,SupplierProductColorHeaderdff_Custom.
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Field Value

Type View object

View Object The name of the view object. You retrieve this information from the downloaded flexfield
definition XML file. For example, CjmDocumentHeaderDFFVO

Query Type Unique identifier

Query Attribute DocumentHeaderId

Use Existing View Object Selected

In the details section of your entity, on the Attributes Mappings tab, enter the attributes of the entity you
created and the view object attributes from the XML file, for example:

Attribute View Object Attribute

DocumentHeaderId_Custom DocumentHeaderId

SupplierProductColorHeaderdff_
Custom

supplierProductColorHeaderdff

15. Click Save and Publish the sandbox. Once it is published, when the Eligibility REST is described, the attributes
should be visible in the payload.

Pricing Algorithm Setup

Note:  If you have implemented algorithm extensions for the Get Eligible Programs algorithm, then you must
perform the Merge Algorithm Extensions steps described in the Post-Update Steps section of the Oracle SCM Cloud:
Performing Your 22C Quarterly Update guide available from Oracle Fusion Cloud SCM: Performing Your Quarterly
Update (Doc ID 2337485.1).

After any customizations you must update the changes in the Pricing algorithm and publish it.

1. From the Navigator, select Pricing Administration.
2. From the Tasks panel click Manage Algorithms. Select the algorithm for program eligibility, Get Eligible

Programs.

Note:  You can either create a new version of Get Eligible Programs or you can modify the existing version by
first setting it to inactive, making the changes, making it active again, and publishing it.

3. On the Edit Algorithm: Get Eligible Programs page, in the Data Sets section of the Algorithm tab, select Process
Supplier Rebate Programs > Process Each Program Header > Invoke Header Eligibility Matrix  and add the
data set you created using Service Mappings. Add the following details under the Header data set row:

Field Value

Name Enter your custom entity name here. For example, SupplierProductColorHeaderdff_Custom.
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Field Value

Variable Path Add the variable path to your custom entity here. For example,
 EligibityRequest.SupplierProductColorHeaderdff_Custom.

Primary Leave this blank.

Cardinality Zero or one

Data Set Join [DocumentHeaderId_Custom:{Header.HeaderId}]

Order By Leave this blank.

4. Verify your setup, save, and then click Actions and Publish to publish the algorithm.

Adding Custom Dimension based on DFF Setup
1. With the appropriate pricing administrator role, navigate to the Manage Matric Classes page.

◦ Offering: Order Management

◦ Functional Area: Pricing Administration

◦ Task: Manage Matrix Classes

2. Click Channel Program Eligibility to select and edit it.
3. Click Actions > Add Row in the Condition Columns section.

Field Value

Name Enter a entity name here. For example, Supplier Product Color Equals.

Source Code Name Enter a value for example, SUPPLIER_PRODUCT_COLOR_E.

Comparison =

Compare to Attribute SupplierProductColorHeaderdff_Custom.SupplierProductColorHeaderdff_Custom

Allow Null Selected

Null is Wildcard Selected

Domain Text

4. Click the icon next to Domain to edit the column domain values.

Field Value

Name Enter a name here. For example, Supplier Product Color Equals.

Default Value Leave this blank

Default is fixed value Don't select this.
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Field Value

Domain Type None

Data Type Text

Adding the Lookup code to the Channel Lookup
1. With the appropriate channel role, navigate to the Setup and Maintenance page.

◦ Offering: Order Management

◦ Functional Area: Channel Revenue Management

◦ Task: Manage Channel Lookups

2. On the Manage Channel Lookups page, search for ORA_CJM_SUP_REBATE_QUAL as the Lookup Type.
3. Click Action > New to add the following lookup code:

Field Value

Lookup Code Enter a name here. For example, SUPPLIER_PRODUCT_COLOR.

Enabled Selected

Meaning Enter a description here. For example, SUPPLIER_PRODUCT_COLOR.

How to Set Up Custom Qualifiers Based on Supplier Invoice Line
Descriptive Flexfields  
Here's how you can set up and use custom qualifiers based on Supplier Invoice Line descriptive flexfields in your
Supplier Rebate programs.

Note:  This setup doesn't apply to Supplier Rebate programs with direct integration to PO, Receiving and AP.

Configure Document Line Descriptive Flexfield
1. With roles having the required access, navigate to the Setup and Maintenance work area.

◦ Offering: Order Management

◦ Functional Area: Channel Revenue Management

◦ Task: Manage Channel Descriptive Flexfields

2. On the Manage Channel Descriptive Flexfield page, search for the Channel Document Line DFF as the name,
and click to edit it.
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3. On the Edit Descriptive Flexfields: Channel Document Line DFF page, in the Global Segments section, click
Actions > Create to create a new Global Segment.

Field Value

Name SupplierNumber_Linedff

Code SupplierNumber_Linedff

API Name supplierNumberLinedff

Enabled Ensure the check box is selected

4. Click Create Value Set.
5. On the Create Value Set page, enter the details, and save your work. For example:

Field Value

Value Set Code Numbersequence

Description Numbersequence

Module Channel Revenue Management

Validation Type Independent

Value Data Type Number

6. Click Manage Values and ensure the values are enabled, and save your work. For example:

Attribute Value Description Enabled

Value 2 2 Selected

Note:  This attribute value should have been specified in the supplier invoice and available in the imported
CSV file to qualify the program.

7. On the Manage Channel Descriptive Flexfields page, search for the Channel Document Header DFF, and click
Actions > Deploy Flexfield. Wait for the deployment dialog to indicate that deployment successfully finished,
then click OK.

8. Verify your setup.

Download the Flexfield Archive and Obtain the View Object Details for the Channel
Document Line Descriptive Flexfields Context

1. From the Manage Channel Document Header Descriptive Flexfields page, select your flexfield.
2. From the Actions menu, select Download Flexfield Archive. Wait for the dialog to indicate that the archive

successfully finished, then click Download. Save the 10566_CJM_DOCUMENT_LINE_DFF.zip file to your local
hard drive.

3. Open the file, extract and get the information for the context from the location:
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10566_CJM_DOCUMENT_LINE_DFF.zip\oracle\apps\flex\scm\cjm\indirectSales\documentLineFlex\view

4. Open the XML file CjmDocumentLineDFFVO.xml for your flexfield to see the VO name. For example, name =
CjmDocumentLineDFFVO

5. You can also get the attribute name from the XML file. For example, ViewAttribute Name =
suppliernumberLinedff.

Manage Service Mapping Setup Using Sandbox after Identifying the Channel
Document Line Descriptive Flexfields

1. With the appropriate pricing administrator role, navigate to the Sandboxes page.
2. In the Navigator, click Sandboxes.
3. On the Sandbox page, click Create Sandbox.
4. On the Create Sandbox page, enter a name for the sandbox.
5. Select the check box for the Manage Service Mappings  tool, then click Create and Enter.
6. Navigate to the Pricing Administration work area, select Manage Service Mappings from the panel.

Note:  A yellow banner displays at the top of the page to indicate that you're in the sandbox.

7. On the Manage Service Mappings page, click Channel.
8. On the Edit Service Mapping: Channel page, click the Entities tab. You use the Entities tab to define the entity

and its attribute details that receives the output of the service mapping. On the Entities tab, click Action > Add
Row, and enter the following details:

Field Value

Entity Name of your entity, for example, SuppliernumberLinedff_Custom

Description A description containing information about the entity for the flexfield on the order header. For
example, SuppliernumberLinedff_Custom.

9. In the Details section, add the following attributes, for example, and then save your work.

Attribute Type Primary Key Allow Null

DocumentLineId_Custom Long Selected Selected

SuppliernumberLinedff_Custom Long Leave this blank Selected

10. To specify the services, click the Services tab, select ProgramEligibility.
11. In the ProgramEligibility: Details section, select the Entities tab, click Actions > Add Row, enter the following

values, for example, and then save your work.

Field Value

Entity SuppliernumberLinedff_Custom

Read Selected

Write Leave this blank
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12. In the Details section, add the following attributes, for example, and then save your work.

Attribute Alias Read Write Parent Attribute

DocumentLineId_Custom Leave this blank. Selected Leave this blank. Leave this blank.

SuppliernumberLinedff_
Custom

Leave this blank. Selected Leave this blank. Leave this blank.

13. On the Edit Service Mappings: Channel page, select the Sources tab.
14. For each of the following sources, add the entity you created, and add the following details in the Entity

Mappings tab of the Details section:

Field Value

Source ChannelProgramsForSupplierDocument

Entity The name of the entity you created. For example,SuppliernumberLinedff_Custom.

Type View object

View Object The name of the view object. You retrieve this information from the downloaded flexfield
definition XML file. For example, CjmDocumentLineDFFVO

Query Type Join

Query Attribute DocumentLineId

Joined Entity Line

Joined Entity Attribute LineId

In the details section of your entity, on the Attributes Mappings tab, enter the attributes of the entity you
created and the view object attributes from the XML file, for example:

Attribute View Object Attribute

DocumentLineId_Custom DocumentLineId

SuppliernumberLinedff_Custom suppliernumberLinedff

15. Click Save and Publish the sandox. Once it is published, when the Eligibility REST is described, the attributes
should be visible in the payload.

Pricing Algorithm Setup
After any customizations you must update the changes in the Pricing algorithm and publish it.

1. From the Navigator, select Pricing Administration.
2. From the Tasks panel click Manage Algorithms. Select the algorithm for program eligibility, Get Eligible

Programs.

99



SCM Cloud
Implementing Channel Revenue Management

Chapter 3
Integrate

Note:  You can either create a new version of Get Eligible Programs or you can modify the existing version by
first setting it to inactive, making the changes, making it active again, and publishing it.

3. On the Edit Algorithm: Get Eligible Programs page, in the Data Sets section of the Algorithm tab, select Process
Supplier Rebate Programs > Process Each Program Header > Invoke Program Eligibility Matrix  and add
the data set you created using Service Mappings. Add the following details under the header row:

Field Value

Name Enter your custom entity name here. For example, SuppliernumberLinedff_Custom.

Variable Path Add the variable path to your custom entity here. For example,
 EligibityRequest.SuppliernumberLinedff_Custom.

Primary Leave this blank.

Cardinality Zero or one

Data Set Join [DocumentLineId_Custom:{Line.LineId}]

Order By Leave this blank.

4. Verify your setup, save, and then click Actions and Publish to publish the algorithm.

Adding Custom Dimension based on DFF Setup
1. With the appropriate pricing administrator role, navigate to the Manage Matric Classes page.

◦ Offering: Order Management

◦ Functional Area: Pricing Administration

◦ Task: Manage Matrix Classes

2. Click Channel Program Eligibility to select and edit it.
3. Click Actions > Add Row in the Condition Columns section and add a column, for example:

Field Value

Name Enter a entity name here. For example, Supplier Number Equals.

Source Code Name Enter a value for example, SUPPLIER_NUMBER_E.

Comparison =

Compare to Attribute SuppliernumberLinedff_Custom.SuppliernumberLinedff_Custom.

Allow Null Selected.

Null is Wildcard Selected

Domain Number

4. Click the icon next to Domain to edit the column domain values.
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Field Value

Name Enter a name here. For example, Supplier Number Equals.

Default Value Leave this blank

Default is fixed value Don't select this.

Domain Type None

Data Type Number

Adding the Lookup code to the Channel Lookup
1. With the appropriate channel role, navigate to the Setup and Maintenance page.

◦ Offering: Order Management

◦ Functional Area: Channel Revenue Management

◦ Task: Manage Channel Lookups

2. On the Manage Channel Lookups page, search for ORA_CJM_SUP_REBATE_QUAL as the Lookup Type.
3. Click Action > New to add the following lookup code:

Field Value

Lookup Code Enter a name here. For example, SUPPLIER_NUMBER.

Enabled Selected

Meaning Enter a description here. For example, SUPPLIER_NUMBER.

4. Click Action > New to add another lookup code:

Field Value

Lookup Code Enter a name here. For example, SUPPLIER_NUMBER.

Enabled Selected

Meaning Enter a description here. For example, SUPPLIER_NUMBER.

How to Set Up Custom Qualifiers Based on Sales Invoice Header
Descriptive Flexfields  
Here's how you can set up and use custom qualifiers based on Sales Invoice Header descriptive flexfields in your
Customer Rebate programs.
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Configure Document Header Descriptive Flexfield
1. With roles having the required access, navigate to the Setup and Maintenance work area.

◦ Offering: Order Management

◦ Functional Area: Channel Revenue Management

◦ Task: Manage Channel Descriptive Flexfields
2. On the Manage Channel Descriptive Flexfields page, search for the Channel Document Header DFF as the

name, and click to edit it.
3. On the Edit Descriptive Flexfields: Channel Document Header DFF page, in the Global Segments section, click

Actions > Create to create a new Global Segment.

Field Value

Name Customer_Fabric_Color_headerdff

Code Customer_Fabric_Color_headerdff

API Name customerFabricColorHeaderdff

Enabled Ensure the check box is selected

4. Click Create Value Set.
5. On the Create Value Set page, enter the details, and save your work. For example:

Field Value

Value Set Code Customer_Fabric_Color

Description Customer_Fabric_Color

Module Channel Revenue Management

Validation Type Independent

Value Data Type Character

6. In the Definition section, enter the following details, and save your work. For example:

Field Value

Value Subtype Text

Maximum Length 15

7. Click Manage Values and ensure the values are enabled and save your work. For example:

Attribute Value Description Enabled

Value Black Black Selected
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Note:  This attribute value should have been specified in the sales order and available in the imported CSV
file to qualify the program.

8. Return to the Create Segment page, enter the required details, and save your work. For example:

Section Attribute Value

Column Assignment Data Type Character

Column Assignment Table Column ATTRIBUTE_CHAR1

Validation Value Set Customer_Fabric_Color

Validation Value Set Description Customer_Fabric_Color

Display Properties Prompt Customer_ Fabric_Color_headerdff

Display Properties Display Type List of Values

On the Manage Channel Descriptive Flexfields page, search for the Channel Document Header DFF, and click
Actions > Deploy Flexfield. Wait for the deployment dialog to indicate that deployment successfully finished,
then click OK

9. Verify your setup.

Download the Flexfield Archive and Obtain the View Object Details for the Channel
Document Header Descriptive Flexfields Context

1. From the Manage Channel Document Header Descriptive Flexfields page, select your flexfield.
2. From the Actions menu, select Download Flexfield Archive. Wait for the dialog to indicate that the archive

successfully finished, then click Download. Save the 10566_CJM_DOCUMENT_HEADER_DFF.zip file to your
local hard drive.

3. Open the file, extract and get the information for the context from the location:
10566_CJM_DOCUMENT_HEADER_DFF\oracle\apps\flex\scm\cjm\indirectSales\documentHeaderFlex\view

4. Open the XML file CjmDocumentHeaderDFFVO.xml for your flexfield to see the VO name. For example, name =
CjmDocumentHeaderDFFVO

5. You can also get the attribute name from the XML file. For example, ViewAttribute Name
=customerFabricColorHeaderDff.

Manage Service Mapping Setup Using Sandbox after Identifying the Channel
Document Header Descriptive Flexfields

1. With the appropriate pricing administrator role, navigate to the Sandboxes page.
2. In the Navigator, Configuration, click Sandboxes.
3. On the Sandboxes page, click Create Sandbox.
4. On the Create Sandbox page, enter a name for the sandbox. For example, CR_Sandbox3
5. Select the check box for the Manage Service Mappings tool, then click Create and Enter.
6. Navigate to the Pricing Administration work area, select Manage Service Mappings from the panel.

Note:  A yellow banner displays at the top of the page to indicate that you're in the sandbox.

7. On the Manage Service Mappings page, click Channel.
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8. On the Edit Service Mapping: Channel page, click the Entities tab. Use the Entities tab to define the entity and
its attribute details that receive the output of the service mapping. On the Entities tab, click Actions > Add Row,
and enter the following details:

Field Value

Entity Name of your entity, for example, CustomerFabricColorHeaderDff_Custom

Description A description containing information about the entity for the flexfield on the order header. For
example, CustomerFabricColorHeaderDff_custom.

9. In the Details section, add the following attributes, for example, and then save your work.

Attribute Type Primary Key Allow Null

DocumentHeaderId_Custom Long Selected Selected

customerFabricColorHeaderDff_
Custom

String Leave this blank Selected

10. To specify the services, click the Services tab, select ProgramEligibility.
11. In the ProgramEligibility: Details section, select the Entities tab, click Actions > Add Row, enter the following

values, for example, and then save your work.

Field Value

Entity CustomerFabricColorHeaderdff_Custom

Read Selected

Write Leave this blank

12. In the Entities section for the entity you created, add the following attributes, for example, and then save your
work.

Attribute Alias Read Write Parent Attribute

DocumentHeaderId_
Custom

Leave this blank Selected Leave this blank Leave this blank

customerFabricColorHeaderDff_
Custom

Leave this blank Selected Leave this blank Leave this blank

13. On the Edit Service Mappings: Channel page, select the Sources tab.
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14. For each of the following sources, add the entity you created, and add the following details in the Entity
Mappings tab of the Details section:

Field Value

Source ChannelProgramsForCustomerDocument

Entity The name of the entity you created. For example, CustomerFabricColorHeaderdff_Custom .

Type View object

View Object The name of the view object. You retrieve this information from the downloaded flexfield
definition XML file. For example, CjmDocumentHeaderDFFVO

Query Type Unique identifier

Query Attribute DocumentHeaderId

Use Existing View Object Selected

In the details section of your entity, on the Attributes Mappings tab, enter the attributes of the entity you
created and the view object attributes from the XML file, for example:

Attribute View Object Attribute

DocumentHeaderId_Custom DocumentHeaderId

customerFabricColorHeaderDff_
Custom

customerFabricColorHeaderDff

15. Click Save and Publish the sandbox. Once it is published, when the Eligibility REST is described, the attributes
should be visible in the payload.

Pricing Algorithm Setup

Note:  If you have implemented algorithm extensions for the Get Eligible Programs algorithm, then you must perform
the Merge Algorithm Extensions steps described in the Post-Update Steps section of the Oracle SCM Cloud:

Performing Your 22C Quarterly Update guide available from Oracle Fusion Cloud SCM: Performing Your Quarterly
Update (Doc ID 2337485.1).

After any customizations you must update the changes in the Pricing algorithm and publish it.

1. From the Navigator, select Pricing Administration.
2. From the Tasks panel click Manage Algorithms. Select the algorithm for program eligibility, Get Eligible

Programs.

Note:  You must create a new version of Get Eligible Programs to make changes and publish it. You cannot
modify published versions, for example, Version 0 and Version 1.
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3. On the Edit Algorithm: Get Eligible Programs page, select Process Supplier Ship and Debit or Customer
Rebate Programs > Process Eligible Program Headers. In the Data Sets section of the Algorithm tab, add the
data set you created using Service Mappings. Add the following details under the Header data set row:

Field Value

Name Enter your custom entity name here. For example, CustomerFabricColorHeaderdff_Custom.

Variable Path Add the variable path to your custom entity here. For example,
 EligibityRequest.CustomerFabricColorHeaderdff_Custom.

Primary Leave this blank.

Cardinality Zero or one

Data Set Join [DocumentHeaderId_Custom:{Header.HeaderId}]

Order By Leave this blank.

4. In the Data Sets section of the Algorithm tab, select Process Each Program Candidate > Process Program
Eligibility > Invoke Program Eligibility Matrix. Add the following details under the Header data set row:

Field Value

Name Enter your custom entity name here. For example, ServiceParam.

Variable Path Add the variable path to your custom entity here. For example, EligibityRequest.
EligibilityRequestEligibilityServiceParameter.

Primary Selected

Cardinality Leave this blank.

Data Set Join Leave this blank.

Order By Leave this blank.

5. Verify your setup, save, and then click Actions and Publish to publish the algorithm.

Adding Custom Dimension based on DFF Setup
1. With the appropriate pricing administrator role, navigate to the Manage Matric Classes page.

◦ Offering: Order Management

◦ Functional Area: Pricing Administration

◦ Task: Manage Matrix Classes

2. Click Channel Program Eligibility to select and edit it.
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3. Click Actions > Add Row in the Condition Columns section.

Field Value

Name Enter an entity name here. For example, XX_Color Equals.

Source Code Name Enter a value for example, XX_COLOR_E.

Comparison =

Compare to Attribute CustomerFabricColorHeaderdff_Custom.customerFabricColorHeaderdff_Custom

Allow Null Selected

Null is Wildcard Selected

Domain Text

4. Click the icon next to Domain to edit the column domain values.

Field Value

Name Enter a name here. For example, XX_Color Equals.

Default Value Leave this blank

Default is fixed value Don't select this.

Domain Type Custom

Data Type Text

Adding the Lookup code to the Channel Lookup
1. ◦ With the appropriate channel role, navigate to the Setup and Maintenance page.

- Offering: Order Management
- Functional Area: Channel Revenue Management
- Task: Manage Channel Lookups

2. On the Manage Channel Lookups page, search for ORA_CJM_CUS_REBATE_QUAL as the Lookup Type.
3. Click Actions > New to add the following lookup code:

Field Value

Lookup Code Enter a name here. For example, XX_Color .

Display Sequence 12

Enabled Selected

Meaning Enter a description here. For example, Custom Color
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How to Set Up Custom Qualifiers Based on Sales Invoice Line
Descriptive Flexfields  
Here's how you can set up and use custom qualifiers based on Sales Invoice Line descriptive flexfields in your Customer
Rebate programs.

Configure Document Line Descriptive Flexfield
1. With roles having the required access, navigate to the Setup and Maintenance work area.

◦ Offering: Order Management

◦ Functional Area: Channel Revenue Management

◦ Task: Manage Channel Descriptive Flexfields

2. On the Manage Channel Descriptive Flexfields page, search for the Channel Document Line DFF as the name-
and click to edit it.

3. On the Edit Descriptive Flexfields: Channel Document Line DFF page, in the Global Segments section, click
Actions > Create to create a new Global Segment.

Field Value

Name AccountNumber_Linedff

Code AccountNumber_Linedff

API Name accountnumberLinedff

Enabled Ensure the check box is selected

4. Click Create Value Set.
5. On the Create Value Set page, enter the details, and save your work. For example:

Field Value

Value Set Code Numbersequence

Description Numbersequence

Module Channel Revenue Management

Validation Type Independent

Value Data Type Number
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6. Click Manage Values and ensure the values are enabled and save your work. For example:

Attribute Value Description Enabled

Value 2 2 Selected

Note:  This attribute value should have been specified in the sales order and available in the imported CSV
file to qualify the program.

7. On the Manage Channel Descriptive Flexfields page, search for the Channel Document Header DFF, and click
Actions > Deploy Flexfield. Wait for the deployment dialog to indicate that deployment successfully finished,
then click OK

8. Verify your setup.

Download the Flexfield Archive and Obtain the View Object Details for the Channel
Document Line Descriptive Flexfields Context

1. From the Manage Channel Document Header Descriptive Flexfields page, select your flexfield.
2. From the Actions menu, select Download Flexfield Archive. Wait for the dialog to indicate that the archive

successfully finished, then click Download. Save the 10566_CJM_DOCUMENT_LINE_DFF.zip file to your local
hard drive.

3. Open the file, extract and get the information for the context from the location:
10566_CJM_DOCUMENT_LINE_DFF.zip\oracle\apps\flex\scm\cjm\indirectSales\documentLineFlex\view

4. Open the XML file CjmDocumentLineDFFVO.xml for your flexfield to see the VO name. For example, name =
CjmDocumentLineDFFVO

5. You can also get the attribute name from the XML file. For example, ViewAttribute Name =
accountnumberLinedff.

Manage Service Mapping Setup Using Sandbox After Identifying the Channel
Document Line Descriptive Flexfields

1. With the appropriate pricing administrator role, navigate to the Sandboxes page.
2. In the Navigator, Configuration, click Sandboxes.
3. On the Sandboxes page, click Create Sandbox.
4. On the Create Sandbox page, enter a name for the sandbox. For example, CR_Sandbox1
5. Select the check box for the Manage Service Mappings tool, then click Create and Enter.
6. Navigate to the Pricing Administration work area, select Manage Service Mappings from the panel.

Note:  A yellow banner displays at the top of the page to indicate that you're in the sandbox.

7. On the Manage Service Mappings page, click Channel.
8. On the Edit Service Mapping: Channel page, click the Entities tab. You use the Entities tab to define the entity

and its attribute details that receives the output of the service mapping. On the Entities tab, click Actions > Add
Row, and enter the following details:

Field Value

Entity Name of your entity, for example, AccountnumberLinedff_Custom

Description A description containing information about the entity for the flexfield on the order header. For
example, AccountnumberLinedff_Custom.
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9. In the Details section, add the following attributes, for example, and then save your work.

Attribute Type Primary Key Allow Null

DocumentLineId_Custom Long Selected Selected

AccountnumberLinedff_Custom Long Leave this blank Selected

10. To specify the services, click the Services tab, select ProgramEligibility.
11. In the ProgramEligibility: Details section, select the Entities tab, click Actions > Add Row, enter the following

values, for example, and then save your work.

Field Value

Entity AccountnumberLinedff_Custom

Read Selected

Write Leave this blank

12. In the Entities section for the entity you created, add the following attributes, for example, and then save your
work.

Attribute Alias Read Write Parent Attribute

DocumentLineId_Custom Leave this blank Selected Leave this blank Leave this blank

AccountnumberLinedff_
Custom

Leave this blank Selected Leave this blank Leave this blank

13. On the Edit Service Mappings: Channel page, select the Sources tab.
14. For each of the following sources, add the entity you created, and add the following details in the Entity

Mappings tab of the Details section:

Field Value

Source ChannelProgramsForCustomerDocument

Entity The name of the entity you created. For example, AccountnumberLinedff_Custom .

Type View object

View Object The name of the view object. You retrieve this information from the downloaded flexfield
definition XML file. For example, CjmDocumentLineDFFVO

Query Type Unique identifier
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Field Value

Query Attribute DocumentLineId

In the details section of your entity, on the Attributes Mappings tab, enter the attributes of the entity you
created and the view object attributes from the XML file, for example:

Attribute View Object Attribute

DocumentLineId_Custom DocumentLineId

AccountnumberLinedff_Custom accountnumberLinedff

15. Click Save and Publish the sandbox. Once it is published, when the Eligibility REST is described, the attributes
should be visible in the payload.

Pricing Algorithm Setup
After any customizations you must update the changes in the Pricing algorithm and publish it.

1. From the Navigator, select Pricing Administration.
2. From the Tasks panel click Manage Algorithms. Select the algorithm for program eligibility, Get Eligible

Programs.

Note:  You must create a new version of Get Eligible Programs to make changes and publish it. You cannot
modify published versions, for example, Version 0 and Version 1.

3. On the Edit Algorithm: Get Eligible Programs page, select Process Supplier Ship and Debit or Customer
Rebate Programs > Process Eligible Program Headers. In the Data Sets section of the Algorithm tab, add the
data set you created using Service Mappings. Add the following details under the Header data set row:

Field Value

Name Enter your custom entity name here. For example, AccountnumberLinedff_Custom.

Variable Path Add the variable path to your custom entity here. For example,
 EligibityRequest.CustomernumberLinedff_Custom

Primary Leave this blank.

Cardinality Zero or one

Data Set Join [DocumentLineId_Custom:{Line.LineId}]

Order By Leave this blank.
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4. In the Algorithm tab, select Process Each Program Candidate > Expand Process Program Eligibility  > Invoke
Program Eligibility Matrix. Add the following details under the Header data set row:

Field Value

Name Enter your custom entity name here. For example, AccountnumberLinedff_Custom.

Variable Path Add the variable path to your custom entity here. For example,
 EligibityRequest.AccountnumberLinedff_Custom.

Primary Leave this blank.

Cardinality Zero or one

Data Set Join [DocumentLineId_Custom:{Line.LineId}]

Order By Leave this blank.

5. Verify your setup, save, and then click Actions and Publish to publish the algorithm.

Adding Custom Dimension Based on DFF Setup
1. With the appropriate pricing administrator role, navigate to the Manage Matric Classes page.

◦ Offering: Order Management

◦ Functional Area: Pricing Administration

◦ Task: Manage Matrix Classes
2. Click Channel Program Eligibility to select and edit it.
3. Click Actions > Add Row in the Condition Columns section and add a column, for example:

Field Value

Name Enter an entity name here. For example, Account Number.

Source Code Name Enter a value for example, ACCOUNT_NUMBER_E.

Comparison =

Compare to Attribute AccountnumberLinedff_Custom.AccountnumberLinedff_Custom

Allow Null Selected

Null is Wildcard Selected

Domain Number

Adding the Lookup Code to the Channel Lookup
1. ◦ With the appropriate channel role, navigate to the Setup and Maintenance page.

- Offering: Order Management
- Functional Area: Channel Revenue Management
- Task: Manage Channel Lookups
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2. On the Manage Channel Lookups page, search for ORA_CJM_CUS_REBATE_QUAL as the Lookup Type.
3. Click Actions > New to add the following lookup code:

Field Value

Lookup Code Enter a name here. For example, ACCOUNT_NUMBER.

Enabled Selected

Meaning Enter a description here. For example, Account Number

4. Click Actions > New to add another lookup code:

Field Value

Lookup Code Enter a name here. For example, ACCOUNT_NUMBER.

Enabled Selected

Meaning Enter a description here. For example, Account Number

Oracle Fusion Order Management Integration  
When creating or revising a sales order, eligible channel programs can be applied to the order line in the form of
incentives.

Channel program details are exposed in order management extension rules to write additional rules to control how
channel programs are applied and managed on the order.

Note:
• Channel Revenue Management supports Requested Ship Date as a qualifier. In the Sales Order page, the

Request Type is Ship On.

• Requested Arrival Date isn't supported as a qualifier. In the Sales Order page, the Request Type is Arrive On.

Related Topics
• Overview of Using Extensible Flexfields in Order Management
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4  Workflow Approvals and Notifications

Overview of BPM Workflow-based Approvals  
With Business Process Management workflow, you can configure customer claim approval rules that the application
uses to process and route approvals to designated approvers.

BPM Workflow-based approvals are only available for customer claims. Approvers receive notifications to take action on
customer claims.

Use the approval rules to:

• Automate your approval business process

• Improve business rules flexibility through:
◦ Serial and parallel routing

◦ Escalation

• Facilitate approver actions to:
◦ Request for additional information, Approve, Reject

◦ Reassignment

• Improve auditability with:
◦ Approval history

You can configure notifications to:

• Control when to send notifications to users involved with the task

• Disable or enable in-app or email notifications, or both

Related Topics
• Configure Workflow Approvals and Notifications

Claim Approvals  
In this topic, you'll learn about how claim approvals work with BPM Workflow.

• Manage Stuck Approvals using the Transaction Console:
◦ View in-flight and completed approval processes using the keyword Customer Claim.

◦ Terminate the approval process and move the claim to Open status.

◦ Restart the approval process after correcting the approval rule.

• Skip approvals
◦ If you settle a claim using only Open Deductions, Open Overpayments, or Open Credit Memos, then the

application skips the approval process and moves the claim directly from Open to Settlement Pending
status. This applies only if the Approve Customer Claims with BPM Workflow feature is opted in.
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• Submitted claim reverts to Open status
◦ The submitted claim will move from Approval Pending to Open status if the approval task flow is in error.

This can happen if there are no active stages or participants.

• Settlement amount used for approval
◦ The settlement amount used for approval will not include the amount from Open Deductions, Open

Overpayments, and Open Credit Memos.

• Claim attributes in approval rules
◦ Claim attributes used in approval rules must be prefixed by Claim..

Configure Workflow Approvals and Notfications  
The BPM Worklist enables you to configure claim approvals through a set of workflows.

Here are some examples of what you can do to configure workflow tasks, including notifications:

• Set how many levels of approval are needed for transactions over a particular amount

• Define who the assignees would be, based on the supervisory hierarchy in Oracle Fusion Cloud HCM

• Create approval groups so that the workflow task can be assigned to the set of users in the group instead of an
individual user

• Control when to send notifications to users involved with the task

• Disable or enable in-app or email notifications, or both

Here's a summary of the configuration tasks:

• Sign in as a supply chain administrator.

• Opt into the Approve Customer Claims with BPM Workflow feature.

• To access the BPM Worklist, run the Manage Task Configurations for Supply Chain Management task in the
Customers functional area.

• Search for the ChannelCustomerClaimsApprovalTask.

• Update the workflow tasks by including details of deadlines and escalation policy.

• Select the notification type and provide additional details to configure the notification.

• Create approval groups that include a predefined set of users configured to act on the notification.

• Create approval rules that include conditions for approval.

Predefined Attributes Used in Claim Approval Rules  
Predefined attributes are provided for use in claim approval rules.

The following table contains the list of predefined attributes used in claim approval.

Attribute Description Sample Value

Claim.billToAccountNumber Number of the bill-to customer account. 1008
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Attribute Description Sample Value

Claim.billToCountryCode Abbreviation that identifies the country for the
bill-to address.

US

Claim.billToCustomer Name of the bill-to customer. Seven Corporation

Claim.businessUnitId Value that uniquely identifies the business unit. 2304

Claim.claimCurrencyCode Abbreviation that identifies the currency used
for the channel claim.

USD

Claim.claimDate Date when a claim is created. 2023-08-10

Claim.claimId Value that uniquely identifies the channel claim. 300100578945838

Claim.claimNumber Number that indicates the customer claim. CLM37054

Claim.claimOwnerUsername Username of the user who created the claim. ANALYST109

Claim.claimReasonCode Abbreviation that identifies the channel claim
reason.

SHIPPING

Claim.claimSalespersonNumber Value that uniquely identifies the claim's
salesperson.

Claim.claimSourceCode Abbreviation that identifies the claim source. CLAIM

Claim.claimTypeCode Abbreviation that identifies the channel claim
type.

DAMAGES

Claim.functionalCurrencyCode Abbreviation that identifies the functional
currency.

USD

Claim.invoiceSalespersonNumber Value that uniquely identifies the claim
salesperson associated with the invoice.

49032

Claim.settlementAmount Amount associated with the settlement
method. It doesn't include the amount from
Open Deductions, Open Overpayments, or
Open Credit Memos.

935.32

Claim.settlementMethod The name of the payment method used to
settle the claim.

Credit Memo

Claim.settlementMethodCode Abbreviation that identifies the payment
method used to settle the claim.

CM_ON_ACCOUNT

Claim.settlementTypeCode Abbreviation that identifies the settlement type
selected to settle the claim.

ORA_NON_PROMOTIONAL

Claim.shipToCountryCode Abbreviation that identifies the country for the
ship-to address.

US

Claim.shipToCustomerId Value that uniquely identifies the ship-to
customer.

1008

Claim.submittedBy Username of the claim submitter. ANALYST109

Claim.Task.Creator Username of the user submitting the claim. ANALYST109

117



SCM Cloud
Implementing Channel Revenue Management

Chapter 4
Workflow Approvals and Notifications

Migrate Pending Approvals to BPM Workflow  
The Migrate Pending Approvals to BPM Workflow scheduled process to enable BPM workflow-based approvals for
channel entities in pending approval status.

If there are claims in Approval Pending status when you opt in to the Approve Customer Claims with BPM Workflow
feature, then the claims for the netting use cases are considered as approved and moved to Settlement Pending status.
This means that when you settle a using only Open Deductions, Open Overpayments, or Open Credit Memos, then
these claims are considered approved and moved to settlement pending status.

Parameter Description Required

Migrate Customer Claims Select a value from the list to decide whether to
migrate customer claims. By default, this is No.
Select Yes to run the scheduled process. If there
are no claims in approval pending status, then
no claims will be processed.

No
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5  Set Up Channel Settings

Manage Channel Settings  
Use the Manage Settings page to review and update values for the predefined Channel Revenue Management settings.
You can't create a new setting, or delete existing ones. You can update them based on your business needs.

In the Setup and Maintenance work area, go to:

• Offering: Order Management/Procurement

• Functional Area: Channel Revenue Management/Supplier Incentives

• Task: Manage Channel Settings

Note:  Some of these settings are required tasks.

Setting Description Required

Aging Method for Filtering
 

Use this setting to select the aging bucket that
should be used to filter claims at your site.
Aging Methods can be created in Receivables
using the task: Manage Aging Methods.
 

Note:
You can select only one aging method, and it
must belong to the Common Set.
 
If you don't configure the aging method,
 Manage Claims page won't have the
capability to filter by age.
 

Yes, for Deductions and Settlement
 

Automatically Show Available Programs to
Associate

By default, programs available to be associated
are displayed. Change this setting if you don't
want to display the programs available for
association.

Yes for Customer Promotion Prorgams.

Calendar for Accrual Calculation
 

Use this setting to specify the calendar period
used to associate supplier annual program
accruals based on your fiscal periods.
 

Tip:
Don't define a calendar based your fiscal
periods. Typically a January to December
calendar is used to communicate with all
your suppliers.
 

Yes, for Supplier Annual Programs
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Setting Description Required

Tip:
The CSV import will fail if the invoice date
of the supplier invoice can't find a matching
period. Don't forget to open periods for a
new year.
 

CAUTION:
You won't be able to update or disable the
setting after it's saved.
 

Recommendation: Start your Period Name
with the year.
 

Claim Owner
 

Use this setting to assign a claim owner for your
claims at the BU level.
 

Note:  The value you add in this setting is
used as the default if you haven't configured
the Customer Trade Profile or the Supplier
Trade Profile. However, it is recommend that
you configure the owner for the Customer
Trade Profile and the Supplier Trade Profile.

To create a new assignment:
 

1. In the Assignment - Claim Owner: Values
section, click the Add icon.

2. From the list, select the Business Unit for
which you want to assign a claim owner.
You can see only the BUs you have access
to.

3. Select the Claim Owner from the list.
4. Enter a Value Code. This acts as a unique

identifier for the setting, and is required.
5. Click Save.

No, but recommended.
 

Credit Method for Accounting Rules
 

Use this setting to select the receivables
method that must be used to reverse
accounting entries for the settlement method
Credit Memo - On Invoice, if accounting rules
are used in the original invoice.
 

1. In the Settlement by Credit Memo - On
Invoice - Credit Method for Accounting
Rules: Values section, select a value from
the Credit Method for Accounting Rules
list.

LIFO: Last In First Out. Starts from the last
accounting period and reverses all prior
periods till the credit memo is used up.

Prorate: Credits an equal percentage to all
the account assignments for the invoice.

Yes, for Deductions and Settlement
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Setting Description Required

This is the value which is enabled by
default.

Unit: Reverses revenue for the number of
units specified in the original invoice line.

2. The Value Code is SITE, as this is a site
level setting.

3. Click Save.

Credit Method for Installments
 

Use this setting to select the receivables
method that must be used to credit
installments for the settlement method Credit
Memo - On Invoice, if there are multiple
installments in the original invoice.
 

1. In the Settlement by Credit Memo - On
Invoice - Credit Method for Installments:
Values section, select a value from the
Credit Method for Installments  list.

FIFO: First in First Out. Credits the first
installment first.

LIFO: Last In First Out. Credits the last
installment first.

Prorate: Credit the installments of the
credited transactions and prorate them
based on the amount remaining for each
installment. This is the value which is
enabled by default.

2. The Value Code is SITE, as this is a site
level setting.

3. Click Save.

Yes, for Deductions and Settlement
 

Deduction Threshold
 

Use this setting to set the threshold amount for
your deduction write-offs.
 

1. In the Settlement by Write-off - Deduction
Threshold: Values section, click the Add
icon.

2. From the list, select the Business Unit
for which you're setting up the write-off
threshold. You can see only the BUs you
have access to.

3. Enter the threshold amount in the
Deduction Threshold field. This is in the
ledger currency of the BU you selected.

4. Enter a Value Code. This acts as a unique
identifier for the setting, and is required.

5. Click Save.

Yes, for Deductions and Settlement
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Setting Description Required

Note:
When you update the threshold amount,
there's no impact on existing deductions
which are already eligible for write-offs.
 
The write-off threshold amount in Channel
Revenue Management must be between
the From Write-off Limit per Receipt
and To Write-off Limit per Receipt in the
Receivables System Options page > Cash
Processing tab for the corresponding BU.
 

Event for Triggering Supplier Rebate Accrual
 

Use this setting to specify the event that
triggers the creation of supplier rebate accruals.
 

1. In the Supplier Rebate - Event for
Triggering Supplier Rebate Accrual: Values
section, click the Add icon.

2. From the list, select the Business Unit
for which you're setting up the triggering
event. You can see only the BUs you have
access to.

3. Select the triggering event from the Event
for Triggering Supplier Rebate Accrual
list.

Receiving Transaction: Supplier rebate
accruals are created after the PO is
received.

Supplier Invoice: Supplier rebate accruals
are created only after the PO is received
and invoiced.

4. Enter a Value Code. This acts as a unique
identifier for the setting, and is required.

5. Click Save.

Note:
An important deployment best practices
for supplier rebates is determining when
to trigger the posting of accruals. The best
practice approach is that most organizations
should trigger the posting of accruals upon
the receipt of a supplier invoice for received
goods, because this validates that the
received goods weren't delivered in error,
and there is no doubt with an invoice number
which received goods are being accrued and
claimed.
 

Yes, for Supplier Rebate
 

Receivables Activity for Receipt Write-Offs
 

Use this setting to select the receivables activity
that should be used for receipt write-offs for
non-invoice related deductions.
 

1. In the Settlement by Write-off -
Receivables Activity for Receipt Write-Offs:
Values section, click the Add icon.

Yes, for Deductions and Settlement
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Setting Description Required

2. From the list, select the Business Unit for
which you're setting up the write-off. You
can see only the BUs you have access to.

3. Select the Receivables Activity from the
list.

4. Enter a Value Code. This acts as a unique
identifier for the setting, and is required.

5. Click Save.

Receivables Activity for Write-Off Adjustment
 

Use this setting to select the receivables activity
that should be used for write-off adjustments
for invoice related deductions.
 

1. In the Settlement by Write-off -
Receivables Activity for Write-Off
Adjustment: Values section, click the Add
icon.

2. From the list, select the Business Unit for
which you're setting up write-offs. You can
see only the BUs you have access to.

3. Select the Receivables Activity from the
list.

4. Enter a Value Code. This acts as a unique
identifier for the setting, and is required.

5. Click Save.

Yes, for Deductions and Settlement
 

Settlement Type Use this setting to choose the default
settlement type. You can choose between
Promotional and Nonpromotional.

Yes, for Deductions and Settlement and
Customer Promotion Programs.

Write-off Reviewer
 

Use this setting to select the claim owner who
must review the write-offs for your business
unit.
 

1. In the Settlement by Write-off - Write-Off
Reviewer: Values section, click the Add
icon.

2. From the list, select the Business Unit for
which you're setting up the write-off. You
can see only the BUs you have access to.

3. Select the reviewer from the Write-Off
Reviewer list.

4. Enter a Value Code. This acts as a unique
identifier for the setting, and is required.

5. Click Save.

No.
 

Note:  If you use Redwood, then this setting
isn't applicable.

Note:  After saving a setting, you can't delete it. You can only disable it, by deselecting the Enable check box.
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Manage Aging Methods  
Aging methods aid in the timely and efficient resolution of deductions. Claim age is calculated based on days from
claim creation to resolution. Use the Manage Aging Methods page to create or update your aging methods. This must
belong to the common set.

In the Setup and Maintenance work area, go to:

• Offering: Order Management

• Functional Area: Channel Revenue Management

• Task: Manage Aging Methods

How Age is Calculated for a Claim

• For Open Claims

Age = System Date - Claim Date + 1

• For Resolved Claims

Age = Resolved Date - Claim Date + 1

Related Topics
• Aging Methods

How to Set Up Write-offs  
Investigating deductions can be time intensive and often not cost effective for smaller deductions. By configuring
thresholds at the business unit, customer, account, and bill-to site levels, automatic write offs can process eligible claims
without any human intervention.

After claim investigation of a deduction or invoice deduction, a claim analyst with the correct privileges can manually
write off any amount because it will go through approvals.

You must also configure receivables activity used in the creation of the receipt write-off or of write-off adjustment in AR.
For invoice deductions, you settle as a write-off adjustment. For deductions, you settle as a receipt write-off.

Write-off Type Thresholds Approvals Receivables Activity for
Receipt Write Off

Receivables Activity for
Write-Off Adjustment

Automatic Set at:
• Business Unit - in

Channel Settings

• Party - in Customer
Trade Profile

• Account - in Customer
Trade Profile

N/A Set at:
• Business Unit - in

Channel Settings

Set at:
• Business Unit - in

Channel Settings
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Write-off Type Thresholds Approvals Receivables Activity for
Receipt Write Off

Receivables Activity for
Write-Off Adjustment

• Bill-to Site - in
Customer Trade
Profile

Manual (requires the
claim analyst to have the
privilege to do manual write
offs)

N/A Required Set at:
• Business Unit - in

Channel Settings

• Claim Type - in
Manage Channel
Claim Types

Set at:
• Business Unit - in

Channel Settings

• Claim Type - in
Manage Channel
Claim Types

How to Configure Deduction Claims for Write-Off
You can configure deduction claims to be written off using the following settings:

• From the Manage Channel Settings page, set up the following at the business unit level:

◦ Deduction Threshold

◦ Receivables Activity for Receipt Write-offs

◦ Receivables Activity for Write-off Adjustment

◦ Write-off Reviewer

Note:  If you use Redwood, then this setting isn't applicable.

If the claim amount is less than or same as the threshold amount, and a reviewer is selected, then this
reviewer is assigned the claim, as the claim owner. The claim is created in the Open status.

If the write-off reviewer isn't enabled, and the deduction amount is less than or same as the threshold
amount, then the claim is created directly in the Settlement Pending status.

• From the Manage Claim Types page, you can set up a default receivables activity for receipt write-off and
for write-off adjustment for a business unit and claim type when writing off customer claims. This mapping
enables you to standardize write-off accounting for a set of claim types.

If the receivables activity isn’t specified for the claim type, then the value is defaulted from the business unit.

Related Topics
• Manage Supplier Claim Types

• Write-offs and Receipts

• Create Customer Trade Profiles
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6  Set Up User Statuses

User Statuses  
Claims and Programs have predefined statuses based on their various stages. In addition to this, you can create user-
defined statuses based on your business needs.

For example, you might want a review of a program that's pending for approval from another department. You can use a
user status to indicate the same.

Manage User Statuses
You can use the Manage User Statuses page to create and update user-defined statuses for program and claim
statuses. Each system status comes with a predefined user status. Make sure you minimally update the description and
change the user status name, if necessary. You can create new statuses based on additional business needs.

1. In the Setup and Maintenance work area, go to:

◦ Offering: Order Management/Procurement

◦ Functional Area: Channel Revenue Management/Supplier Incentives

◦ Task: Manage Channel User Statuses

2. On the Manage User Statuses page, click the Add icon to create a new user status.

Note:  You can have multiple user statuses for each system status.

3. Enter a code for your user status in the User Status Code field. This code:

◦ Acts as a unique identifier for the user status, and is required.

◦ Is used to identify and synchronize setup data across multiple environments.

◦ Is not available to users in the transactional pages.

4. From the User Status For drop-down list, select either Claim or Program.
5. Use the Buy Side and Sell Side check boxes to select the channel flows for which you want the user status

enabled. You can't update this after saving the user status.
6. Enter the name of your user status in the User Status field.
7. From the System Status drop-down list, select the system status for which you're creating this user status.
8. Select the Buy-side Default check box if you want to make this user status the default for the selected system

status for buy side channel flows. Select the Sell-side Default check box if you want to make this user status
the default for the selected system status for sell side channel flows. For every system status, there must be one
default user status.

9. Select the Enable check box to enable the user status.
10. Enter values for the remaining fields, if required. Click Save.

Note:  Once saved, you can't delete a user status. You can only disable it.
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7  Set Up Sell Side Programs

Overview of Customer Programs  
A customer program is used to define a channel agreement between the manufacturer, distributor, or wholesaler and
their channel customers.

Customer Programs encompass Customer Rebate Programs and Customer Lump Sum Programs.

Program managers can negotiate customer promotions and create programs.

Delivered program templates represent supported channel business processes. The purpose of a program type is to
model the enterprise’s channel business requirements by configuring features of a program type based on a program
template.

The program type controls and simplifies the program creation. When a program manager creates a program, the
identification of a program type is required and this will drive how a program is created, applied, and processed.

Related Topics
• Elements of a Customer Promotion Program

Set Up Customer Program Qualifiers  
Here you'll understand how to set up customer program qualifiers.

Qualifiers are attributes used to define eligibility in the form of customer, additional conditions, and product rules in a
channel program. Only those qualifiers that are part of the program type can be selected in the program. That is, you
have to select the qualifiers during program type creation, and only these are available for selection in the programs.
If you need a new qualifier type to be available in the program, you must first add that qualifier in the corresponding
program type.

How to Add User-Defined Attributes to Items  
You can create user-defined attributes that can be used in the program product rules to determine the price or discount.

You must set it up as an item extensible attribute in an item class to represent details about the item.

Create an Attribute Group and Attributes
1. With roles allowing access, in the Setup and Maintenance work area, go to:

◦ Offering: Product Management

◦ Functional Area: Items
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◦ Task: Manage Item Attribute Groups and Attributes

2. In the Manage Attribute Groups page, from the Actions drop-down button, click Create to create an attribute
group.

3. In the Create Attribute Group page, enter the details for the following fields:

Field Description

Display Name Enter a display name for the attribute group. For example, Item Color.

Internal Name Enter an internal reference name. For example, Item Color Specification.

API Name Automatically populated, edit if required.

Behavior Select Single Row from the list.

4. On the Context Usages tab, select Create from the Actions drop-down list.
5. Select Item from the Name list as the context usage. Click Save. This creates the attributes group with context

usage as Item.
6. In the Edit Attributes page, in the Attributes section, click Create from the Actions drop-down button.
7. In the Create Attribute page, enter the details for the following required fields:

Field Description

Display Name Enter a display name for the attribute. For example, Color.

Internal Name Enter an internal reference name. For example, Product Color.

API Name Automatically populated, edit if required.

Data Type Select the data type of the attribute. For example, for color select Character.

Table Column Automatically populated, edit if required.
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8. Select a Value Set from the list, or create one by clicking Create Value Set.

If you're creating a value set, in the Create Value Set page, enter the details for the following fields:

◦ Enter a code for your value set. For example, PRODUCT_COLOR.

◦ Enter a description to for the value set. For example, Value set for product colors.

◦ Select Product Model from the Module list.

◦ Select a Validation Type. You must select Independent or Format Only for each item extensible attribute
that you plan to use with Pricing.

◦ Select the data type of your value set from the Value Data Type list. You must select either Number or
Character for the data type. Other data types aren't supported.

◦ In the Definition section, enter the required details and save.

◦ Click Manage Values to add the values for the value set.

◦ In the Manage Values page, Click Create from the Actions drop-down button.

◦ Add the values you want for your value set. For example, different product colors like blue, red, and so on.

◦ Click Save and Close to navigate back to the Create Attributes page.

9. In the Create Attributes page, the Display Properties are now populated. You can edit this if required.

◦ Prompt: The prompt for your attribute. For example, Color.

◦ Display Type: How the values should be displayed. For example, List of Values.

10. Click Save and Close. The attribute for the attribute group is saved, and you're now on the Edit Attribute Group
page. You can create more attributes for this group if required. Note down the flexfield code and save.

Add the Attribute Group to an Item Class
1. With roles allowing access, in the Setup and Maintenance work area, go to:

◦ Offering: Product Management

◦ Functional Area: Items

◦ Task: Manage Item Classes

2. In the Manage Item Classes page, select the Item Class under which you want to add the attribute group and its
attributes as extensible attributes. You can select the Root Item Class to add the attribute group to all the item
classes.

3. In the Edit Item Class page, click Pages and Attribute Groups tab. On the Attribute Groups subtab, from the
Actions drop-down button, click Select and Add.

4. Select your attribute group and click Apply, then click OK. Click Save to save the updates to the item class.
5. Navigate to the Pages subtab. Select Pricing Item Attributes. If it's not available, add it. See the Add Your

Attribute Group to An Item Class section in the Add Your Own Attributes to Items in Pricing topic from the
Pricing Administration guide.

6. In the Attributes Group: Pricing Item Attributes section, click Select and Add from the Actions drop-down
button. Select your attribute group. Click Apply, then OK. Click Save to save the updates to the item class.

7. Navigate to the Functional Item Pages subtab and ensure that the following is available:

◦ Functional Area: Pricing

◦ Usage: Pricing

◦ Item page: Pricing Item Attributes

The attribute group is added to the item classes.

131



SCM Cloud
Implementing Channel Revenue Management

Chapter 7
Set Up Sell Side Programs

Deploy the Item Extensible Flexfield
After associating the attribute groups to the item classes, you must deploy the extensible flexfield.

1. With roles allowing access, in the Setup and Maintenance work area, go to:
◦ Offering: Product Management

◦ Functional Area: Items

◦ Task: Deploy Item Extensible Flexfields

2. Search for your flexfield code. Select it and click Deploy Flexfield.
3. After successful deployment, you must sign out and sign back in to view the EFF configuration on the item.

Edit the Pricing Matrix Class
You must now add the item attribute to the Pricing Matrix Class.

1. With roles allowing access, from the Navigator, select Pricing Administration. In the Overview page, open the
Tasks panel and select Manage Matrix Classes.

2. In the Manage Matrix Classes pages, select Channel Program Eligibility.
3. In the Edit Matrix Classes page, click Add Row from the Actions drop-down list. This creates a new dimension

to Channel Program Eligibility.
4. In the Name field, enter a name for your dimension. For example, Color.
5. In the Source Code Name field, enter a code concatenated with the operator abbreviation. The supported

operator abbreviations are E for equal to, NE for not equal to, EGT for greater than or equal to, and ELT for less
than or equal to. For example, COLOR_E.

6. In the Comparison field, choose the comparison operator. For example, =.
7. From the Compare to Attribute drop-down list, select one of the following. You must select the same data type

that you specified when you set up the attribute on the Manage Item Attribute Groups and Attributes page. If
the data types don't match, then the eligibility rules won't work correctly.

◦ itemExtensibleAttribute.VarcharValue

◦ itemExtensibleAttribute.NumberValue

8. Leave the Required check box deselected. Select the Allow Null and Null Is Wildcard check boxes.
9. From the Domain list, select:

◦ Domain Type: Item Extensible Attribute

◦ Data Type: Select the same data type that you specified when you set up the attribute on the Manage
Item Attribute Groups and Attributes page

◦ Attribute: Select the attribute you created in the Manage Item Attribute Groups and Attributes page.

◦ Attribute Group Identifier: ItemExtensibleAttribute.AttributeGroupCode (default value)

◦ Attribute Identifier: ItemExtensibleAttribute.AttributeCode (default value)

10. Leave the Default Value field blank as it's not used. Click OK.
11. Click Save.

Update Channel Lookup
1. In the Setup and Maintenance work area, go to:

◦ Offering: Order Management/Procurement

◦ Functional Area: Channel Revenue Management/Supplier Incentives

◦ Task: Manage Channel Lookups
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2. Search for the extensible lookup: ORA_ CJM_CUST_ITEM_LEVEL and add a new lookup code.
3. In the Lookup Code field, enter the same name as the Source Code Name used for Channel Program Eligibility

matrix class (without the concatenated operator). For example, if the Source Code Name in the matrix class is
COLOR_E, then enter COLOR as the lookup code.

4. Enter values for the remaining fields and click Save.

Note:  For more information about creating extensible flexfields, see User Defined Attribute Groups and Attributes
(Extensible Flexfields-EFFs) Setup White Paper (Doc ID 1992317.1) on My Oracle Support at https://support.oracle.com.

Overview of Lump Sum Programs  
Manufacturers may have agreements with retailers to incentivize them for carrying out certain trade promotion
activities on behalf of the manufacturer.

Lump sum programs are created by manufacturers or wholesalers to offer incentives to retailers for these types of
promotional activities. Promotional payments arising out of lump sum programs are accrued as soon as the program
becomes active. Lump sum programs are customer-specific and they target only one customer at a time.

Related Topics
• Elements of a Lump Sum Program

Set Up Program Types  

Predefined Customer Program Templates  
Predefined program templates represent supported channel flows.

You must select a program template when creating a program type. Templates supported are:

• Customer Promotion

• Customer Lump Sum

Promotion Code Numbering
The promotion code is made up of a prefix and a single sequence. Prefix is defined by the program type. The predefined
prefixes are:

• Customer Promotions - CREB

• Customer Lump Sum programs - CLUM

A single sequence generates numbers from a given starting number stored in the database. This single sequence is
across all programs.

Note:  If you prefer, you can configure your own prefix for a program type. A prefix can be shared across multiple
program types if so determined.
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Manage Program Types  
The purpose of a program type is to model the enterprise’s channel business requirements by configuring features of a
program type based on a program template.

The program type controls and simplifies the program creation. When a program manager creates a program, the
identification of a program type is required and this drives how a program is created, applied, and processed.

Use configurable program types to create programs.

Program Type for Customer Promotion Programs
The customer promotion template supports different date contexts and customer eligibility based on the customer, bill-
to, or ship-to qualifiers. Additional conditions may be based on order type, order line type, warehouse, or salesperson
qualifiers. Specify product rebates in terms of the percentage or the amount per unit.

A program type can restrict the date contexts, selection of qualifiers, or the type of rebates available to simplify program
creation.

You can create and update customer promotion program types from the Manage Program Types page.

1. In the Setup and Maintenance work area, go to:

◦ Offering: Order Management

◦ Functional area: Channel Revenue Management

◦ Task: Manage Channel Program Types

2. Click the Create icon to open the Create Program Type page.
3. Select Customer Promotion from the Based on Predefined Program Template list of values.
4. Enter a name for your program type in the Name field.
5. Enter a code for your program type in the Program Type Code field. This code:

◦ Acts as a unique identifier for the program type.

◦ Is used to synchronize setup data across multiple environments.

◦ Isn’t available to users in the transactional pages.

6. Update the Prefix field if required. This value acts as the prefix for your Promotion Code while creating a
program. The predefined prefix for the customer promotion template is CREB.

7. Select the Enable program beneficiary check box to specify an alternate beneficiary to whom the accrued
earnings will be paid. The beneficiary can be different from the eligible customer on the sales transaction.
Alternate beneficiaries are defined within the context of a program, and must be a customer. Enable this check
box for a royalty program type.

8. On the Qualifiers tab:
a. Select the applicable date contexts for your programs. From the Qualify Programs Based On list of

values select either:
- Actual Ship Date: If you select this, then the channel programs created with this program type are

qualified by matching them against the actual ship date.
- Invoice Date: If you select this, then the programs are qualified by matching them against the

invoice date.
- Order Date: If you select this, the programs are qualified by matching them against the order date.
- Requested Arrival Date: If you select this, the programs are qualified by matching them against

the requested arrival date.
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- Requested Ship Date: If you select this, the programs are qualified by matching them against the
requested ship date.

b. Add the qualifiers you want for your customer and additional conditions rules. The values in the list of
values are from the lookup ORA_CJM_CUST_REBATE_QUAL.

9. On the Accrual Calculation tab, specify the pricing charge definition that Pricing associates with an item. Select
a pricing basis for discount types. You can choose between Unit List Price and Unit Selling Price. If you select
Unit List Price, then you must ensure that the Unit List Price is specified in the sales transaction CSV file. The
Unit Selling Price is mandatory in the sales transaction.

10. On the Optional Defaulting tab, specify the defaults for your programs.
◦ Default Program Currency To: Select the default currency for your program from the list of values. For

example, US Dollar.
◦ Default Discount Type for Product Rules To: Select the default discount type for your product rule from

the list of values. Available values are Amount and Percent.
11. Click Save. The program type is created in the Draft status.

Program Type for Customer Lump Sum Programs
The lump sum program template supports lump sum programs that are customer-specific and target a single customer
at a time.

This program type enables you to default the program currency and product distribution.

You can create and update lump sum program types from the Manage Program Types page.

1. In the Setup and Maintenance work area, go to:
◦ Offering: Order Management

◦ Functional Area: Channel Revenue Management

◦ Task: Manage Channel Program Types
2. On the Manage Channel Program Types page you can create and update your program types. Click the Create

icon. The Create Program Type page opens.
3. From the Based on Predefined Program Template drop-down list, select Customer Lump Sum.
4. Enter a name for your program type in the Name field.
5. Enter a code for your program type in the Program Type Code field. This code:

◦ Acts as a unique identifier for the program type.

◦ Is used to synchronize setup data across multiple environments.

◦ Isn’t available to users in the transactional pages.
6. Update the Prefix field if required. This value acts as the prefix for your Promotion Code while creating a

program. The predefined prefix for the customer lump sum program template is CLUM.
7. In the Optional Defaulting tab, select the defaults. The defaults you select here determine the defaults during

program creation.
◦ Default Program Currency To: Optionally, select a default currency.

◦ Default Product Distribution Type To: Optionally, select the type of product distribution. You can
choose from Amount, Even, or Percent.

8. From the Actions menu, select Activate to active the lump sum program type.

Program Type Statuses  
Use program type statuses to monitor your customer program types.
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Use program type statuses to monitor your program types. You can update them from the Manage Program Types
page. Statuses for program type are defined in the lookup ORA_CJM_PROGRAM_TYPE_STATUS.

This table shows supported program type statuses.

Status What Happens to the Channel Program

Draft The program type has been created and not activated.

Active The program type has been activated for use. Only active program types can be used to create a
program.

Closed for New Programs An active program type can be closed for use in additional new programs. These are no longer eligible
for use in new programs.
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8  Set Up Buy Side Programs

Overview of Supplier Programs  
Suppliers programs are used to define the rules of a channel agreement between the distributor or wholesaler and their
suppliers.

Generally, supplier programs are organized into various types, each with their own rule structure and set of business
processes. This structure is encompassed in a program type. When creating a program, the identification of a program
type is required. Use program types to determine channel guidelines, such as defining how a program is created,
applied, and processed. The program type controls and simplifies the program creation.

Related Topics
• Elements of a Supplier Ship and Debit Program

• Elements of a Supplier Rebate Program

• Elements of a Supplier Annual Program

Set Up Program Qualifiers  
Important: This section is not applicable to Supplier Annual Programs because there is no integration with Fusion
Pricing. Qualifiers are attributes used to define eligibility in the form of program, market, and product rules in a channel
program. Only those qualifiers that are part of the program type can be selected in the program. That is, you have to
select the qualifiers during program type creation, and only these are available for selection in the programs. If you need
a new qualifier type to be available in the program, you must first add that qualifier in the corresponding program type.

Set Up Custom Qualifier for Market and Program Rules
Prior to adding a custom qualifier to a program type, it must be defined in the lookup ORA_CJM_QUALIFIER_TYPE and
should be enabled. It should also be available in the Channel Program Eligibility matrix class.

Related Topics
• Manage Channel Lookups

• Manage Your Integration

How to Add User-Defined Attributes to Items  
You can create user-defined attributes that can be used in the program product rules to determine the price or discount.
You must set it up as an item extensible attributes in an item class to represent details about the item.
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Create an Attribute Group and Attributes
1. With roles allowing access, in the Setup and Maintenance work area, go to:

◦ Offering: Product Management

◦ Functional Area: Items

◦ Task: Manage Item Attribute Groups and Attributes

2. In the Manage Attribute Groups page, from the Actions drop-down button, click Create to create an attribute
group.

3. In the Create Attribute Group page, enter the details for the following fields:

Field Description

Display Name
 

Enter a display name for the attribute group. For example, Item Color.
 

Internal Name
 

Enter an internal reference name. For example, Item Color Specification.
 

API Name
 

Automatically populated, edit if required.
 

Behavior
 

Select Single Row from the list.
 

4. On the Context Usages tab, select Create from the Actions drop-down list.
5. Select Item from the Name list as the context usage. Click Save. This creates the attributes group with context

usage as Item.
6. In the Edit Attributes page, in the Attributes section, click Create from the Actions drop-down button.
7. In the Create Attribute page, enter the details for the following required fields:

Field Description

Display Name
 

Enter a display name for the attribute. For example, Color.
 

Internal Name
 

Enter an internal reference name. For example, Product Color.
 

API Name
 

Automatically populated, edit if required.
 

Data Type
 

Select the data type of the attribute. For example, for color select Character.
 

Table Column
 

Automatically populated, edit if required.
 

8. Select a Value Set from the list, or create one by clicking Create Value Set.
If you're creating a value set, in the Create Value Set page, enter the details for the following fields:
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a. Enter a code for your value set. For example, PRODUCT_COLOR.
b. Enter a description to for the value set. For example, Value set for product colors.
c. Select Product Model from the Module list.
d. Select a Validation Type. You must select Independent or Format Only for each item extensible attribute

that you plan to use with Pricing.
e. Select the data type of your value set from the Value Data Type list. You must select either Number or

Character for the data type. Other data types aren't supported.
f. In the Definition section, enter the required details and save.

g. Click Manage Values to add the values for the value set.
h. In the Manage Values page, Click Create from the Actions drop-down button.
i. Add the values you want for your value set. For example, different product colors like blue, red, and so on.
j. Click Save and Close to navigate back to the Create Attributes page.

9. In the Create Attributes page, the Display Properties are now populated. You can edit this if required.

a. Prompt: The prompt for your attribute. For example, Color.
b. Display Type: How the values should be displayed. For example, List of Values.

10. Click Save and Close. The attribute for the attribute group is saved, and you're now on the Edit Attribute Group
page. You can create more attributes for this group if required. Note down the flexfield code and save.

Add the Attribute Group to an Item Class
1. With roles allowing access, in the Setup and Maintenance work area, go to:

◦ Offering: Product Management

◦ Functional Area: Items

◦ Task: Manage Item Classes

2. In the Manage Item Classes page, select the Item Class under which you want to add the attribute group and its
attributes as extensible attributes. You can select the Root Item Class to add the attribute group to all the item
classes.

3. In the Edit Item Class page, click Pages and Attribute Groups tab. On the Attribute Groups subtab, from the
Actions drop-down button, click Select and Add.

4. Select your attribute group and click Apply, then click OK. Click Save to save the updates to the item class.
5. Navigate to the Pages subtab. Select Pricing Item Attributes. If it's not available, add it. See the Add Your

Attribute Group to An Item Class section in the Add Your Own Attributes to Items in Pricing topic from the
Pricing Administration guide.

6. In the Attributes Group: Pricing Item Attributes section, click Select and Add from the Actions drop-down
button. Select your attribute group. Click Apply, then OK. Click Save to save the updates to the item class.

7. Navigate to the Functional Item Pages subtab and ensure that the following is available:

◦ Functional Area: Pricing

◦ Usage: Pricing

◦ Item page: Pricing Item Attributes

The attribute group is added to the item classes.

139



SCM Cloud
Implementing Channel Revenue Management

Chapter 8
Set Up Buy Side Programs

Deploy the Item Extensible Flexfield
After associating the attribute groups to the item classes, you must deploy the extensible flexfield.

1. With roles allowing access, in the Setup and Maintenance work area, go to:

◦ Offering: Product Management

◦ Functional Area: Items

◦ Task: Deploy Item Extensible Flexfields

2. Search for your flexfield code. Select it and click Deploy Flexfield.
3. After successful deployment, you must sign out and sign back in to view the EFF configuration on the item.

Edit the Pricing Matrix Class
You must now add the item attribute to the Pricing Matrix Class.

1. With roles allowing access, from the Navigator, select Pricing Administration. In the Overview page, open the
Tasks panel and select Manage Matrix Classes.

2. In the Manage Matrix Classes pages, select Channel Program Eligibility.
3. In the Edit Matrix Classes page, click Add Row from the Actions drop-down list. This creates a new dimension

to Channel Program Eligibility.
4. In the Name field, enter a name for your dimension. For example, Color.
5. In the Source Code Name field, enter a code concatenated with the operator abbreviation. The supported

operator abbreviations are E for equal to, NE for not equal to, EGT for greater than or equal to, and ELT for less
than or equal to. For example, COLOR_E.

6. In the Comparison field, choose the comparison operator. For example, =.
7. From the Compare to Attribute drop-down list, select one of the following. You must select the same data type

that you specified when you set up the attribute on the Manage Item Attribute Groups and Attributes page. If
the data types don't match, then the eligibility rules won't work correctly.

◦ itemExtensibleAttribute.VarcharValue

◦ itemExtensibleAttribute.NumberValue

8. Leave the Required check box deselected. Select the Allow Null and Null Is Wildcard check boxes.
9. From the Domain list, select:

◦ Domain Type: Item Extensible Attribute

◦ Data Type: Select the same data type that you specified when you set up the attribute on the Manage
Item Attribute Groups and Attributes page

◦ Attribute: Select the attribute you created in the Manage Item Attribute Groups and Attributes page.

◦ Attribute Group Identifier: ItemExtensibleAttribute.AttributeGroupCode (default value)

◦ Attribute Identifier: ItemExtensibleAttribute.AttributeCode (default value)

10. Leave the Default Value field blank as it's not used. Click OK.
11. Click Save.

Update Channel Lookup
1. In the Setup and Maintenance work area, go to:

◦ Offering: Order Management/Procurement
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◦ Functional Area: Channel Revenue Management/Supplier Incentives

◦ Task: Manage Channel Lookups

2. Search for the extensible lookup: ORA_ CJM_ITEM_LEVEL and add a new lookup code.
3. In the Lookup Code field, enter the same name as the Source Code Name used for Channel Program Eligibility

matrix class (without the concatenated operator). For example, if the Source Code Name in the matrix class is
COLOR_E, then enter COLOR as the lookup code.

4. Enter values for the remaining fields and click Save.

Note:  For more information about creating extensible flexfields, see User Defined Attribute Groups and Attributes
(Extensible Flexfields-EFFs) Setup White Paper (Doc ID 1992317.1) on My Oracle Support at https://support.oracle.com.

Related Topics
• Item Attribute Groups and Attributes

• Product Value Sets: Explained

• Item Classes

• Add Your Own Attributes to Items in Pricing

• Item Specifications and Attributes

Set Up Program Types  

Predefined Program Templates  
Predefined templates are templates of industry defined channel programs and flows supported by Channel Revenue
Management.

You can select a predefined template while creating a program type. Types of templates supported:

• Supplier Rebate

• Supplier Annual Program

• Supplier Ship and Debit (from the standpoint of the distributor managing programs from their suppliers)

Program Code Numbering
The program code is made up of a prefix and a single sequence. Prefix is defined by the program type. The predefined
prefix for Supplier Ship and Debit program template is SSD, and for Supplier Rebate is REB. A single sequence generates
numbers from a given starting number stored in the database. This single sequence is across all programs.

Note:  A prefix can be shared across multiple program types if so determined.

For example, consider two program types prefixed with ABC and DEF:

• 1st program code is ABC1000

• 2nd program code is DEF1001

• 3rd program code is ABC1002
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Manage Program Types  
Program types incorporate channel processing guidelines such as defining how a program is created, applied, and
processed.

Program types control and simplify program creation. For example, within a predefined program template such as
Supplier Ship and Debit, a distributor can configure different flavors of supplier ship and debit as different program
types.

You can create and update program types from the Manage Program Types page.

1. In the Setup and Maintenance work area, go to:

◦ Offering: Order Management/Procurement

◦ Functional Area: Channel Revenue Management/Supplier Incentives

◦ Task: Manage Channel Program Types

2. On the Manage Channel Program Types page you can create and update your program types. Click the Create
icon. The Create Program Type page opens.

Create Supplier Rebate Program Type
1. From the Based on Predefined Program Template drop-down list, select Supplier Rebate.
2. Enter a name for your program type in the Name field.
3. Enter a code for your program type in the Program Type Code field. This code:

◦ Acts as a unique identifier for the program type, and is required.

◦ Is used to identify and synchronize setup data across multiple environments.

◦ Is not available to users in the transactional pages.

4. Update the Prefix field if required. This value acts as the prefix for your Program Code while creating a
program. The predefined prefix for the supplier rebate template is REB.
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5. On the Qualifiers tab:
a. Select the applicable date contexts for your programs. From the Qualify Programs Based On drop-down

list select either:
- Purchase Order Date: If you select this, the channel programs created with this program type are

qualified by matching them against the date on the PO.
- Receipt Transaction Date: If you select this, the programs are qualified by matching them against

the transaction date in the receiving transaction.
- Requested Delivery Date: If you select this, the programs are qualified by matching them against

the requested delivery date on the order line.
- Requested Ship Date: If you select this, the programs are qualified by matching them against the

requested ship date on the order line.
- Shipped Date: If you select this, the programs are qualified by matching them against the shipped

date on the receipt.
- Supplier Invoice Date: If you select this, the programs are qualified by matching them against the

invoice date on the supplier invoice.

Note:  Supplier Invoice Date doesn't apply to supplier rebates via the direct integration to
inbound receiving transactions.

b. Add the qualifiers you want for your program and market rules. The values in the drop-down list are from
the lookup ORA_CJM_SUP_REBATE_QUAL.

6. On the Optional Defaulting tab:
Specify the defaults for your programs.

◦ Default Program Currency To: Select the default currency for your program from the drop-down list. For
example, US Dollar.

◦ Default Discount Type for Product Rules To: Select the default discount type for your product rule from
the drop-down list. Available values are Amount and Percent.

7. Click Save. The program type is created in the Draft status.

Create Supplier Annual Program Type
1. From the Based on Predefined Program Template drop-down list, select Supplier Annual Program.
2. Enter a name for your program type in the Name field.
3. Enter a code for your program type in the Program Type Code field. This code:

◦ Acts as a unique identifier for the program type, and is required.

◦ Is used to identify and synchronize setup data across multiple environments.

◦ Is not available to users in the transactional pages.

4. Update the Prefix field if required. This value acts as the prefix for your Program Code while creating a
program. The predefined prefix for the supplier annual program template is ANN.

5. On the Optional Defaulting tab:
Specify the defaults for your programs.

◦ Default Program Currency To: Select the default currency for your program from the drop-down list. For
example, US Dollar.

◦ Default Calculation Method: Select the default calculation method for your program. Available values
are Retrospective and Stepped.
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◦ Default Tier Type: Select the default tier type for your volume rule. Available values are Purchases and
Quantity.

6. Click Save. The program type is created in the Draft status.

Create Supplier Ship and Debit Program Type
1. From the Based on Predefined Program Template drop-down list, select Supplier Ship and Debit.
2. Enter a name for your program type in the Name field.
3. Enter a code for your program type in the Program Type Code field. This code:

◦ Acts as a unique identifier for the program type, and is required.

◦ Is used to identify and synchronize setup data across multiple environments.

◦ Is not available to users in the transactional pages.
4. Update the Prefix field if required. This value acts as the prefix for your Program Code while creating a

program. The predefined prefix for the supplier ship and debit template is SSD.
5. On the Qualifiers tab:

a. Select the applicable date contexts for your programs. From the Qualify Programs Based On drop-down
list select either:

- Ordered Date: If you select this, the channel programs created with this program type are qualified
by matching them against the ordered date on the order.

- Requested Ship Date: If you select this, the channel programs created with this program type are
qualified by matching them against the requested ship date on the order line.

b. Add the qualifiers you want for your program and market rules. The values in the drop-down list are from
the lookup ORA_ CJM_QUALIFIER_ TYPE.

6. On the Pricing Integration tab:
◦ Specify the pricing charge definitions. Pricing uses these to determine the accrual for an item.

i. From the Charge Type drop-down list, select the type of charge for the items in your program. For
example, sale, service, or freight.

ii. From the Charge Subtype drop-down list, select the subtype for the items in your program. This
provides additional details about the charge. For example, the charge is a price or a fee.

◦ Specify the pricing basis for your discount types.
i. From the Basis for Percent drop-down list, select the pricing basis for a discount based on a

percentage.
ii. From the Basis for New Cost drop-down list, select the pricing basis for a discount based on a new

cost.

Note:   You must select the pricing basis if your product rule discount is based on New Cost or Percent.

7. On the Order Management Integration tab:
Specify the Order Management action for sales orders created with programs of this program type.

◦ Apply Program Manually To Order: If you select this check box, the program won't be automatically
applied to the eligible sales orders. You have to manually add them from the Manage Incentives dialog
box.

◦ Prevent User from Declining a Program: If you select this check box, you can't remove the program
from the sales order after it gets applied.

8. On the Optional Defaulting tab:
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Specify the defaults for your programs.

◦ Default Program Currency To: Select the default currency for your program from the drop-down list. For
example, US Dollar.

◦ Default Discount Type for Product Rules To: Select the default discount type for your product rule from
the drop-down list. Available values are Amount, New Cost, and Percent.

9. Click Save. The program type is created in the Draft status.

Activate Program Types
To activate a program type, with roles allowing access, open your program type from the Manage Program Types page.
Click Activate on the Actions drop-down button. A program type in the draft status can either be activated or deleted.

An active program type can be made inactive. Open the program type and from the Actions drop-down button, click
Inactivate. The status changes to Closed for New Programs.

Note:  You can delete a program type after its activation only if there aren't any programs associated with the program
type.

Related Topics
• Manage Pricing Charge Definitions

Program Type Statuses  
Use program type statuses to monitor your program types. You can update them from the Manage Program Types
page. Statuses for program type are defined in the lookup ORA_CJM_PROGRAM_TYPE_STATUS. This table shows
supported program type statuses.

This table shows supported program type statuses.

Status Description

Draft
 

The program type has been created and not activated.
 

Active
 

The program type has been activated for use. Only active program types can be used to create a
program.
 

Closed for New Programs
 

An active program type can be closed for use in additional programs. These are no longer eligible for
use in new programs.
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This figure shows the system status transitions for program types.
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9  Set Up Adjustments

Overview of Adjustment Types  
Before you can create manual adjustments, you must set up adjustment types. Each adjustment must be classified by
an adjustment type for processing to the checkbook and determining what prefix to use in the adjustment number.

The administration of adjustment types is partitioned by reference set. Within this setup, the predefined adjustment
type defines how the adjustment type affects the checkbook. For example, the missed supplier accrual adjustments
would be based on the Increase Earned predefined adjustment type, because such adjustments would increase
earned accruals in the checkbook. Supplier rejection adjustments would be based on the Decrease Earned predefined
adjustment type, because such adjustments would decrease earned accruals in the checkbook. In addition, you can
specify a prefix that will be used in generating adjustment numbers for each adjustment type.

Note:  Adjustment types can share the same prefix or they can have different prefixes.

Set Up Adjustment Numbering
Adjustment numbers consist of a prefix and a single sequence. The prefix is defined in the adjustment type setup. A
single sequence generates numbers from a given starting number that's stored in the database and the single sequence
is used across all adjustments. The sequence starts at 1000.

Most implementations choose to have the same prefix for adjustment types. However, we also support different
prefixes by adjustment type. For example, let's assume two adjustment types prefixed with ABC and DEF respectively:

• For the first adjustment number, the sequence is ABC1000.

• For the second adjustment number, the sequence is DEF1001.

• For the third adjustment number, the sequence is ABC1002.

In this example, the ABC and DEF prefixes were defined in the adjustment type setup, which can be up to any five
alphanumeric characters.

Related Topics
• Reference Data Sets and Sharing Methods

Manage Adjustment Types  
You can create and update adjustment types from the Manage Adjustment Types page.

1. In the Setup and Maintenance work area, go to:

◦ Offering: Order Management/Procurement

◦ Functional Area: Channel Revenue Management/Supplier Incentives
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◦ Task: Manage Channel Adjustment Types

2. On the Manage Adjustment Types page, select the Add icon to create a new adjustment type.
3. Enter a code for your adjustment type in the Adjustment Type Code field. This code:

◦ Acts as a unique identifier for the adjustment type, and is required.

◦ Is used to identify and synchronize setup data across multiple environments.

◦ Is not available to users in the transactional pages.

4. From the Set Name list, select the set for which you want to create the adjustment type.
5. Enter the name of your adjustment type in the Adjustment Type field.
6. From the Predefined Adjustment Type drop-down list, select either Decrease Earned or Increased Earned.

Predefined adjustment types are defined in the lookup ORA_CJM_ADJUSTMENT_TYPE.
7. Enter the prefix you want for your adjustments in the Prefix field.
8. Enter values for the remaining fields, if required.
9. Create adjustment reasons for your adjustment type in the Adjustment Reasons section. Click Save.

Note:  Each adjustment type can have multiple adjustment reasons.

Manage Adjustment Reasons  
These are the reasons for making the adjustments, which you can set up based on your business needs.

You can create and update adjustment reasons for each adjustment type in the Adjustment Reasons section on the
Manage Adjustment Types page.

1. Select the adjustment type for which you want to create adjustment reasons. Scroll down to the Adjustment
Reason section.

2. Select the Add icon to create a new adjustment type.
3. Enter a code for your adjustment reason in the Adjustment Reason Code field. This code:

◦ Acts as a unique identifier for the adjustment reason, and is required.

◦ Is used to identify and synchronize setup data across multiple environments.

◦ Is not available to users in the transactional pages.

4. Enter the adjustment reason in the Adjustment Reason field.
5. These fields are optional:

◦ Description: Add a description to better document your reason.

◦ Enable check box: If this check box is selected, the reason becomes available for selection in the Manage
Adjustments page while creating a manual adjustment with the corresponding adjustment type.

◦ Default check box: If this check box is selected, the reason becomes the default for the adjustment type,
and is automatically selected as the adjustment reason while creating a manual adjustment with the
corresponding adjustment type.

6. Click Save.
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10  Set Up Customer Claims

Overview of Customer Claims  
Here you can learn about and complete the setup steps that you must perform before you can start processing claims.

Deduction claims are derived from Receivables and you can create manual claims.

You must complete the following setups:

1. Claim Types
2. Claim Reasons
3. Claim Sources and Settlement Methods

The claim source represents how and where the claim was created. The settlement methods represent type of
Receivables transactions that are supported for a specific claim source. A claim can be settled with multiple settlement
methods.

The following table displays the Receivables action that creates a specific claim source and all the supported settlement
methods for each claim source. Configure the settlement methods for each claim source as needed.

Receivables Action Claim Source Settlement Method Additional Settlement Methods

Create Claim Investigation Deduction • Credit Memo on Account

◦ Nonpromotional

◦ Promotional

• Manual Write Off

• Open Credit Memos

• Open Overpayments

• Automatic Write Off

Create Claim Investigation Overpayment Invoice Open Deductions

Create Channel Revenue Claim Invoice Deduction • Credit Memo on Account

◦ Nonpromotional

◦ Promotional

• Credit Memo on Invoice

◦ Nonpromotional

• Chargeback

• Manual Write Off

• Open Credit Memos

• Open Overpayments

• Automatic Write Off

Create Channel Revenue Claim Invoice Overpayment Invoice Open Deductions

Not Applicable Manual Claim • Credit Memo on Account

◦ Nonpromotional

◦ Promotional

None
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Manage Claim Types  
Here you'll understand how to manage customer claim types.

Channel Revenue Management has configurable claim types. The administration of claim types is partitioned by
reference sets. You can use claim types to analyze claims and identify possible business process improvements.

1. In the Setup and Maintenance work area, go to:

◦ Offering: Order Management/Procurement

◦ Functional Area: Channel Revenue Management

◦ Task: Manage Channel Claim Types

2. On the Manage Claim Types page, you can create and update your claim types.
3. Click the Add icon to create a new claim type. Enter a code for your claim type in the Claim Type Code field.

This code:

◦ Acts as a unique identifier for the claim type.

◦ Is required to synchronize the setup data across multiple environments.

◦ Is not available to users in the transactional pages.

4. From the Set Name list, select the set for which you want to create the claim type.
5. Select the Sell Side check box to select the channel flow for which you want the claim type enabled. You can't

update this once saved.
6. Enter the name of your claim type in the Claim Type field.
7. Enter values for the remaining fields, if required.

◦ Description: Add a description for your claim type.

◦ From Date and To Date: Add a date range during which your claim type is valid.

8. Select the following value to map your claim type with a transaction type in Receivables.

◦ Mapped Transaction Type for Credit Memo: Select Credit Memo.

◦ Mapped Transaction Type for Invoice: Select Invoice.

◦ Mapped Transaction Type for Chargeback: Select Chargeback-NES

9. Select the desired receivables activity to map your claim type and business unit for a receipt write off and a
write-off adjustment settlement transaction in AR.

10. Click Save.

Manage Claim Reasons  
Here you'll understand how to manage customer claim reasons.

Channel Revenue Management has configurable claim reasons. The administration of claim reasons is partitioned by
reference set. You can use claim reasons to analyze claims and identify possible business process improvements.

1. In the Setup and Maintenance work area, go to:

◦ Offering: Order Management/Procurement

◦ Functional Area: Channel Revenue Management
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◦ Task: Manage Channel Claim Reasons

2. On the Manage Claim Reasons page, you can create and update your claim reasons.
3. Click the Add icon to create a new claim reason.
4. Enter a code for your claim reason in the Claim Reason Code field. This code:

◦ Acts as a unique identifier for the claim reason, and is required.

◦ Is used to identify and synchronize the setup data across multiple environments.

◦ Is not available to users in the transactional pages.

5. From the Set Name list, select the set for which you want to create the claim reason.
6. Select the Sell Side check boxes to select the channel flow for which you want the claim reason enabled. You

can't update this once saved.
7. Enter the name of your claim reason in the Claim Reason field.
8. Enter values for the remaining fields, if required.

◦ Description: Add a description for your claim reason.

◦ From Date and To Date: Add a date range during which your claim reason is valid.

9. For Deductions and Settlement, select the following values to map your claim reason to Receivables:

◦ Mapped Credit Memo Reason: Select the Receivables credit memo reason that should be used for
deductions settled with credit memos, when using this claim reason, for example Damaged Product.

◦ Mapped Adjustment Reason: Select the Receivables adjustment reason that must be applied to
deduction write-offs, for example Offset.

◦ Mapped Chargeback Reason: Select the Receivables Chargeback Reason that should be used for
deductions settled with chargebacks, when using this claim reason, for example Offset.

10. Click Save. You can't delete a claim reason after saving. You can only update it.

Manage Customer Claim Sources and Settlement
Methods  
When a customer claim is settled, Receviables transactions are created based on settlement methods.

You can configure the claim sources and the settlement methods they use for processing from the Manage Claim
Sources page. The administration of claim sources is partitioned by reference sets.

1. In the Setup and Maintenance work area, go to:

◦ Offering: Order Management

◦ Functional Area: Channel Revenue Management

◦ Task: Manage Channel Claim Sources

2. Click the Add icon to create a new claim source.
3. From the Set Name list, select the set for which you want to create the claim source.
4. From the Claim Source drop-down list, select your claim source. The values are from the lookup

ORA_CJM_CLAIM_SOURCE.
5. Select the Enable check box if you want the claim source to be available for your claims.
6. Enter the prefix you want for each of your claim source in the Prefix field. The value is used in as the prefix

along with the generated claim number for each claim belonging to this claim source.
7. Enter values for the remaining fields, if required.
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◦ Description: Add a description for your claim source.

◦ Default Claim Type: Select the claim type you want as the default for your claim source.

◦ Default Claim Reason: Select the claim reason you want as the default for your claim source.

8. Select the settlement methods for your claim source from the Available Settlement Methods section. You can
set a settlement method as the default for the claim source.

◦ Claim settlement methods are defined in the lookup ORA_CJM_SETTLEMENT_METHOD.

◦ The application that supports a predefined settlement method is defined in the lookup
ORA_CJM_CLAIM_ACCOUNT_FOR.

Claim Source Supported Settlement Method Accounting For

Deduction Credit Memo – On Account Receivables

152



SCM Cloud
Implementing Channel Revenue Management

Chapter 11
Set Up Supplier Claims

11  Set Up Supplier Claims

Overview of Supplier Claims  
Here you can learn about and complete the setup steps that you must perform before you can generate claims.

You must complete the following setups:

1. Claim Types
2. Claim Reasons
3. Claim Sources and Settlement Methods

Set Up Claims Numbering
Claim numbers consist of a prefix and a single sequence. The prefix is defined in the claim source setup. A single
sequence generates numbers from a given starting number that's stored in the database and the single sequence is
used across all claims. The sequence starts at 1000.

Implementations may choose to have the same or different prefix across claim sources. Consult the business owners to
help make this decision. For example, let's assume two claim sources prefixed with ABC and DEF respectively:

• For the first claim number, the sequence is ABC1000.

• For the second claim number, the sequence is DEF1001.

• For the third claim number, the sequence is ABC1002.

In this example, the ABC and DEF prefixes were defined in the claim source setup, which can be up to any five
alphanumeric characters.

Set Up Supplier Claim Extract  
Users must have roles allowing them to generate supplier claims to also generate and view claim extracts.

• The predefined Oracle BI Publisher templates are located under Catalog > Shared Folders > Supply Chain
Management > Channel Revenue Management > Claims.

This table shows the template names for claim extracts from various claims.

Template Name Claim

Claim Detail Extract Report
 

Supplier ship and debit claims
 

Supplier Annual Claim Detail Extract
Report
 

Supplier annual program claims
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Template Name Claim

Supplier Rebate Claim Detail Extract
Report
 

Supplier rebate claims
 

• You can also decide on the columns you want included in the export file, and create a BI Publisher template for
it.

• The default format for date is YYYY/MM/DD.

• The default format for time stamp is YYYY/MM/DD HH24:MI:SS.

Related Topics
• Generate Claim Extract

Manage Supplier Claim Types  
Channel Revenue Management has configurable claim types. The administration of claim types is partitioned by
reference sets. You can use claim types to analyze claims and identify possible business process improvements.

1. In the Setup and Maintenance work area, go to:

◦ Offering: Order Management/Procurement

◦ Functional Area: Channel Revenue Management/Supplier Incentives

◦ Task: Manage Channel Claim Types

2. On the Manage Claim Types page, you can create and update your claim types.
3. Click the Add icon to create a new claim type.
4. Enter a code for your claim type in the Claim Type Code field. This code:

◦ Acts as a unique identifier for the claim type, and is required.

◦ Is used to identify and synchronize the setup data across multiple environments.

◦ Is not available to users in the transactional pages.

5. From the Set Name list, select the set for which you want to create the claim type.
6. Use the Buy Side and Sell Side check boxes to select the channel flows for which you want the claim type

enabled. You can't update this once saved.
7. Enter the name of your claim type in the Claim Type field.
8. Enter values for the remaining fields, if required.

◦ Description: Add a description for your claim type.

◦ From Date and To Date: Add a date range during which your claim type is valid.

9. For Deductions and Settlement, select the following values to map your claim type with a transaction type in
Receivables.

◦ Mapped Transaction Type for Credit Memo: Receivables transaction type to be used with the claim
type, for deductions that are settled with credit memos.
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◦ Mapped Transaction Type for Invoice: Receivables transaction type to be used with the claim type for
overpayments that are settled using invoices.

◦ Mapped Transaction Type for Chargeback: Receivables transaction type to be used with the claim type
for deductions that are settled with a chargeback.

10. For Deductions and Settlement, select the desired receivables activity to map your claim type and business unit
for a receipt write off and write-off adjustment settlement transaction in AR.

11. Click Save.

Manage Supplier Claim Reasons  
Channel Revenue Management has configurable claim reasons. The administration of claim reasons is partitioned by
reference set. You can use claim reasons to analyze claims and identify possible business process improvements.

1. In the Setup and Maintenance work area, go to:

◦ Offering: Order Management/Procurement

◦ Functional Area: Channel Revenue Management/Supplier Incentives

◦ Task: Manage Channel Claim Reasons

2. On the Manage Claim Reasons page, you can create and update your claim reasons.
3. Click the Add icon to create a new claim reason.
4. Enter a code for your claim reason in the Claim Reason Code field. This code:

◦ Acts as a unique identifier for the claim reason, and is required.

◦ Is used to identify and synchronize the setup data across multiple environments.

◦ Is not available to users in the transactional pages.

5. From the Set Name list, select the set for which you want to create the claim reason.
6. Use the Buy Side and Sell Side check boxes to select the channel flows for which you want the claim reason

enabled. You can't update this once saved.
7. Enter the name of your claim reason in the Claim Reason field.
8. Enter values for the remaining fields, if required.

◦ Description: Add a description for your claim reason.

◦ From Date and To Date: Add a date range during which your claim reason is valid.

9. For Deductions and Settlement, select the following values to map your claim reason to Receivables:

◦ Mapped Credit Memo Reason: Select the Receivables credit memo reason that should be used for
deductions settled with credit memos, when using this claim reason.

◦ Mapped Adjustment Reason: Select the Receivables adjustment reason that must be applied to
deduction write-offs.

◦ Mapped Chargeback Reason: Select the Receivables Chargeback Reason that should be used for
deductions settled with chargebacks, when using this claim reason.

10. Click Save. You can't delete a claim reason after saving. You can only update it.
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Manage Supplier Claim Sources and Settlement Methods
 
Based on the application that generates the claim, and the claim amount, the claim class is determined.

The claim class along with the reference set determines the claim source for any claim. When this claim is interfaced to
the Financials cloud to collect or pay, it uses the associated settlement method to do so.

You can configure the claim sources and the settlement methods they use for processing from the Manage Claim
Sources page. The administration of claim sources is partitioned by reference sets.

1. In the Setup and Maintenance work area, go to:

◦ Offering: Order Management

◦ Functional Area: Channel Revenue Management

◦ Task: Manage Channel Claim Sources

2. Click the Add icon to create a new claim source.
3. From the Set Name list, select the set for which you want to create the claim source.
4. From the Claim Source drop-down list, select your claim source. The values are from the lookup

ORA_CJM_CLAIM_SOURCE.
5. Select the Enable check box if you want the claim source to be available for your claims.
6. Claim classes are derived based on the claim source. Claim classes are defined in the lookup

ORA_CJM_CLAIM_CLASS.

This table shows the mapping between claim source and claim class.

Flow Claim Source Claim Class

Deductions and Settlement
 

Deduction
 

Deduction
 

Deductions and Settlement
 

Invoice Deduction
 

Deduction
 

Deductions and Settlement
 

Invoice Overpayment
 

Overpayment
 

Deductions and Settlement
 

Manual Claim
 

Claim
 

Deductions and Settlement
 

Overpayment
 

Overpayment
 

Supplier Annual Program
 

Supplier Annual Program - Claim
 

Claim
 

Supplier Annual Program
 

Supplier Annual Program - Debit Claim
 

Debit Claim
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Flow Claim Source Claim Class

Supplier Rebate
 

Supplier Rebate - Claim
 

Claim
 

Supplier Rebate
 

Supplier Rebate - Debit Claim
 

Debit Claim
 

Supplier Ship and Debit
 

Supplier Ship and Debit - Claim
 

Claim
 
When a supplier claim is totaled, a positive
total is assigned as Claim
 

Supplier Ship and Debit
 

Supplier Ship and Debit - Debit Claim
 

Debit Claim
 
When a supplier claim is totaled, a negative
total is assigned as Debit Claim.
 

7. Enter the prefix you want for each of your claim source in the Prefix field. The value is used in as the prefix
along with the generated claim number for each claim belonging to this claim source.

8. Enter values for the remaining fields, if required.

◦ Description: Add a description for your claim source.

◦ Default Claim Type: Select the claim type you want as the default for your claim source.

◦ Default Claim Reason: Select the claim reason you want as the default for your claim source.

9. Select the settlement methods for your claim source from the Available Settlement Methods section. You can
set a settlement method as the default for the claim source.

◦ Claim settlement methods are defined in the lookup ORA_CJM_SETTLEMENT_METHOD.

◦ The application that supports a predefined settlement method is defined in the lookup
ORA_CJM_CLAIM_ACCOUNT_FOR.

Claim Source Supported Settlement Methods Accounting For

Deduction
 

Credit Memo - On Account
 
Open Credit Memo
 
Open Overpayment
 
Write-Off
 

Receivables
 

Invoice Deduction
 

Credit Memo - On Account
 
Credit Memo - On Invoice
 
Open Credit Memo

Receivables
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Claim Source Supported Settlement Methods Accounting For

 
Open Overpayment
 
Write-Off
 
Chargebacks
 

Invoice Overpayment
 

Invoice
 
Open Deduction
 

Receivables
 

Manual Claim
 

Credit Memo - On Account
 

Receivables
 

Overpayment
 

Invoice
 
Open Deduction
 

Receivables
 

Supplier Annual Program - Claim
 

AP Debit
 

Payables
 

Supplier Annual Program - Debit Claim
 

AP Default Payment
 

Payables
 

Supplier Rebate - Claim
 

AP Debit
 

Payables
 

Supplier Rebate - Debit Claim
 

AP Default Payment
 

Payables
 

Supplier Ship and Debit - Claim
 

AP Debit
 

Payables
 

Supplier Ship and Debit - Debit Claim
 

AP Default Payment
 

Payables
 

10. Click Save.
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12  Set Up Channel Revenue Flows

Manage Channel Lookups  
Here you can view, manage, and edit the lookups for Channel Revenue Management.

1. In the Setup and Maintenance work area, go to:

◦ Offering: Order Management/Procurement

◦ Functional Area: Channel Revenue Management/Supplier Incentives

◦ Task: Manage Channel Lookups

2. You can search for and manage the Channel Revenue Management lookups from the Manage Channel
Lookups page.

List of Channel Lookups
This table lists the lookups and their codes available for Channel Revenue Management.

Note:  You can configure lookups with Lookup Configuration Level: Extensible or User.

Lookup Type Meaning Description Lookup Configuration
Level

Lookup Codes

ORA_CJM_ACCRUAL_ADJ_
FOR
 

Accrual Adjustment For
 

Indicates that the accrual
adjustment is done for the
supplier.
 

System
 

SUPPLIER
 
CUSTOMER
 
PARTY
 

ORA_CJM_ACCRUAL_
STATUS
 

Accrual Status for Eligible
Line
 

Indicates whether accrual
has been computed for the
eligible line.
 

System
 

ORA_CJM_ACCRUAL_
PENDING
 
ORA_CJM_ACCRUED
 
ORA_CJM_ERROR
 

ORA_CJM_ACCRUAL_TYPE
 

Accrual Type
 

Indicates that the accrual is
created for the supplier.
 

System
 

SUPPLIER
 

ORA_CJM_ADJUSTMENT_
TYPE
 

Manual Adjustment Type
 

List of manual adjustment
types supported in the
channel. For example,
 Increase Earned, or
Decrease Earned.
 

System
 

DECREASE_EARNED
 
INCREASE_EARNED
 
TIER_INCREASE_EARNED
 
TIER_DECREASE_EARNED
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Lookup Type Meaning Description Lookup Configuration
Level

Lookup Codes

ORA_CJM_ANP_
CHECKBOOK_GROUP_BY
 

Grouping Criteria for
Accruals for Annual
Program
 

Indicates the attribute used
to summarize the accruals
in the annual program
checkbook.
 

System
 

ORA_CJM_CATEGORY_OR_
ITEM
 
ORA_CJM_ITEM_IN_
CATEGORY
 
ORA_CJM_PERIOD
 

ORA_CJM_ASSOCIATION_
TYPE
 

Claim Association Type
 

Indicates the level at which
association is performed.
For example, Program,
 Order, Product or Invoice.
 

System
 

PROGRAM
 

ORA_CJM_BATCH_DATA_
SOURCE
 

Batch Data Source Type
 

Indicates the transaction
type used to categorize
the transaction data in the
batch.
 

System
 

ORA_RECEIVING_TRX
 
ORA_SALES_ORDER
 
ORA_SUPPLIER_INVOICE_
CSV
 
ORA_SALES_ORDER_CSV
 

ORA_CJM_BATCH_LINE_
STATUS
 

Batch Line Status
 

List of statuses supported
in the channel batch line.
 

System
 

ORA_VALIDATED
 
ORA_PROCESSED
 

ORA_CJM_BATCH_
SOURCE_TYPE
 

Source for Load
Transactions
 

Indicates the source used
in the Load Transactions
scheduled process.
 

System
 

RECEIVING_TRX
 

ORA_CJM_BATCH_STATUS
 

Batch Status
 

List of statuses supported
in the channel batch.
 

System
 

ORA_OPEN
 
ORA_VALIDATED
 
ORA_PROCESSED
 

ORA_CJM_BUDGET_
CATEGORY

Channel Budget Category List of Budget categories. User SALES
 
VENDOR_REBATE
 

ORA_CJM_CHECKBOOK_
GROUP_BY
 

Grouping Criteria for
Accruals
 

Indicates the attribute used
to summarize the accruals
in the supplier program
checkbook.
 

System
 

ORA_CJM_ITEM
 
ORA_CJM_PO
 
ORA_CJM_BILL_TO_
LOCATION
 
ORA_CJM_SHIP_TO_
LOCATION
 

ORA_CJM_CLAIM_
ACCOUNTING_FOR
 

Claim Accounting For
 

Indicates whether the claim
accounting is for Payables
or Receivables.

System
 

PAYABLES
 
RECEIVABLES
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Lookup Type Meaning Description Lookup Configuration
Level

Lookup Codes

  

ORA_CJM_CLAIM_CLASS
 

Channel Claim Class
 

List of claim classes
supported in the channel.
 

System
 

CLAIM
 
DEBIT_CLAIM
 
DEDUCTION
 
OVERPAYMENT
 

ORA_CJM_CLAIM_FOR
 

Claim For
 

Indicates that the claim is
created for the supplier.
 

System
 

SUPPLIER
 

ORA_CJM_CLAIM_LINE_
TYPE
 

Claim Line Type
 

List of claim line types
supported in the channel.
 

System
 

ITEM
 
MEMO_LINE
 
TAX
 
FREIGHT
 
ORA_DESCRIPTION
 

ORA_CJM_CLAIM_PAY_
OVER_EARNING

Pay Over Earnings Indicates whether the pay
over earning is allowed or
not.

System ORA_ALLOW
 
ORA_DISALLOW
 

ORA_CJM_CLAIM_SOURCE
 

Channel Claim Source
 

List of claim sources
supported in the channel
claim.
 

System
 

CLAIM
 
CLAIM_INVESTIGATION_
DED
 
CLAIM_INVESTIGATION_
OPM
 
INVOICE_DEDUCTION
 
INVOICE_OVERPAYMENT
 
SA_CLAIM
 
SA_DEBIT_CLAIM
 
SSD_CLAIM
 
SSD_DEBIT_CLAIM
 
SR_CLAIM
 
SR_DEBIT_CLAIM
 

ORA_CJM_CLAIM_STATUS
 

Channel Claim Status
 

List of statuses supported
in the channel claim.
 

System
 

APPROVAL_PENDING
 
APPROVAL_REJECTED
 
CANCELLED
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Lookup Type Meaning Description Lookup Configuration
Level

Lookup Codes

NETTING_IN_PROG
 
OPEN
 
UPDATE_IN_PROGRESS
 
SETTLED
 
SETTLEMENT_PENDING
 

ORA_CJM_CODE_
MAPPING_TYPE
 

Channel Code Mapping
Type
 

Indicates the mapping
types for customer
mappings.
 

System
 

ORA_CLAIM_REASON
 

ORA_CJM_CUST_CHKBK_
TYPE

Type of Data Shown in
Customer Checkbook

Indicates whether to
show customer balances,
 program balances, or total
balances.

System ORA_CUSTOMER_BAL
 
ORA_PROGRAM_BAL
 
ORA_TOTAL_BAL
 

ORA_CJM_CUST_CLAIM_
ASSOC_TYPE

Association Type for
Customer Claims

Indicates the level at which
accrual association is
performed in customer
claims.

System ORA_PROGRAM

ORA_CJM_CUST_REB_
PERCENT_BASIS

Percent Basis for Customer
Rebates

List of pricing bases for
percent supported in
customer rebate programs.

System ORA_UNIT_LIST_PRICE
 
ORA_UNIT_SELLING_PRICE
 

ORA_CJM_CUST_REBATE_
DATE_QUAL

Date Qualifier for Customer
Rebates

Indicates the date qualifiers
supported in customer
rebates.

System ACTUAL_SHIP_DATE
 
SALES_INVOICE_DATE
 
ORDERED_DATE
 
REQ_ARRIVAL_DATE
 
REQ_SHIP_DATE
 

ORA_CJM_CUST_REBATE_
QUAL

Qualifier for Customer
Rebates

List of qualifiers supported
in customer rebate
programs.

Extensible ORA_HEADER_BILL_TO_
CUSTOMER_ID
 
ORA_HEADER_BILL_TO_
SITE_USE_ID
 
ORA_ORDER_LINE_TYPE
 
ORDER_TYPE
 
SALESPERSON_ID
 
SHIP_TO_PARTY_SITE_ID
 
ORA_WAREHOUSE
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Lookup Type Meaning Description Lookup Configuration
Level

Lookup Codes

ORA_CJM_CUST_CLAIM_
RESOL_TYPE

Resolution Type for
Customer Claims

Indicates the resolution
types supported in
customer claims.

System ORA_PROMOTIONAL
 
ORA_NON_PROMOTIONAL
 

ORA_CJM_CUST_CLM_
ACCRUE_TO_LVL

Level of Accrue To
for Customer Claim
Associations

Indicates the level of accrue
to supported in customer
claim associations.

System ORA_ALL_ACCT_
RELATIONSHIP
 
ORA_BILL_TO_
RELATIONSHIP
 
ORA_RECIPROCAL_
RELATIONSHIP
 

ORA_CJM_CUST_CLM_
CALENDAR_YEAR

Calendar Year for Customer
Claim Associations

Indicates the calendar years
supported in customer
claims associations.

System ORA_CURRENT_YEAR
 
ORA_LAST_YEAR
 

ORA_CJM_CUST_PROG_
ITEM_LEVEL

Item Level for Product
Rules in Customer
Programs

Item levels supported in
product rules for customer
programs.

Extensible ORA_ITEM
 
ORA_ALL_ITEMS
 

ORA_CJM_DISCOUNT_
APPLIED_TO
 

Discount Applied To
 

Choices to indicate the
grouping option used
when applying the channel
program. For example,
 Single line or Group of
lines.
 

System
 

LINE - Single line
 

ORA_CJM_DISP_TYPE_
STATUS
 

Filter Records by Status
 

Filter used to sort records
based on one of the
following statuses: enabled,
 disabled or all statuses.
 

System
 

Y
 
N
 
ALL
 

ORA_CJM_DISTRIBUTION_
TYPE

Product Distribution Type List of product distribution
types supported in the
lump sum program.

System ORA_EVEN
 
ORA_AMOUNT
 
ORA_PERCENT
 

ORA_CJM_DOCUMENT_
TYPE
 

Channel Document Type
 

Indicates the document
type.
 

System
 

ORA_RECEIVING_TRX
 

ORA_CJM_ESS_PARAM_
PROCESS_MODE
 

Program Process Mode
 

Indicates whether the
program runs in preview
mode or update mode.
 

System
 

PREVIEW - In preview
mode, the program reports
the accounting exceptions.
 
UPDATE - In update mode,
the program sweeps the
unaccounted channel
transactions.
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Lookup Type Meaning Description Lookup Configuration
Level

Lookup Codes

ORA_CJM_GEN_SUP_CLM_
DATE_TYPE
 

Date Type for Generate
Supplier Claims
 

Indicates the date type
used for identifying eligible
accruals in the Generate
Supplier Claims scheduled
process.
 

System
 

ACCT_DATE
 
REQ_ACCT_DATE
 

ORA_CJM_INITIATED_BY Initiated By Indicates whether the
program is created by an
internal or external user.

System ORA_CJM_INTERNAL
 
ORA_CJM_EXTERNAL
 

ORA_CJM_ITEM_LEVEL
 

Channel Program Item
Level
 

List of item levels
supported in the channel
program. For example, Item
or All Items.
 

Extensible
 

ALL_ITEMS
 
ITEM
 

ORA_CJM_ITEM_VAL_
ORG_SETUP_IN

Applications with the item
validation organization
setting

List of applications from
where channel retrieves the
item validation organization
setting.

System ORA_RECEIVABLES
 
ORA_PRICING
 

ORA_CJM_LINE_
DISCOUNT_TYPE
 

Line Discount Type
 

Discount types supported
in the channel program. For
example, amount, percent,
 or new cost.
 

System
 

DISCOUNT_AMOUNT
 
DISCOUNT_PERCENT
 
NEW_COST
 
NEW_PRICE
 

ORA_CJM_LINE_SOURCE_
TYPE
 

Claim Line Source Type
 

List of line source types
supported in the channel.
 

System
 

PROGRAM
 

ORA_CJM_LS_QUALIFIER Lump Sum Program
Qualifier

List of qualifiers supported
in Lump Sum programs.

System ORA_BILL_TO_
CUSTOMER_ACCOUNT
 

ORA_CJM_MANUAL_ADJ_
STATUS
 

Manual Adjustment Status
 

List of statuses supported
in the manual adjustment.
 

System
 

APPROVAL_PENDING
 
APPROVAL_REJECTED
 
APPROVED
 
OPEN
 
SUCCESSFUL
 

ORA_CJM_MASS_
SETTLEMENT_METHOD

Channel Claim Mass
Settlement Method

List of settlement methods
supported in the mass
settle page.

Extensible ORA_CJM_CREDIT_MEMO
 
ORA_CJM_WRITE_OFF
 

ORA_CJM_ORDER_GL_
POST_PHASE
 

Order Line Phase to Create
GL Entries
 

Order line phase at which
GL entries are created.
 

System
 

INVOICED
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Lookup Type Meaning Description Lookup Configuration
Level

Lookup Codes

ORA_CJM_PGM_CHKBK_
TYPE

Type of Data Shown in
Program Checkbook

Indicates whether to show
customer balances, bill to
balances, or total balances.

System ORA_CUSTOMER_BAL
 
ORA_BILL_TO_BAL
 
ORA_TOTAL_BAL
 

ORA_CJM_PRICING_APP_
DATE_TYPE
 

Channel Program
Application Date Type
 

Sales order date type used
for evaluating channel
program eligibility.
 

System
 

ORDERED_DATE
 
REQ_SHIP_DATE
 

ORA_CJM_PROG_ITEM_
LEVEL
 

Item Level for Product
Rules
 

Item levels supported in
product rules evaluated
in Channel Revenue
Management.
 

System
 

ORA_ALL_ITEMS
 
ORA_ITEM
 
ORA_ITEM_CATEGORY
 

ORA_CJM_PROGRAM_
STATUS
 

Channel Program Statuses
 

List of statuses supported
in the channel program.
 

System
 

ACTIVE
 
APPROVAL_PENDING
 
APPROVAL_REJECTED
 
DRAFT
 
TERMINATED
 
SUPPLIER_DRAFT
 
DECLINED
 

ORA_CJM_PROGRAM_
TYPE
 

Channel Program Template
 

List of program templates
supported in Channel
Revenue Management.
 

System
 

SUPPLIER_ANNUAL_
PROGRAM
 
SUPPLIER_SHIP_AND_
DEBIT
 
SUPPLIER_REBATE
 
CUSTOMER_REBATE
 

ORA_CJM_PROGRAM_
TYPE_STATUS
 

Channel Program Type
Statuses
 

List of statuses supported
in the channel program
type.
 

System
 

ACTIVE
 
CLOSED
 
DRAFT
 
PREDEFINED
 

ORA_CJM_QUALIFIER_
 OPERATOR
 

Qualifier Operator
 

List of operators supported
while adding qualifiers in
channel.
 

System
 

E (=)
 
NE (<>)
 

ORA_CJM_QUALIFIER_
TYPE
 

Channel Program Qualifier
 

List of qualifiers supported
in Channel Revenue
Management.

Extensible
 

BILL_TO_CUSTOMER_ID
 
ORDER_TYPE
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Lookup Type Meaning Description Lookup Configuration
Level

Lookup Codes

  
SALESPERSON_ID
 
SOLD_TO_PARTY_ID
 
SHIP_TO_PARTY_SITE_ID
 
SALESPERSON_ID
 
ORA_WAREHOUSE
 

ORA_CJM_SALES_
METHOD
 

Sales Method
 

Source of sales for which
a rebate program is
applicable. For example,
 Direct or Indirect.
 

System
 

B - Both
 
D - Direct
 

ORA_CJM_SETTLEMENT_
DOC_TYPE
 

Settlement Document Type
 

Indicates whether the
settlement document line is
a transaction or instrument.
 

System
 

TRANSACTION
 
INSTRUMENT
 

ORA_CJM_SETTLEMENT_
METHOD
 

Channel Claim Settlement
Method
 

List of settlement methods
supported in channel
claims.
 

Extensible
 

AP_DEBIT
 
AP_DEFAULT
 
CM_ON_ACCOUNT
 
CM_ON_INVOICE
 
PRE_OPEN_CREDIT
 
ON_ACCOUNT_INV
 
OPEN_DED
 
OPEN_OPM
 
WRITE_OFF
 
ORA_CHARGEBACK
 

ORA_CJM_SUP_RBT_DISC_
TYPE
 

Discount Type for Supplier
Rebates
 

Discount types supported
in supplier rebate
programs.
 

System
 

ORA_DISCOUNT_PERCENT
 
ORA_DISCOUNT_AMOUNT
 
ORA_NEW_PRICE
 

ORA_CJM_SUP_RBT_
EARN_ACCR_EVT
 

Event for Triggering Earned
Accrual for Supplier Rebate
 

Indicates the event for
triggering supplier rebate
accrual.
 

System
 

ORA_CJM_ACCR_EVT_
RECEIPT
 
ORA_CJM_ACCR_EVT_
SUPPL_INVOICE
 

ORA_CJM_SUP_RBT_NEW_
PRIC_BASIS
 

New Price Basis for Supplier
Rebates
 

List of pricing bases for new
price supported in supplier
rebate programs.
 

Extensible
 

ORA_PO_LINE_UNIT_PRICE
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Lookup Type Meaning Description Lookup Configuration
Level

Lookup Codes

ORA_CJM_SUP_RBT_
PERCENT_BASIS
 

Percent Basis for Supplier
Rebates
 

List of pricing bases for
percent supported in
supplier rebate programs.
 

Extensible
 

ORA_PO_LINE_UNIT_PRICE
 

ORA_CJM_SUP_REBATE_
DATE_QUALFR
 

Date Qualifier for Supplier
Rebates
 

Indicates the date qualifiers
supported in supplier
rebates.
 

System
 

PO_DATE
 
RECEIPT_TRX_DATE
 
REQ_DELIVERY_DATE
 
REQ_SHIP_DATE
 
SHIPPED_DATE
 
SUPPLIER_INVOICE_DATE
 

ORA_CJM_SUP_REBATE_
QUAL
 

Qualifier Type for Supplier
Rebates
 

List of qualifiers supported
in supplier rebate
programs.
 

Extensible
 

ORA_BILL_TO_LOCATION
 
ORA_SHIP_TO_LOCATION
 
ORA_TRANSACTION_
REASON
 

ORA_CJM_SUPPLIER_INV_
REASON
 

Reason for Supplier Invoice
Correction
 

List of reasons for
correcting an invoice.
 

Extensible
 

-
 

ORA_CJM_TIER_CALC_
METHOD

Tier Calculation Method List of tier calculation
methods supported in
programs.

System ORA_RETROSPECTIVE
 
ORA_STEPPED
 

ORA_CJM_TIER_TYPE
 

Channel Program Tier Type
 

Tier types supported in the
channel program.
 

System
 

ORA_QUANTITY
 
ORA_AMOUNT
 

ORA_CJM_TRANSACTION_
TYPE
 

Channel Transaction Type
 

List of transaction types
supported in channel.
For example, Accrual or
Adjustment.
 

System
 

ACCRUAL
 
ADJUSTMENT
 

ORA_CJM_USER_STATUS_
FOR
 

User Status For
 

Indicates channel object
type for which the user
status is created.
 

System
 

CLAIM
 
PROGRAM
 
PROGRAM_TYPE
 

ORA_CJM_YES_NO
 

Generic Yes or No List of
Values
 

Generic Yes or No list of
values.
 

System
 

Y - Yes
 
N - No
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Manage Channel Profile Options  
Here you can view and manage profile options for Channel Revenue Management.

1. In the Setup and Maintenance work area, go to:

◦ Offering: Order Management/Procurement

◦ Functional Area: Channel Revenue Management/Supplier Incentives

◦ Task: Manage Channel Profile Options

2. On the Manage Channel Profile Options page:

◦ The Search Results: Profile Option section displays details of the profile option code, the profile display
name, the application and its module that uses the profile option, the start and end dates, and the
description of the profile option that you search for.

◦ The Profile Option: Profile Values section displays the profile level set for the profile option.

List of Channel Profile Options
This table lists the profile options available for Channel Revenue Management.

Profile Display Name Profile Option Code Description

Channel Currency Conversion Type
 

CJM_CURRENCY_CONVERSION_TYPE
 

Use this option to specify the conversion rate
type to be used during currency conversions at
the site level.
 

Credit Method for Installments
 

ORA_CJM_AR_CR_MTHD_FOR_INSTL
 

For Deductions and Settlement
 
Use this option to specify how installments
must be credited in Receivables for transactions
with multiple installments, when settling with
the settlement method Credit Memo - On
Invoice. This option is for the site level. Values
can be:
 

• FIFO: First in First Out. Credits the first
installment first.

• LIFO: Last In First Out. Credits the last
installment first.

• Prorate: Credits the installments of the
credited transactions and prorate them
based on the amount remaining for each
installment.

Credit Method for Accounting Rules
 

ORA_CJM_AR_CR_MTHD_FOR_RULE
 

For Deductions and Settlement
 
Use this option to specify how the accounting
entries must be reversed in Receivables by the
settlement method Credit Memo - On Invoice, if
accounting rules are used. This option is for the
site level. Values can be:
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Profile Display Name Profile Option Code Description

 
• LIFO: Last In First Out. Starts from the last

accounting period and reverses all prior
periods till the credit memo is used up.

• Prorate: Credits an equal percentage to all
the account assignments for the invoice.

• Unit: Reverses revenue for the number of
units specified in the original invoice line.

Calendar Year Filter in Available Accruals Search ORA_CJM_AVAIL_ACCR_CAL_YEAR_FILTER Use this option to specify the calendar year
filter used to search available accruals. This
option can be used at the site or user levels.
The default value is set at the site level.

Group by in Available Accruals Search ORA_CJM_AVAIL_ACCR_GROUP_BY Use this option to specify the association type
used to group results in the available accruals
search. This profile can be used at the site or
user levels. The default value is set at the site
level.

Minimum Number of Days of Receipt Data for
Initial Load
 

ORA_CJM_MIN_DAYS_INITIAL_LOAD_RECEIPT
 

For Supplier Rebates
 
Use this option to specify the number of days
of receipt data that must be processed in
the initial (first) run of the Load Transactions
process at the site level. When:
 
N = Minimum Number of Days of Receipt Data
For Initial Load
 
D1 = Start date of the active program with the
earliest start date.
 
D2 = D1 - N
 

• If D2 <= Today's date, the initial start date
for Load Transactions is D2.

• If D2 > Today's date, the initial start date
for Load Transactions is Today - N days.

• If there are no active programs, the initial
start date for Load Transactions is Today -
N days.

• Default value for Minimum Number of
Days of Receipt Data For Initial Load is set
as 30 days, if the profile value is cleared or
a negative value is entered.

The profile option is used to determine how
far back in days your implementation wants to
collect receiving transactions from when you
first execute the Load Transactions process.
This profile is only used the first time you run
the Load Transactions scheduled process. After
the first run, the application tracks when the
process was last performed. So from the next
run onward, it collects only the new receiving
transactions.
 
For example, if you're running the first Load
Transactions process on Dec 14th and the
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Profile Display Name Profile Option Code Description

implementation wants to bring in 1 month of
transactions prior to a Jan 1st go-live date,
then your initial load on Dec 14th should set
Minimum Number of Days of Receipt Data from
Initial Load to 14 days.
 

Manage Channel Messages  
Here you can view, edit, and add new messages for Channel Revenue Management.

1. In the Setup and Maintenance work area, go to:

◦ Offering: Order Management/Procurement

◦ Functional Area: Channel Revenue Management/Supplier Incentives

◦ Task: Manage Channel Messages

2. On the Manage Channel Messages page, you can search for, and edit existing messages, or create your custom
messages.

Note:  Before creating a new message, check the existing messages to see if it meets your need.

3. To create a new message, click the New icon, or select New from the Actions drop-down list.
4. On the Create Message page, enter you message details. The following attributes are required:

Attribute Description

Message Name
 

Enter a unique name with the format: APPLICATIONSHORTNAME_LBA/SUB-LBA_MESSAGE
DESCRIPTION. For example, CJM_ADJ_SUP_ATRIB_NO_INPUT. Use all uppercase letters, and
don't use symbols.
 

◦ Don't include spaces within the name, or at the start or end of the name. Use underscore
characters to separate parts of the message name.

◦ Don't include message numbers in the name.

Application
 

Channel Revenue Management
 

Module
 

Select the area for which the message is created. For example, common.
 

Message Type
 

Select the type of the message, for example, error, warning and so on.
 

Short Text
 

Enter the message that you want to use.
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5. If you're using tokens, in the Message Tokens area, select New and add the token details. A token is a
placeholder for variable content, such as text or a number. Channel Revenue Management replaces the token
with the value at runtime.

6. Click Save and Close.
For more information, see the Configuring and Extending Applications guide for Oracle Applications Cloud.

Manage Channel Descriptive Flexfields  
Here you can view and manage descriptive flexfields for Channel Revenue Management.

1. In the Setup and Maintenance work area, go to:

◦ Offering: Order Management/Procurement

◦ Functional Area: Channel Revenue Management/Supplier Incentives

◦ Task: Manage Channel Descriptive Flexfields

2. On the Manage Descriptive Flexfields page, search for the Channel flexfield.

Channel Descriptive Flexfields
These DFFs are available to manage additional information for Channel Revenue Management.

Name Flexfield Code Description

Channel Program Header DFF
 

CJM_PROGRAMS
 

Fields for additional information about the
channel program header.
 

Channel Program Product Rules
 

CJM_ PROGRAM_ PRODUCT_RULES
 

Fields for additional information about a
product rule of a channel program.
 

Channel Claim Header DFF
 

CJM_CLAIMS
 

Fields for additional information about the
channel claim header.
 

Customer Claim Header DFF
 

CCJM_CUSTOMER_CLAIMS
 

Fields for additional information about the
customer claim header.
 

Channel Document Header DFF. CJM_DOCUMENT_HEADER_DFF Fields to capture additional information about
the channel document header.

Channel Document Line DFF CJM_DOCUMENT_LINE_DFF Fields to capture additional information about
the channel document line.

Related Topics
• Overview of Flexfields
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13  Set Up Import

Import Customer Invoices  
You can import customer invoices from CSV files into Channel Revenue Management using the Import Management
application.

Import Management can be accessed from Tools > Import Management.

Consideration: If you import sales invoices via the CSV file (Batch Transaction Type = ORA_SALES_ORDER_CSV), then
you must first import the CSV file, and then schedule the Create Accruals for Channel Batch process to create accruals.

How to Handle Errors
Here are some tips to handle errors that may occur during the import process:

• The import process provides you with an error.csv file and a reject.csv file for a given import. All the errors are
in the error.csv file. The reject.csv file is a copy of your source CSV with additional columns with error messages.

• Correct the errors in the reject.csv file. Remember to remove the first and last columns and save as a new CSV
file.

• Import the new CSV file.

Note:  You must fix all the errors in the CSV file before rerunning the import. A batch is created only if there are no
validation errors.
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Attributes Required from Oracle Fusion Cloud Applications
You must set up these attributes that are part of various Oracle Fusion Cloud applications for importing sales invoices.

Application Attribute Required?

HR foundation in HCM Business Unit Yes

Financials foundation Currency Yes

Product Information Management Item Yes

Product Information Management UOM Yes

Pricing Item Validation Organization (Pricing
Parameter)

Yes

Receivables Bill-to Customer, Account and Site Yes

TCA Ship-to Customer, Site Yes

TCA Sold-to Customer Yes

TCA Salesperson Yes, if specified in the CSV file

Order Management Sales Order Type Yes, if specified in the CSV file

Order Management Sales Order Line Type Yes, if specified in the CSV file

Receivables Sales Invoice Type Yes, if specified in the CSV file

Receivables Sales Invoice Line Type Yes, if specified in the CSV file

Inventory Warehouse Yes, if specified in the CSV file

Sales Invoice Attributes
You must use Channel Batch Transaction as the import object. The attribute Batch Transaction Type is a required
attribute. For sales invoices, it's ORA_SALES_ORDER_CSV. You can either download the Channel Batch Transaction
template or map your template against the attributes in the Channel Batch Transaction object. The following attributes
are available for sales invoices:

Display Name Attribute Name Description Required Validated

Batch Transaction Type BatchTransactionType The transaction type
used to categorize the
transaction data in the
batch.

Yes Yes

Bill of Lading BillOfLadingNumber A carrier's contract and
receipt for the goods
that the carrier agrees to
transport from a specific
origin address to a specific
destination address.

- No
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Display Name Attribute Name Description Required Validated

Bill-to Account BillToAccount The account number of the
bill-to customer.

Conditional Yes

Bill-to Account ID BillToAccountID The unique identifier for
the bill-to account.

Conditional Yes

Bill-to Account Site BillToAccountSite Indicates the unique user-
friendly identifier of the
customer account site.

Conditional Yes

Bill-to Account Site ID BillToAccountSiteID Indicates the unique
identifier of the customer
account site.

Conditional Yes

Bill-to Customer BillToCustomer The name of the bill-to
customer.

Conditional Yes

Bill-to Customer ID BillToCustomerID The unique identifier for
the bill-to customer.

Conditional Yes

Bill-to Customer Registry ID BillToCustomerRegistryID The user-friendly unique
identifier for the bill-to
customer.

Conditional Yes

Business Unit BusinessUnit The business unit for the
transaction.

Conditional Yes

Business Unit ID BusinessUnitId The unique identifier for
the business unit.

Conditional Yes

Comments Comments The comments for the
transaction.

- No

Currency Currency The currency code for the
transaction.

Yes Yes

Item ItemNumber The inventory item number. Conditional Yes

Item Description ItemDescription The description for the
item.

- No

Item ID ItemID The unique identifier for
the inventory item.

Conditional Yes

Line Comments LineComments The comments for the
transaction line.

- No

Original Sales Order Line
Number

OriginalSalesOrderLineNumberThe line number for the
original sales order line.

- No

Original Sales Order
Number

OriginalSalesOrderNumber The sales order number for
the original sales order.

- No

Original System Line
Reference

OriginalSystemLineReference The original document
reference for the
transaction line in the
external system.

- No

Original System Reference OriginalSystemReference The original document
reference for the
transaction in the external
system.

- No
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Display Name Attribute Name Description Required Validated

Original System Source OriginalSystemSource The name of the system
source.

Yes No

Purchase Order Line
Number

PurchaseOrderLineNumber The unique identifier for
the purchase order line.

- No

Purchase Order Number PurchaseOrderNumber The purchase order
document number.

- No

Requested Arrival Date RequestedArrivalDate The original date the
customer requested the
item arrive on.

- No

Requested Ship Date RequestedShipDate The original date the
customer requested the
item ship on.

- No

Sales Invoice Date SalesInvoiceDate The date that appears on a
customer invoice.

Yes No

Sales Invoice Line Number SalesInvoiceLineNumber The unique identifier for
the invoice line.

Yes No

Sales Invoice Line Type SalesInvoiceLineType Indicates whether the
invoice line corresponds
to an item, tax, freight, or
miscellaneous.

- Yes

Sales Invoice Number SalesInvoiceNumber The invoice number for the
customer invoice.

Yes No

Sales Invoice Type SalesInvoiceType The invoice type for the
invoice.

- Yes

Sales Order Date SalesOrderDate The ordered date on the
sales order.

Yes No

Sales Order Line Number SalesOrderLineNumber The unique identifier for
the sales order line.

Yes No

Sales Order Line Type SalesOrderLineType Defines the system
behavior for the order line
transaction.

- Yes

Sales Order Number SalesOrderNumber The identifier for the sales
order.

Yes No

Sales Order Type SalesOrderType The name of the type of
order that was placed.

- Yes

Salesperson Salesperson The person who is engaged
in the sale of goods and
services.

- Yes

Salesperson ID SalespersonID The unique identifier for
the salesperson.

- Yes

Salesperson Number SalespersonNumber The unique user-friendly
number that is associated
with the salesperson.

- Yes
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Display Name Attribute Name Description Required Validated

Shipment Number ShipmentNumber The unique identifier of a
shipment.

- No

Shipped Date ShippedDate The date the shipment was
actually sent.

- No

Shipped Quantity ShippedQuantity The quantity of goods or
services that was shipped
by supplier.

Yes No

Shipped UOM ShippedUOM The unit of measure for
the shipped quantity. UOM
stands for Unit of Measure.

Yes Yes

Ship-to Customer ShipToCustomer The name of the ship-to
customer.

Conditional Yes

Ship-to Customer ID ShipToCustomerID The unique identifier for
the ship-to customer.

Conditional Yes

Ship-to Customer Registry
ID

ShipToCustomerRegistryID The user-friendly unique
identifier for the ship-to
customer.

Conditional Yes

Ship-to Site ShipToSite The unique user-friendly
address identifier for the
ship-to customer.

Conditional Yes

Ship-to Site ID ShipToSiteID The unique address
identifier for the ship-to
customer.

Conditional Yes

Sold-to Customer SoldToCustomer The name of the sold-to
customer.

Conditional Yes

Sold-to Customer ID SoldToCustomerID The unique identifier for
the sold-to customer.

Conditional Yes

Sold-to Customer Registry
ID

SoldToCustomerRegistryID The user-friendly unique
identifier for the sold-to
customer.

Conditional Yes

Sold-to Site SoldToSite The unique user-friendly
address identifier for the
sold-to customer.

- Yes

Sold-to Site ID SoldToSiteID The unique address
identifier for the sold-to
customer.

- Yes

Unit List Price UnitListPrice The base selling price
before applying discounts.

- No

Unit Selling Price UnitSellingPrice The price per unit that a
buyer paid for an item.

Yes No

Warehouse Code WarehouseCode The unique alphanumeric
identifier for the inventory
organization.

No Yes

Warehouse ID WarehouseID The unique identifier for
the warehouse that is

No Yes
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Display Name Attribute Name Description Required Validated

used to ship items from or
receive items into.

Waybill WaybillNumber The non-negotiable
document describing the
contract for transporting
cargo.

- No

Channel Document Header
DFF
 

Based on setup The fields to capture
additional information
about the channel
document header.

Note:  If a DFF attribute
is populated in the csv
but not configured
in the DFF, it will get
copied to the document
transaction without
validation.

Based on setup Yes

Channel Document Line
DFF

Based on setup The fields to capture
additional information
about the channel
document line.

Note:  If a DFF attribute
is populated in the csv
but not configured
in the DFF, it will get
copied to the document
transaction without
validation.

- -

Note:  When both ID and Name values are available, for example, BusinessUnitId and BusinessUnit, the ID value is
evaluated.

Note:  The combination of Batch Transaction Type, Business Unit ID, Original System Source, Sales Order Line
Number, and Sales Order Number must be unique.

Qualifiers for Sales Invoice
Here's the list of qualifiers for sales invoices

• Order Date

• Invoice Date

• Actual Ship Date

• Requested Ship Date

• Requested Arrival Date

• Customer
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• Bill To

• Ship To

• Order Type

• Order Line Type

• Salesperson

• Warehouse

• Channel Document Header DFF (only for csv integration)

• Channel Document Line DFF (only for csv integration)

Mapping between Customer Qualifiers in Customer Rebate and Attributes
in CSV

Customer Qualifier in Customer
Rebate

Name in Channel Batch
Transaction Template CSV File

Accounts Receivable Transaction
UI

Accounts Receivable
receivablesInvoices REST API

Customer Bill-to Account Bill-to Account Number BillToCustomerNumber

Bill To Bill-to Account Site Bill-to Site BillToSite

Ship To Ship-to Site Ship-to Site ShipToSite

Related Topics
• How do I import data?

• How do I map import fields?

• Overview of Import Queues

Import Supplier Invoices  
You can import supplier invoices from CSV files into Channel Revenue Management using the Import Management
application. Import Management can be accessed from Tools > Import Management.

Consideration: If you import supplier invoices via a CSV file (Batch Transaction Type = ORA_SUPPLIER_INVOICE_CSV),
then import the CSV file once, and then schedule 2 processes to create accruals (for example, Create Accruals for
Channel Batch and Create Accruals for Volume Programs).
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How to Handle Errors
Here are some tips to handle errors that may occur during the import process:

1. The import process provides you with an error.csv file and a reject.csv file for a given import. All the errors are
in the error.csv file. The reject.csv file is a copy of your source CSV with additional columns with error messages.

2. Correct the errors in the reject.csv file. Remember to remove the first and last columns and save as a new CSV
file.

3. Import the new CSV file.

Note:  You must fix all the errors in the CSV file before rerunning the import. A batch is created only if there
are no validation errors.

Attributes Required from Oracle Fusion Cloud Applications
You must set up these attributes that are part of various Oracle Fusion Cloud applications for importing supplier
invoices.

This table contains all the required attributes that must be set up in various Oracle Fusion Cloud applications, for
importing supplier invoices using CSV files.
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Application Attribute Required?

HR foundation in HCM
 

Business Unit
 

Yes
 

HR foundation in HCM
 

Bill-to Location
 

Yes, if specified in the CSV file
 

HR foundation in HCM
 

Ship-to Location
 

Yes, if specified in the CSV file
 

HR foundation in HCM
 

Receiving Location
 

Yes, if specified in the CSV file
 

Financials foundation
 

Currency
 

Yes
 

Product Information Management
 

Item
 

Yes
 

Product Information Management
 

Supplier Item
 

Yes, if specified in the CSV file
 

Product Information Management
 

UOM
 

Yes
 

Inventory Management
 

Receiving Inventory Org
 

Yes, if specified in the CSV file
 

Procurement
 

Supplier
 

Yes
 

Procurement
 

Supplier Site
 

Yes
 

Procurement
 

Procurement BU
 

Yes, if specified in the CSV file
 

Procurement
 

Item Validation Org
 
(Configure the Procurement Business Function
for Procurement BU)
 

Yes
 

Payables Invoices
 

Invoice Type
 

Yes
 

Receiving
 

Transaction Type
 

Yes, if specified in the CSV file
 

Receiving or Inventory
 

Transaction Reason
 

Yes, if specified in the CSV file
 

Supplier Invoice Attributes
You must use Channel Batch Transaction as the import object. The attribute Batch Transaction Type is a required
attribute. For supplier invoices, it's ORA_SUPPLIER_INVOICE_CSV. You can either download the Channel Batch
Transaction template or map your template against the attributes in the Channel Batch Transaction object. These
attributes are available for supplier invoices.

This table contains all the attributes that are available for supplier invoice import
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Attribute Name Display Name Description Required? Validated?

BatchTransactionType
 

Batch Transaction Type
 

The transaction type
used to categorize the
transaction data in the
batch.
 

Yes
 

Yes
 
Value is from the lookup
ORA_CJM_BATCH_DATA_
SOURCE
 

BusinessUnit
 

Business Unit
 

The business unit for the
transaction.
 

Conditional
 

Yes
 

BusinessUnitId
 

Business Unit ID
 

The unique identifier for
the business unit.
 

Conditional
 

Yes
 

Comments
 

Comments
 

The comments for the
transaction.
 

No
 

No
 

Currency
 

Currency
 

The currency code for the
transaction.
 

Yes
 

Yes
 

ItemNumber
 

Item
 

The inventory item number.
 

Conditional
 

Yes
 

ItemDescription
 

Item Description
 

The description for the
item.
 

No
 

No
 

ItemID
 

Item ID
 

The unique identifier for
the inventory item.
 

Conditional
 

Yes
 

LineComments
 

Line Comments
 

The comments for the
transaction line.
 

No
 

No
 

OriginalReceivingTransactionNumber
 

Original Receiving
Transaction Number
 

The unique identifier for
the original transaction
associated with the
receiving line.
 

No
 

No
 

OriginalSupplierInvoiceLineNumber
 

Original Supplier Invoice
Line Number
 

The line number for the
original supplier invoice
line.
 

No
 

No
 

OriginalSupplierInvoiceNumber
 

Original Supplier Invoice
Number
 

The supplier invoice
number for the original
supplier invoice.
 

No
 

No
 

OriginalSystemLineReference
 

Original System Line
Reference
 

The original document
reference for the
transaction line in the
external system.
 

No
 

No
 

OriginalSystemReference
 

Original System Reference
 

The original document
reference for the

No
 

No
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Attribute Name Display Name Description Required? Validated?

transaction in the external
system.
 

OriginalSystemSource
 

Original System Source
 

The name of the system
source.
 

Yes
 

No
 

ProcurementBusinessUnit
 

Procurement Business Unit
 

The procurement business
unit on the purchase order.
 

No
 

Yes
 

ProcurementBusinessUnitId
 

Procurement Business Unit
ID
 

The unique identifier for
the procurement business
unit on the purchase order.
 

No
 

Yes
 

PurchaseOrderBillToLocationCode
 

Purchase Order Bill-to
Location Code
 

The unique identifier for
the bill-to location.
 

No
 

Yes
 

PurchaseOrderBillToLocationId
 

Purchase Order Bill-to
Location ID
 

The unique identifier of
the address for the bill-to
location.
 

No
 

Yes
 

PurchaseOrderDate
 

Purchase Order Date
 

The date on which the
purchase order was
communicated to the
supplier.
 

No
 

No
 

PurchaseOrderLineNumber
 

Purchase Order Line
Number
 

The unique identifier for
the purchase order line.
 

No
 

No
 

PurchaseOrderLineRequestedDeliveryDate
 

Purchase Order Line
Requested Delivery Date
 

The date by which the
buyer has requested
delivery of a line item by
the supplier.
 

No
 

No
 

PurchaseOrderLineRequestedShipDate
 

Purchase Order Line
Requested Ship Date
 

The date by which the
buyer asked suppliers
to ship goods from their
location.
 

No
 

No
 

PurchaseOrderLineShipToLocationCode
 

Purchase Order Line Ship-
to Location Code
 

The unique identifier for
the ship-to location.
 

No
 

Yes
 

PurchaseOrderLineShipToLocationId
 

Purchase Order Line Ship-
to Location ID
 

The unique identifier of
the address for the ship-to
location.
 

No
 

Yes
 

PurchaseOrderNumber
 

Purchase Order Number
 

The purchase order
document number.
 

No
 

Yes
 

ReceiptBillOfLadingNumber
 

Receipt Bill of Lading
 

A carrier's contract and
receipt for the goods

No
 

No
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Attribute Name Display Name Description Required? Validated?

that the carrier agrees to
transport from a specific
origin address to a specific
destination address.
 

ReceiptNumber
 

Receipt Number
 

The number that
acknowledges that a
shipment was received in
the warehouse.
 

No
 

No
 

ReceiptShipmentNumber
 

Receipt Shipment Number
 

A shipment from one
supplier that can include
several items ordered on
many purchase orders.
 

No
 

No
 

ReceiptShippedDate
 

Receipt Shipped Date
 

The date when goods or
services were shipped by
the supplier.
 

No
 

No
 

ReceiptWaybillNumber
 

Receipt Waybill
 

The non-negotiable
document describing the
contract for transporting
cargo.
 

No
 

No
 

ReceivingInventoryOrganizationCode
 

Receiving Inventory
Organization Code
 

The user-defined unique
code for the inventory
organization.
 

No
 

Yes
 

ReceivingInventoryOrganizationID
 

Receiving Inventory
Organization ID
 

The unique identifier for
the inventory organization.
 

No
 

Yes
 

ReceivingLocationCode
 

Receiving Location Code
 

The unique identifier for
the receiving location.
 

No
 

Yes
 

ReceivingLocationId
 

Receiving Location ID
 

The unique identifier for
the receiving location.
 

No
 

Yes
 

ReceivingTransactionDate
 

Receiving Transaction Date
 

The date on which the
transaction was performed.
 

No
 

No
 

ReceivingTransactionNumber
 

Receiving Transaction
Number
 

The unique identifier for
the transaction associated
with the receiving line.
 

No
 

No
 

ReceivingTransactionReason
 

Receiving Transaction
Reason
 

An explanation or
justification that explains
why the transaction is
performed.
 

No
 

Yes
 

ReceivingTransactionReasonId
 

Receiving Transaction
Reason ID

The unique identifier for
the transaction reason.

No
 

Yes
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Attribute Name Display Name Description Required? Validated?

  

ReceivingTransactionType
 

Receiving Transaction Type
 

The transaction type
used to categorize the
transaction.
 

No
 

Yes
 
Value is from the
Receiving lookup RCV_
TRANSACTION_TYPE.
 

SupplierName
 

Supplier
 

The organization or
individual that provides
goods or services to the
buying organization for
payment, bound by a
contractual obligation.
 

Conditional
 

Yes
 

SupplierId
 

Supplier ID
 

The unique identifier for
the supplier.
 

Conditional
 

Yes
 

SupplierInvoiceDate
 

Supplier Invoice Date
 

The invoice date of the
supplier invoice.
 

Yes
 

No
 

SupplierInvoiceLineNumber
 

Supplier Invoice Line
Number
 

The line number for the
supplier invoice line.
 

Yes
 

No
 

SupplierInvoiceLineQuantity
 

Supplier Invoice Line
Quantity
 

The quantity for the
supplier invoice line.
 

Yes
 

No
 

SupplierInvoiceLineReason
 

Supplier Invoice Line
Reason
 

An explanation or
justification that explains
why the transaction is
performed.
 

No
 

No
 

SupplierInvoiceLineUnitPrice
 

Supplier Invoice Line Unit
Price
 

The unit price for the
supplier invoice line.
 

Yes
 

No
 

SupplierInvoiceLineUOM
 

Supplier Invoice Line UOM
 

The unit of measure for the
supplier invoice line. UOM
stands for Unit of Measure.
 

Yes
 

Yes
 

SupplierInvoiceNumber
 

Supplier Invoice Number
 

The supplier invoice
number for the supplier
invoice.
 

Yes
 

No
 

SupplierInvoiceType
 

Supplier Invoice Type
 

The supplier invoice type
for the supplier invoice.
 

Yes
 

Yes
 
Values are from the
Payables lookup type
INVOICE TYPE, lookup code
STANDARD, CREDIT, and
DEBIT. The reference data
set is Common.
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Attribute Name Display Name Description Required? Validated?

SupplierItemNumber
 

Supplier Item
 

The supplier item number
from the purchase order
shipment line.
 

No
 

Yes
 

SupplierItemId
 

Supplier Item ID
 

The unique identifier for
the supplier item.
 

No
 

Yes
 

SupplierNumber
 

Supplier Number
 

The unique identifier of the
supplier assigned by the
buying organization.
 

Conditional
 

Yes
 

SupplierSite
 

Supplier Site
 

The entity that models how
the buying organization
conducts business with the
supplier.
 

Conditional
 

Yes
 

SupplierSiteId
 

Supplier Site ID
 

The unique identifier for
the supplier site.
 

Conditional
 

Yes
 

Channel Document Header
DFF

Based on setup The fields to capture
additional information
about the channel
document header.

Note:  If a DFF attribute
is populated in the csv
but not configured
in the DFF, it will get
copied to the document
transaction without
validation.

Based on setup Yes

Channel Document Line
DFF

Based on setup The fields to capture
additional information
about the channel
document line.

Note:  If a DFF attribute
is populated in the csv
but not configured
in the DFF, it will get
copied to the document
transaction without
validation.

Note:  When both ID and Name values are available, for example, BusinessUnitId and BusinessUnit, the ID value is
evaluated.

Note:  The combination of Batch Transaction Type, Business Unit ID, Original System Source, Supplier Invoice Line
Number, Supplier Invoice Number, and Supplier Site ID must be unique.
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Qualifiers for Supplier Invoice
Here's the list of qualifiers for supplier invoices

• Purchase Order Date

• Requested Delivery Date

• Requested Ship Date

• Supplier Invoice Date

• Receipt Transaction Date

• Transaction Reason

• Bill-to Location

• Ship-to Location

• Channel Document Header DFF (only for csv integration)

• Channel Document Line DFF (only for csv integration)

Note:  Only global segment descriptive flexfields are supported as program qualifiers, not context-based
segments. However, your implementation can import context-based segments if it doesn't use them as
qualifiers.

Related Topics
• Create Accruals from Imported Supplier Invoices

• How do I import data?

• How do I map import fields?

• Overview of Import Queues

Privileges for Import  
You must assign these privileges to users to enable them to use the Import Management application to import data
from CSV files into Channel Revenue Management.

This table contains the privileges required for a channel user to import data using CSV files.

Privilege Name Code Description Usage Assigned To

View Channel Batch
Transaction File Import
Activity Object Type Data
 

CJM_VIEW_BATCH_TRX_
FILE_IMPORT_ACTIVITY_
OBJECT_TYPE_DATA
 

Allows viewing channel
batch transaction import
activities across the
enterprise.
 

Data
 

Channel Integration
Specialist Duty
 

View Channel Batch
Transaction File Import
Mapping Object Type Data
 

CJM_VIEW_BATCH_TRX_
FILE_IMPORT_MAPPING_
OBJECT_TYPE_DATA
 

Allows viewing channel
batch transaction import
mappings across the
enterprise.

Data
 

Channel Integration
Specialist Duty
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Privilege Name Code Description Usage Assigned To

 

View Channel Batch
Transaction File Import
Object Type Data
 

CJM_VIEW_BATCH_TRX_
FILE_IMPORT_OBJECT_
TYPE_DATA
 

Allows viewing channel
batch transaction import
objects across the
enterprise.
 

Data
 

Channel Integration
Specialist Duty
 

Run File Import Scheduler
 

ZCA_RUN_FILE_IMPORT_
SCHEDULER
 

Allows scheduling and
monitoring the process
that schedules file import
activities.
 

Function (Common CRM
Privilege)
 

Channel Integration
Specialist Duty
 

Set Up File Import Activity
 

ZCA_SET_UP_FILE_
IMPORT_ACTIVITY
 

Allows creating and
maintaining import
activities that contain
process criteria, file
mapping, and schedule
to import external files
containing business
objects, such as customers
and contacts, into staging
tables.
 

Function (Common CRM
Privilege)
 

Channel Integration
Specialist Duty
 

Set Up File Import Object
and Mapping
 

ZCA_SET_UP_FILE_
IMPORT_OBJECT_AND_
MAPPING
 

Allows creating and
maintaining import
activities that contain
process criteria, file
mapping, and schedule
to import external files
containing business
objects, such as customers
and contacts, into staging
tables.
 

Function (Common CRM
Privilege)
 

Channel Integration
Specialist Duty
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14  Security

Deductions and Settlement  

Business Functions  
This topic lists the required business functions.

You must associate the Billing and Revenue Management business function with the business unit on the manual claim.

Roles and Duties  
This topic describes roles and duties in Deductions and Settlement.

This table gives the duty roles that can be assigned to your users:

Roles and Duties in Deductions and Settlement

Name Code Description

BPM Workflow System Admin Role BPMWorkflowAdmin BPM Workflow Administrator Application Role.

Channel Administration
 

ORA_CJM_CHANNEL_ADMINISTRATION_DUTY
 

Manages channel setup and administration
tasks.
 

Channel Claims Management
 

ORA_CJM_CHANNEL_CLAIMS_
MANAGEMENT_DUTY
 

Manages customer claims.
 

Channel Claims Viewing
 

ORA_CJM_CHANNEL_CLAIMS_VIEW_DUTY
 

Views customer claims.
 

Channel Operations
 

ORA_CJM_CHANNEL_OPERATIONS_DUTY
 

Manages execution of scheduled processes.
 

Channel Setup Viewing ORA_CJM_CHANNEL_SETUP_VIEW_DUTY Views setups required for channel execution.
This includes viewing the setups for program
types, adjustment types and reasons, claim
types and reasons, claim sources, and user
statuses.
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For information, see:

• Role-Based Access Control, Oracle Fusion Applications Understanding Security guide

• Provisioning Roles to Application Users, Oracle SCM Cloud Securing SCM guide

Privileges  
You can assign these privileges to your users based on their responsibilities.

Assign Privileges for Deductions and Settlement Users
This table gives the privileges your users require to perform various functions. It contains the names, codes, and
descriptions of the privileges that can be assigned to a channel user.

Privilege Usage Code Description Assigned to Duty Role

Allow Claim Write-Offs
 

Function
 

CJM_ALLOW_CLAIM_
WRITE_OFFS_PRIV
 

Allows to write-off
deductions irrespective
of the write-off threshold
value.
 

Channel Claims
Management Duty
 

Approve Customer Claims
 

UI
 

CJM_APPROVE_
CUSTOMER_CLAIMS_PRIV
 

If you haven't opted into
the Approve Customer
Claims with BPM Workflow
feature, then this privilege
allows viewing and
approval of customer
claims.
 
If you have opted into the
Approve Customer Claims
with BPM Workflow feature,
 then this privilege allows
the approver to view all the
details of the claim in the
notification.
 

Channel Claims
Management Duty
 

Create Customer Claims
 

UI
 

CJM_CREATE_CUSTOMER_
CLAIMS_PRIV
 

Enables creation of
customer claims.
 

Channel Claims
Management Duty
 

Maintain Collections
Aging Buckets (Collections
privilege)
 

UI
 

IEX_MAINTAIN_
COLLECTIONS_AGING_
BUCKETS_PRIV
 

Allows a user to maintain
aging buckets.
 

Channel Administration
Duty
 

Manage Channel
Administration Using REST
Service
 

REST
 

CJM_MANAGE_CHANNEL_
ADMINISTRATION_REST_
SERVICE_PRIV
 

Enables creation and
update of channel claim
sources, channel claim
types, channel adjustment
types, and channel user
statuses using REST
services.
 

Channel Administration
Duty
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Privilege Usage Code Description Assigned to Duty Role

Manage Channel Claim
Reasons
 

UI
 

CJM_MANAGE_CHANNEL_
CLAIM_REASONS_PRIV
 

Enables creation, update,
 and viewing of channel
claim reasons.
 

Channel Administration
Duty
 

Manage Channel Claim
Sources
 

UI
 

CJM_MANAGE_CHANNEL_
CLAIM_SOURCES_PRIV
 

Enables creation, update,
 and viewing of channel
claim sources.
 

Channel Administration
Duty
 

Manage Channel Claim
Types
 

UI
 

CJM_MANAGE_CHANNEL_
CLAIM_TYPES_PRIV
 

Enables creation, update,
 and viewing of channel
claim types.
 

Channel Administration
Duty
 

Manage Channel Customer
Claims using REST Service
 

REST
 

CJM_MANAGE_CHANNEL_
CUSTOMER_CLAIM_REST_
SERVICE_PRIV
 

Enables creation, update,
 and viewing of channel
customer claims using
REST service.
 

Channel Claims
Management Duty
 

Manage Channel Settings
 

UI
 

CJM_MANAGE_CHANNEL_
SETTINGS_PRIV
 

Enables creation, update,
 and viewing of channel
settings.
 

Channel Administration
Duty
 

Manage Channel Settings
using REST Service
 

REST
 

CJM_MANAGE_CHANNEL_
SETTING_REST_SERVICE_
PRIV
 

Enables creation, update,
 and viewing of channel
settings using REST
service.
 

Channel Administration
Duty
 

Manage Channel User
Statuses
 

UI
 

CJM_MANAGE_CHANNEL_
USER_STATUSES_PRIV
 

Enables creation, update,
 and viewing of channel
user statuses.
 

Channel Administration
Duty
 

Manage Customer Claims
 

UI
 

CJM_MANAGE_
CUSTOMER_CLAIMS_PRIV
 

Enables update, and
viewing of customer claims.
 

Channel Claims
Management Duty
 

Manage Customer Trade
Profiles
 

UI
 

CJM_MANAGE_
CUSTOMER_TRADE_
PROFILES_PRIV
 

Enables creation, update,
 and viewing of customer
trade profiles.
 

Channel Claims
Management Duty
 

Manage Customer Trade
Profiles using REST Service
 

REST
 

CJM_MANAGE_
CUSTOMER_TRADE_
PROFILE_REST_SERVICE_
PRIV
 

Enables creation, update,
 and viewing of customer
trade profiles using REST
service.
 

Channel Claims
Management Duty
 

Reprocess Stalled Claims
 

Scheduled Process
 

CJM_REPROCESS_
STALLED_CLAIMS_PRIV
 

Allows submission of the
process that reprocesses
claims stuck in update in
progress status.
 

Channel Operations Duty
 

Review Claim Write-Offs
 

UI
 

CJM_REVIEW_CLAIM_
WRITE_OFFS_PRIV
 

Allows oversight of
systematic write-offs when
review of claim write-offs is
enabled.

Channel Claims
Management Duty
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Privilege Usage Code Description Assigned to Duty Role

 

Review Collections Aging
Buckets (Collections
privilege)
 

UI
 

IEX_REVIEW_
COLLECTIONS_AGING_
BUCKETS_PRIV
 

Allows a user to see the
aged transactions for a
customer.
 

Channel Administration
Duty
 

Settle Customer Claims
 

Scheduled Process
 

CJM_SETTLE_CUSTOMER_
CLAIMS_PRIV
 

Allows submission of the
process that closes settled
customer claims.
 

Channel Operations Duty
 

View Channel Claim
Reasons
 

UI
 

CJM_VIEW_CHANNEL_
CLAIM_REASONS_PRIV
 

Allows viewing of channel
claim reasons.
 

Channel Setup Viewing
Duty
 

View Channel Claim
Sources
 

UI
 

CJM_VIEW_CHANNEL_
CLAIM_SOURCES_PRIV
 

Allows viewing of channel
claim sources.
 

Channel Setup Viewing
Duty
 

View Channel Claim Types
 

UI
 

CJM_VIEW_CHANNEL_
CLAIM_TYPES_PRIV
 

Allows viewing of channel
claim types.
 

Channel Setup Viewing
Duty
 

View Channel Settings
 

UI
 

CJM_VIEW_CHANNEL_
SETTINGS_PRIV
 

Allows viewing of system
settings and their child
entities.
 

Channel Setup Viewing
Duty
 

View Channel User Statuses
 

UI
 

CJM_VIEW_CHANNEL_
USER_STATUSES_PRIV
 

Allows viewing of channel
user statuses.
 

Channel Setup Viewing
Duty
 

View Customers Function AR_VIEW_CUSTOMERS_
PRIV

Allows the viewing of the
customer, account and the
site information.

Channel Claims
Management Duty

View Customer Claims
 

UI
 

CJM_VIEW_CUSTOMER_
CLAIMS_PRIV
 

Allows viewing of all
customer claims.
 

Channel Claims Viewing
Duty
 

View Customer Trade
Profiles
 

UI
 

CJM_VIEW_CUSTOMER_
TRADE_PROFILES_PRIV
 

Allows viewing of customer
trade profiles and their
child entities.
 

Channel Claims Viewing
Duty
 

View Only Activity REST ZMM_VIEW_ONLY_
ACTIVITY_PRIV

Allows only viewing of
activities.

Channel Claims
Management Duty
 
Channel Claims Viewing
Duty
 

View Trading Community
Organization

UI HZ_VIEW_TRADING_
COMMUNITY_
ORGANIZATION_PRIV

Allows exporting,
 searching, and viewing of
organization details such as
addresses, classifications,
 identifiers, and names.

Channel Claims
Management Duty

192



SCM Cloud
Implementing Channel Revenue Management

Chapter 14
Security

Data Security  
Data security consists of controlling access to data through various policies.

• Transactional users with access to transactional pages and scheduled processes must have data access through
BUs.

• Administrators with access to the Functional Setup Manager pages must have data access through Reference
Sets.

Data Security for Deductions and Settlement Users
This table provides the data security policies that are required for your users for various roles.

Data Security Policy Code Description Assigned to Duty Role

Maintain Collections Aging Buckets
Data (Collections privilege)
 

IEX_MAINTAIN_COLLECTIONS_
AGING_BUCKETS_DATA

Allows a user to maintain aging
bucket data.
 

Channel Administration Duty
 

Manage Channel Claims Data
 

CJM_MANAGE_CHANNEL_
CLAIMS_DATA

Controls user access to channel
claims of the business units they're
authorized for.
 

Supplier Channel Management
Duty
 
Channel Operations Duty
 
Channel Claims Manager
 

Manage Channel Claim Reason
Data
 

CJM_MANAGE_CHANNEL_CLAIM_
REASON_DATA

Controls user access to channel
claim reason reference data set
they're authorized for.
 

Channel Administration Duty
 

Manage Channel Claim Source
Mapping Data
 

CJM_MANAGE_CHANNEL_CLAIM_
SOURCE_MAPPING_DATA

Controls user access to channel
claim source mapping reference
data set they're authorized for.
 

Channel Administration Duty
 

Manage Channel Claim Type Data
 

CJM_MANAGE_CHANNEL_CLAIM_
TYPE_DATA

Controls user access to channel
claim type reference data set
they're authorized for.
 

Channel Administration Duty
 

Manage Channel Notes Data
 

CJM_MANAGE_CHANNEL_
NOTES_DATA

Allows viewing, updating, and
deleting of internal notes for
channel objects.
 

Channel Claims Manager
 

Manage Channel Setting Data
 

CJM_MANAGE_CHANNEL_
SETTING_DATA

Controls user access to channel
system setting of the business
units they're authorized for.
 

Supply Chain Application
Administrator
 

Manage Customer Trade Profile
Data
 

CJM_MANAGE_CUSTOMER_
TRADE_PROFILE_DATA

Controls user access to customer
trade profile of the business units
they're authorized for.
 

Channel Claims Manager
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Data Security Policy Code Description Assigned to Duty Role

Manage Receivables Activity
(Receivables privilege)
 

AR_MANAGE_RECEIVABLES_
ACTIVITIES_DATA

Controls user access to receivables
activity of the business units
they're authorized for.
 

Channel Operations Duty
 

View Customer Account Data HZ_VIEW_CUSTOMER_ACCOUNT_
DATA

Allows viewing customer account
data for all customer accounts in
the enterprise.

Channel Claims Manager

View Trading Community
Organization Data

HZ_VIEW_TRADING_
COMMUNITY_ORGANIZATION_
DATA

Allows viewing trading community
organization data for all
organizations in the enterprise.
Allows viewing trading community
organization data where they
are a member of the partner
organization.

Channel Claims Manager

Related Topics
• Data Security

Customer Channel Flows  

Business Functions  
This topic lists the required business functions.

You must associate the Billing and Revenue Management business function with the business unit on the manual claim.

Roles and Duties  
This topic describes roles and duties in customer channel flows.

You can assign these job roles and duties to your users based on their responsibilities.

This table displays the job roles that can be assigned to your users:

Job Roles in Customer Channel Flows

Name Code Description

Channel Claims Manager ORA_CJM_CHANNEL_CLAIMS_MANAGER_JOB Individual responsible for creating, managing,
 and approving customer claims.

Customer Channel Program Manager ORA_CJM_CUSTOMER_CHANNEL_PROGRAM_
MANAGER_JOB
 

Individual responsible for creating, managing,
 and approving customer channel programs.
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Name Code Description

Supply Chain Integration Specialist ORA_RCS_SUPPLY_CHAIN_INTEGRATION_
SPECIALIST_JOB
 

Individual responsible for planning,
 coordinating, and supervising all activities
related to the integration of supply chain
management information systems.

Supply Chain Application Administrator ORA_RCS_SUPPLY_CHAIN_APPLICATION_
ADMINISTRATOR_JOB

Individual responsible for supply chain
application administration. Collaborates with
supply chain application users to maintain
consistent application setup, rules, and access.

This table displays the duty roles that can be assigned to your users:

Duty Roles in Customer Channel Flows

Name Code Description

Customer Channel Program Management ORA_CJM_CUSTOMER_CHANNEL_PROGRAM_
MANAGEMENT_DUTY

Manages customer programs and manual
adjustments.

Customer Channel Program Viewing ORA_CJM_CUSTOMER_CHANNEL_PROGRAM_
VIEW_DUTY

View customer programs.

Channel Claims Management ORA_CJM_CHANNEL_CLAIMS_
MANAGEMENT_DUTY

Manages customer claims.

Channel Claims Viewing ORA_CJM_CHANNEL_CLAIMS_VIEW_DUTY Views customer claims.

Channel Integration Specialist ORA_CJM_CHANNEL_INTEGRATION_
SPECIALIST_DUTY

Manages import of transactional data from
external applications into Channel Revenue
Management.

Channel Administration ORA_CJM_CHANNEL_ADMINISTRATION_DUTY Manages channel setup and administration
tasks.

Channel Operations ORA_CJM_CHANNEL_OPERATIONS_DUTY Manages execution of scheduled processes.

Privileges  
Here you'll understand the privileges for customer channel flows.

You can assign these privileges to your users based on their responsibilities.

Privilege Usage Code Description Assigned to Duty Role

Approve Customer Claims UI
 

CJM_APPROVE_
CUSTOMER_CLAIMS_PRIV

If you haven't opted into
the Approve Customer
Claims with BPM Workflow
feature, then this privilege
allows viewing and
approval of customer
claims.
 

Channel Claims
Management Duty
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Privilege Usage Code Description Assigned to Duty Role

If you have opted into the
Approve Customer Claims
with BPM Workflow feature,
 then this privilege allows
the approver to view all the
details of the claim in the
notification.
 

Get Channel Customer
Checkbook Balances using
REST Service
 

REST
 

CJM_GET_CHANNEL_
CUSTOMER_CHECKBOOK_
BAL_REST_SERVICE_PRIV

Gets the customer
checkbook balances using
REST service.

Customer Channel Program
Management Duty

Get Channel Customer
Program Checkbook
Balances using REST
Service

REST
 

CJM_GET_CHANNEL_
CUSTOMER_PGM_
CHECKBOOK_BAL_REST_
SERVICE_PRIV

Gets the program
checkbook balances using
REST service.

Customer Channel Program
Management Duty

Manage Customer Claims UI
 

CJM_MANAGE_
CUSTOMER_CLAIMS_PRIV

Enables update, and
viewing of customer claims.

Channel Claims
Management Duty

Manage Customer
Programs
 

Function
 

CJM_MANAGE_
CUSTOMER_PROGRAMS_
PRIV

Enables creation, update,
 deletion, and viewing of
customer programs and
their child entities.
 

Customer Channel Program
Management Duty
 

View Customers Fucntion AR_VIEW_CUSTOMERS_
PRIV

Allows the viewing of the
customer, account and the
site information.

Customer Channel Program
Management Duty

View Customer Checkbook UI
 

CJM_VIEW_CUSTOMER_
CHECKBOOK_PRIV

Allows viewing of customer
checkbook.

Customer Channel Program
Management Duty

View Customer Claims UI
 

CJM_VIEW_CUSTOMER_
CLAIMS_PRIV

Allows viewing of all
customer claims.

Channel Claims Viewing
Duty

View Customer Programs
 

Function
 

CJM_VIEW_CUSTOMER_
PROGRAMS_PRIV

Allows viewing of all
customer programs and
their child entities.
 

Customer Channel Program
Viewing Duty
 

View Only Activity REST ZMM_VIEW_ONLY_
ACTIVITY_PRIV

Allows only viewing of
activities.

Customer Channel Program
Management Duty
 
Customer Channel Program
Viewing
 

Data Security  
Here you'll understand the data security for customer channel flows.

Data security consists of controlling access to data through various policies.

• Transactional users with access to transactional pages and scheduled processes must have data access through
BUs.
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• Administrators with access to the Functional Setup Manager pages must have data access through Reference
Sets.

Note:  If you already use Deductions and Settlement, then you must add the reference data set access to existing
users. If you are a first time implementer of customer channel flows, then you must provide business unit and
reference data set access to your users. Implementation users always access to both the business unit and the
reference data set.

Data Security for Customer Channel Flows

Data Security Policy Code Description Assigned to Duty Role

Manage Channel Claims Data CJM_MANAGE_CHANNEL_
CLAIMS_DATA

Controls user access to channel
claims of the business units they
are authorized for.

Channel Claims Manager
 

Manage Channel Program Data CJM_MANAGE_CHANNEL_
PROGRAMS_DATA

Controls user access to channel
programs of the business units
they are authorized for.

Customer Channel Program
Management

Manage Customer Trade Profile
Data

CJM_MANAGE_CUSTOMER_
TRADE_PROFILE_DATA

Controls user access to customer
trade profile of the business units
they are authorized for.

Channel Claims Manager

View Customer Account Data HZ_VIEW_CUSTOMER_ACCOUNT_
DATA

Allows viewing customer account
data for all customer accounts in
the enterprise.

Customer Channel Program
Manager

View Customer Account
Relationship Data

HZ_VIEW_CUSTOMER_ACCOUNT_
RELATIONSHIP_DATA

Allows viewing customer account
relationship data for the reference
data sets for which they are
authorized.

Channel Claims Manager
 
Customer Channel Program
Manager

View Customer Account Site Data HZ_VIEW_CUSTOMER_ACCOUNT_
SITE_DATA

Allows the management of
customer account site data for the
reference data sets for which they
are authorized. If assigning, also
assign the ability to view customer
account site use data.

Channel Claims Manager
 
Customer Channel Program
Manager
 

View Customer Account Site Use
Data

HZ_VIEW_CUSTOMER_ACCOUNT_
SITE_USE_DATA

Allows viewing customer account
site use data for the reference data
sets for which they are authorized.

Channel Claims Manager
 
Customer Channel Program
Manager

View Item Basic Data EGO_VIEW_ITEM_BASIC_DATA Allows access to query and
view item basic information
including attributes, attachments,
 organizations, suppliers,
 relationships, and other related
information.

Customer Channel Program
Management Duty
 
Channel Claims Management Duty

View Trading Community
Organization Data

HZ_VIEW_TRADING_
COMMUNITY_ORGANIZATION_
DATA

Allows viewing trading community
organization data for all
organizations in the enterprise.
Allows viewing trading community
organization data where they
are a member of the partner
organization.

Customer Channel Program
Manager
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Buy Side Channel Flows  

Business Functions  
This topic lists the required business functions.

The following business functions must be associated with the business unit on the Supplier Ship and Debit program:

• Payables Invoicing

• Payables Payment or there is a downstream payables payment service provider for the business unit

• Billing and Revenue Management

The following business functions must be associated with the business unit on the Supplier Rebate program:

• Payables Invoicing

• Payables Payment or a downstream payables payment service provider for the business unit

The following business functions must be associated with the business unit on the Supplier Annual program:

• Payables Invoicing

• Payables Payment or a downstream payables payment service provider for the business unit

Roles and Duties  
You can assign these job roles and duties to your users based on their responsibilities. Job roles and duties are the same
regardless of whether you access buy side channel flows from the Procurement or Order Management offerings.

Job Roles for Buy Side Users
This table gives the job roles that can be assigned to your users:

Role Role Code Description

Supplier Channel Manager
 

ORA_CJM_SUPPLIER_CHANNEL_MANAGER_
JOB
 

Individual responsible for creating, managing,
 and approving supplier channel programs,
 making manual adjustments, and managing
supplier claims.
 

Duty Roles for Buy Side Users
This table gives the duty roles that can be assigned to your users:
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Name Code Description

Channel Administration
 

ORA_CJM_CHANNEL_ADMINISTRATION_DUTY
 

Manages channel setup and administration
tasks.
 

Channel Integration Specialist
 

ORA_CJM_CHANNEL_INTEGRATION_
SPECIALIST_DUTY
 

Manages import of transactional data from
external applications into Channel Revenue
Management.
 

Channel Operations
 

ORA_CJM_CHANNEL_OPERATIONS_DUTY
 

Manages execution of scheduled processes.
 

Channel Setup Viewing
 

ORA_CJM_CHANNEL_SETUP_VIEW_DUTY
 

Views setups required for channel execution.
This includes viewing the setups for program
types, adjustment types and reasons, claim
types and reasons, claim sources, and user
statuses.
 

Supplier Channel Management
 

CJM_SUPPLIER_CHANNEL_MANAGEMENT_
DUTY
 

Manages supplier programs, claims, manual
adjustments, and channel transactions.
 

Supplier Channel Viewing
 

ORA_CJM_SUPPLIER_CHANNEL_VIEW_DUTY
 

Views supplier programs, claims, manual
adjustments, channel transactions, and
program types.
 

For information, see:

• Role-Based Access Control, Oracle Fusion Applications Understanding Security guide

• Provisioning Roles to Application Users, Oracle SCM Cloud Securing SCM guide

Roles  
Here you'll understand the roles for supplier contacts.

You can assign these job roles and duties to your users based on their responsibilities.

Role Role Code Description

Supplier Channel Management in Supplier
Portal Duty
 

CJM_MANAGE_SUPPLIER_PROGRAMS_IN_
PORTAL
 

Role associated with the privilege to create and
update Supplier Programs for the associated
supplier from the Supplier Portal.
 

Supplier Channel Viewing in Supplier Portal
Duty
 

CJM_VIEW_SUPPLIER_PROGRAMS_IN_PORTAL
 

Role associated with the new privilege to view
Supplier Programs for the associated supplier
from the Supplier Portal.
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Privileges  
You can assign these privileges to your users based on their responsibilities. Privileges are the same regardless of
whether you are accessing buy side channel flows from the Procurement or Order Management offerings.

Assign Privileges for Buy Side Users
This table gives the privileges your users require to perform various functions. It contains the names, codes, and
descriptions of the privileges that can be assigned to a channel user.

Privilege Usage Code Description Assigned to Duty Role

Approve Supplier Claims
 

UI
 

CJM_APPROVE_SUPPLIER_
CLAIMS_PRIV
 

Allows viewing and
approval of supplier claims.
 

Supplier Channel
Management Duty
 

Approve Supplier Manual
Adjustments
 

Function
 

CJM_APPROVE_SUPPLIER_
MANUAL_ADJUSTMENT_
PRIV
 

Allows viewing and
approval of supplier manual
adjustments.
 

Supplier Channel
Management Duty
 

Approve Supplier Programs
 

UI
 

CJM_APPROVE_SUPPLIER_
PROGRAMS_PRIV
 

Allows viewing and
approval of supplier
programs.
 

Supplier Channel
Management Duty
 

Close Settled Claims
 

Scheduled Process
 

CJM_CLOSE_SETTLED_
CLAIMS_PRIV
 

Allows submission of the
process that closes settled
claims.
 

Channel Operations Duty
 

Create Accruals
 

Scheduled Process
 

CJM_CREATE_ACCRUALS_
PRIV
 

Allows submission of
the process that creates
accruals.
 

Channel Operations Duty
 

Create Accruals for Volume
Programs
 

Scheduled Process
 

CJM_CREATE_ACCRUALS_
FOR_VOLUME_
PROGRAMS_PRIV
 

Allows submission
of the process that
checks eligibility for
channel document
transactions based on
tiered attainments and
creates channel program
accrual entries for the
eligible transactions.
 

Channel Operations Duty
 

Extract Supplier Claims
 

Scheduled Process
 

CJM_EXTRACT_SUPPLIER_
CLAIMS_PRIV
 

Allows exporting of
claim details in the excel
workbook.
 

Supplier Channel
Management Duty
 
Supplier Channel Viewing
Duty
 

Generate Supplier Claims
 

Scheduled Process
 

CJM_GENERATE_
SUPPLIER_CLAIMS_PRIV
 

Allows submission of the
process that generates
supplier claims.
 

Channel Operations Duty
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Privilege Usage Code Description Assigned to Duty Role

Load Transactions
 

Scheduled Process
 

CJM_LOAD_
TRANSACTIONS_PRIV
 

Allows loading of
transactions from external
sources into Channel
Revenue Management.
 

Channel Operations Duty
 

Maintain Collections Aging
Buckets
 

UI
 

IEX_MAINTAIN_
COLLECTIONS_AGING_
BUCKETS_PRIV
 

Allows a user to maintain
aging buckets.
 

Channel Administration
Duty
 

Manage Active Supplier
Programs
 

UI
 

CJM_MANAGE_ACTIVE_
SUPPLIER_PROGRAMS_
PRIV
 

Enables creation, update,
 deletion, and viewing of
supplier programs and their
child entities, and update of
active programs.
 

Supplier Channel
Management Duty
 

Manage Channel
Adjustment Types
 

UI
 

CJM_MANAGE_CHANNEL_
ADJUSTMENT_TYPES_
PRIV
 

Enables creation, update,
 and viewing of channel
adjustment types and
adjustment reasons.
 

Channel Administration
Duty
 

Manage Channel
Administration Using REST
Service
 

REST
 

CJM_MANAGE_CHANNEL_
ADMINISTRATION_REST_
SERVICE_PRIV
 

Enables creation and
update of channel claim
sources, channel claim
types, channel adjustment
types, and channel user
statuses using REST
services.
 

Channel Administration
Duty
 

Manage Channel Batches
 

UI
 

CJM_MANAGE_CHANNEL_
BATCHES_PRIV
 

Allows update and viewing
of channel batches.
 

Supplier Channel
Management Duty
 

Manage Channel Claim
Reasons
 

UI
 

CJM_MANAGE_CHANNEL_
CLAIM_REASONS_PRIV
 

Enables creation, update,
 and viewing of channel
claim reasons.
 

Channel Administration
Duty
 

Manage Channel Claim
Sources
 

UI
 

CJM_MANAGE_CHANNEL_
CLAIM_SOURCES_PRIV
 

Enables creation, update,
 and viewing of channel
claim sources.
 

Channel Administration
Duty
 

Manage Channel Claim
Types
 

UI
 

CJM_MANAGE_CHANNEL_
CLAIM_TYPES_PRIV
 

Enables creation, update,
 and viewing of channel
claim types.
 

Channel Administration
Duty
 

Manage Channel Claims
using REST Service
 

REST
 

CJM_MANAGE_CHANNEL_
CLAIM_REST_SERVICE_
PRIV
 

Enables creation, update,
 and viewing of channel
claims using REST service.
 

Supplier Channel
Management Duty
 

Manage Channel Program
Types
 

UI
 

CJM_MANAGE_CHANNEL_
PROGRAM_TYPES_PRIV
 

Enables creation, update,
 deletion, and viewing of
channel program types and
child entities.
 

Channel Administration
Duty
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Privilege Usage Code Description Assigned to Duty Role

Manage Channel Program
Types using REST Service
 

REST
 

CJM_MANAGE_CHANNEL_
PROGRAM_TYPE_REST_
SERVICE_PRIV
 

Enables creation, update,
 deletion, and viewing of
channel program types and
child entities.
 

Channel Administration
Duty
 

Manage Channel Programs
Using REST Service
 

REST
 

CJM_MANAGE_CHANNEL_
PROGRAMS_REST_
SERVICE_PRIV
 

Enables creation, update,
 deletion, and viewing of
channel programs and their
child entities using REST
service.
 

Supplier Channel
Management Duty
 

Manage Channel User
Statuses
 

UI
 

CJM_MANAGE_CHANNEL_
USER_STATUSES_PRIV
 

Enables creation, update,
 and viewing of channel
user statuses.
 

Channel Administration
Duty
 

Manage Manual
Adjustments using REST
Service
 

UI
 

CJM_MANAGE_MANUAL_
ADJUSTMENT_REST_
SERVICE_PRIV
 

Enables creation and
viewing of manual
adjustments using REST
service.
 

Supplier Channel
Management Duty
 

Manage Supplier Claims
 

UI
 

CJM_MANAGE_SUPPLIER_
CLAIMS_PRIV
 

Enables creation, update,
 and viewing of supplier
claims and their child
entities.
 

Supplier Channel
Management Duty
 

Manage Supplier Manual
Adjustments
 

UI
 

CJM_MANAGE_SUPPLIER_
MANUAL_ADJUSTMENT_
PRIV
 

Enables creation and
viewing of supplier manual
adjustments.
 

Supplier Channel
Management Duty
 

Manage Supplier Programs
 

UI
 

CJM_MANAGE_SUPPLIER_
PROGRAMS_PRIV
 

Enables creation, update,
 deletion, and viewing of
supplier programs and their
child entities.
 

Supplier Channel
Management Duty
 

Manage Supplier Trade
Profile using REST Service
 

REST
 

CJM_MANAGE_SUPPLIER_
TRADE_PROFILE_REST_
SERVICE_PRIV
 

Enables creation, update,
 and viewing of supplier
trade profile using REST
service.
 

Supplier Channel
Management Duty
 

Manage Supplier Trade
Profiles
 

UI
 

CJM_MANAGE_SUPPLIER_
TRADE_PROFILES_PRIV
 

Enables creation, update,
 and viewing of supplier
trade profiles.
 

Supplier Channel
Management Duty
 

Review Collections Aging
Buckets
 

UI
 

IEX_REVIEW_
COLLECTIONS_AGING_
BUCKETS_PRIV
 

Allows a user to see the
aged transactions for a
customer.
 

Channel Administration
Duty
 

Sweep Channel Transaction
Accounting Events
 

Scheduled Process
 

CJM_SWEEP_CHANNEL_
TRANSACTION_
ACCOUNTING_EVENTS_
PRIV
 

Allows submission of
the process that sweeps
channel transaction
accounting events.
 

Channel Operations Duty
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Privilege Usage Code Description Assigned to Duty Role

View Channel Adjustment
Types
 

UI
 

CJM_VIEW_CHANNEL_
ADJUSTMENT_TYPES_
PRIV
 

Allows viewing of channel
adjustment types and
adjustment reasons.
 

Channel Setup Viewing
Duty
 

View Channel Claim
Reasons
 

UI
 

CJM_VIEW_CHANNEL_
CLAIM_REASONS_PRIV
 

Allows viewing of channel
claim reasons.
 

Channel Setup Viewing
Duty
 

View Channel Claim
Sources
 

UI
 

CJM_VIEW_CHANNEL_
CLAIM_SOURCES_PRIV
 

Allows viewing of channel
claim sources.
 

Channel Setup Viewing
Duty
 

View Channel Claim Types
 

UI
 

CJM_VIEW_CHANNEL_
CLAIM_TYPES_PRIV
 

Allows viewing of channel
claim types.
 

Channel Setup Viewing
Duty
 

View Channel Program
Types
 

UI
 

CJM_VIEW_CHANNEL_
PROGRAM_TYPES_PRIV
 

Allows viewing of channel
program types and child
entities.
 

Channel Setup Viewing
Duty
 

View Channel Transactions
Using REST Service
 

REST
 

CJM_VIEW_CHANNEL_
TRANSACTION_REST_
SERVICE_PRIV
 

Enables viewing of channel
transactions using REST
service.
 

Supplier Channel
Management Duty
 

View Channel User Statuses
 

UI
 

CJM_VIEW_CHANNEL_
USER_STATUSES_PRIV
 

Allows viewing of channel
user statuses.
 

Channel Setup Viewing
Duty
 

View Supplier Checkbook
 

UI
 

CJM_VIEW_SUPPLIER_
CHECKBOOK_PRIV
 

Allows viewing of supplier
checkbook.
 

Supplier Channel
Management Duty
 

View Supplier Claims
 

UI
 

CJM_VIEW_SUPPLIER_
CLAIMS_PRIV
 

Allows viewing of all
supplier claims and their
child entities.
 

Supplier Channel Viewing
Duty
 

View Supplier Manual
Adjustments
 

UI
 

CJM_VIEW_SUPPLIER_
MANUAL_ADJUSTMENT_
PRIV
 

Allows viewing of
all supplier manual
adjustments and their child
entities.
 

Supplier Channel Viewing
Duty
 

View Supplier Programs
 

UI
 

CJM_VIEW_SUPPLIER_
PROGRAMS_PRIV
 

Allows viewing of all
supplier programs and their
child entities.
 

Supplier Channel Viewing
Duty
 

View Supplier Trade Profiles
 

UI
 

CJM_VIEW_SUPPLIER_
TRADE_PROFILES_PRIV
 

Allows viewing of supplier
trade profiles and their
child entities.
 

Supplier Channel Viewing
Duty
 

Note:  All Supplier Ship and Debit UI users must have one of the following two privileges:
• Manage Supplier Programs

• View Supplier Programs
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Assign Privileges to Supplier Contacts
This table describes the privileges for supplier contacts to access Channel Programs via the Supplier Portal.

Privilege Usage Code Description Assigned to Duty Role

Manage Supplier Programs
in Supplier Portal
 

UI
 

CJM_MANAGE_SUPPLIER_
PROGRAMS_IN_PORTAL
 

Enables creation, update,
 and viewing of supplier
programs from the supplier
portal.
 

Supplier Channel
Management in Supplier
Portal Duty
 

View Supplier Programs in
Supplier Portal
 

UI
 

CJM_VIEW_SUPPLIER_
PROGRAMS_IN_PORTAL
 

Allows viewing of supplier
programs from the supplier
portal.
 

Supplier Channel Viewing
in Supplier Portal Duty
 

Data Security  
Data security consists of controlling access to data through various policies.

• Transactional users with access to transactional pages and scheduled processes must have data access through
BUs.

• Administrators with access to the Functional Setup Manager pages must have data access through Reference
Sets.

• Data security policies are the same regardless of whether you access buy side channel flows from the
Procurement or Order Management offerings.

Data Security for Buy Side Users
This table provides the data security policies that are required for your users for various roles.

Data Security Policy Code Description Assigned to Duty Role

Maintain Collections Aging Buckets
Data
 

IEX_MAINTAIN_COLLECTIONS_
AGING_BUCKETS_DATA
 

Allows a user to maintain aging
bucket data.
 

Channel Administration Duty
 

Manage Channel Adjustment Type
Data
 

CJM_MANAGE_CHANNEL_
ADJUSTMENT_TYPE_DATA
 

Controls user access to channel
adjustment type reference data set
they're authorized for.
 

Channel Administration Duty
 

Manage Channel Batch Data
 

CJM_MANAGE_CHANNEL_BATCH_
DATA
 

Controls user access to batches
of the business units they're
authorized for.
 

Supplier Channel Manager
 

Manage Channel Claims Data
 

CJM_MANAGE_CHANNEL_
CLAIMS_DATA
 

Controls user access to channel
claims of the business units they're
authorized for.
 

Supplier Channel Management
Duty
 
Channel Operations Duty
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Data Security Policy Code Description Assigned to Duty Role

Manage Channel Claim Reason
Data
 

CJM_MANAGE_CHANNEL_CLAIM_
REASON_DATA
 

Controls user access to channel
claim reason reference data set
they're authorized for.
 

Channel Administration Duty
 

Manage Channel Claim Source
Mapping Data
 

CJM_MANAGE_CHANNEL_CLAIM_
SOURCE_MAPPING_DATA
 

Controls user access to channel
claim source mapping reference
data set they're authorized for.
 

Channel Administration Duty
 

Manage Channel Claim Type Data
 

CJM_MANAGE_CHANNEL_CLAIM_
TYPE_DATA
 

Controls user access to channel
claim type reference data set
they're authorized for.
 

Channel Administration Duty
 

Manage Channel Notes Data
 

CJM_MANAGE_CHANNEL_
NOTES_DATA
 

Allows viewing, updating, and
deleting of internal notes for
channel objects.
 

Supplier Channel Manager
 

Manage Channel Program Data
 

CJM_MANAGE_CHANNEL_
PROGRAMS_DATA
 

Controls user access to channel
programs of the business units
they're authorized for.
 

Supplier Channel Management
Duty
 
Channel Operations Duty
 

Manage Supplier Trade Profile Data
 

CJM_MANAGE_SUPPLIER_TRADE_
PROFILE_DATA
 

Controls user access to supplier
trade profile of the business units
they're authorized for.
 

Supplier Channel Management
Duty
 

View Channel Batch Transaction
File Import Activity Object Type
Data
 

CJM_VIEW_BATCH_TRX_FILE_
IMPORT_ACTIVITY_OBJECT_
TYPE_DATA
 

Allows viewing channel batch
transaction import activities across
the enterprise.
 

Channel Integration Specialist Duty
 

View Channel Batch Transaction
File Import Mapping Object Type
Data
 

CJM_VIEW_BATCH_TRX_FILE_
IMPORT_MAPPING_OBJECT_
TYPE_DATA
 

Allows viewing channel batch
transaction import mappings
across the enterprise.
 

Channel Integration Specialist Duty
 

View Channel Batch Transaction
File Import Object Type Data
 

CJM_VIEW_BATCH_TRX_FILE_
IMPORT_OBJECT_TYPE_DATA
 

Allows viewing channel batch
transaction import objects across
the enterprise.
 

Channel Integration Specialist Duty
 

View Trading Community
Organization Data

HZ_VIEW_TRADING_
COMMUNITY_ORGANIZATION_
DATA

Allows viewing trading community
organization data for all
organizations in the enterprise.
Allows viewing trading community
organization data where they
are a member of the partner
organization.

Supplier Channel Manager

Related Topics
• Data Security
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15  Accounting Event Details

Accounting Event Details for Customer Accruals  
For every accrual and claim, there is an accounting entry. This appendix explains the events and their corresponding
accounting entries in detail.

For every accrual and claim, there is an accounting entry. This appendix explains the events and their corresponding
accounting entries in detail.

Customer Accrual Event

Debit Credit

Sales or Expense Account Accrual Liability Account

Customer Claim Settlement Event

Debit Credit

Claim Accrual Liability Account Receivables Clearing Account

Accounting Rules for Customer Accruals and Customer Claim Settlements

Event Class Name Journal Entry Description Side

Customer Accrual Sales or Expense Debit

Customer Accrual Accrual Liability Credit

Customer Claim Settlement Claim Accrual Liability Debit

Customer Claim Settlement Receivables Clearing Account Credit

Customer Claim Settlement Primary Ledger Exchange Gain and Loss Debit

Accounting Event Details for Supplier Accruals  
For every accrual, adjustment, and claim, there is an accounting entry. This appendix explains the events and their
corresponding accounting entries in detail.

Accrual Event
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Debit Credit

Accrual Asset Account
 

Income or Discount on COGS Account
 

Claim Settlement Event

Debit Credit

Payables Clearing Account
 

Claim Accrual Asset Account
 

Accounting Rules for Supplier Accruals and Supplier Claim Settlements

Event Class Name Journal Entry Rule
Set

Journal Line Rule Side Account Rule Mapping Set

Supplier Accrual
 

Supplier Accrual Rule
 

Accrual Asset
 

Debit
 

Accrual Asset Account
 

Accrual Asset Account
 

Supplier Accrual
 

Supplier Accrual Rule
 

Income or Discount on
COGS
 

Credit
 

Income or Discount on
COGS Account
 

Income or Discount on
COGS Account
 

Supplier Claim
Settlement
 

Supplier Claim
Settlement by
Payables Rule
 

Payables Clearing
 

Debit
 

Payables Clearing
Account
 

Payables Clearing
Account
 

Supplier Claim
Settlement
 

Supplier Claim
Settlement by
Payables Rule
 

Claim Accrual Asset
 

Credit
 

Claim Accrual Asset
Account
 

Claim Accrual Asset
Account
 

Supplier Claim
Settlement
 

Supplier Claim
Settlement by
Payables Rule
 

Claim Accrual Asset
Account
 

Credit
 

Claim Gain or Loss
Account
 

Exchange Gain
Account
 
Exchange Loss
Account
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